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Disclaimer

I hope you will like the A-Track for Windows program and enjoy using it as much
as | have enjoyed creating the system, BUT . . .

While every effort has been made to thoroughly test and verify all functions
incorporated into the A-Track for Windows application software when interfaced
to the appropriate NCE hardware, please note that the software is supplied on an
"as is" basis and without any warranty that it will perform faultlessly in your
application. You use the A-Track for Windows application software and all
associated hardware items at your own risk, and in accordance with the full
terms of the end-user licence agreement which can be found in Chapter 16 of
this document.

The author and designer will not in any event be held liable for any improper
operation of the A-Track for Windows program, or interference with any other
equipment or software program, nor be held liable for any incidental or
consequential damages of any sort arising out of its use.

Terry Chamberlain May 2023
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1 A-TRACK AND YOUR NCE DCC SYSTEM

As you may have noticed, this Reference Manual is a fairly large document which
describes all features of A-Track in detail. You are not expected to read all of it before
using A-Track, but rather to dip into it as required when you want to use specific
A-Track facilities. However, for the key points that you do need to know before getting
to grips with the program just see the Installation Notes and the User Guide.

1.1 Principal Features of A-Track

A-Track for Windows (A-Track) is a powerful FREE software application to complement
the facilities of your NCE Corporation Power Cab or Power Pro Digital Command Control
system

e Helps you organise your roster of locomotives on your railroad

e No need to be a computer expert

e A-Track stores full details of all of your locomotive and accessory (turnout) decoders
e Easy access to all DCC configuration parameters on your computer screen
e A-Track can back-up all of the data held within each DCC decoder in your roster

e Safeguards all the hours of effort put in by you (or your Club’s DCC expert) in
programming and configuration.

e No change in how your NCE Command Station and Handheld Cabs operate
e Use them exactly as before
e A-Track lends a powerful helping hand in the background

e A-Track runs under Windows XP, Windows Vista, Windows 7, Windows 8 (including
8.1), Windows 10, or Windows 11 on a standard Personal Computer (PC)

Using an NCE Power Cab system (including systems based around an NCE SB3a or SB5
Smart Booster unit, or the entry-level DCC Twin), A-Track connects via an NCE USB
Interface unit, as shown in the example set-ups below for the different NCE systems —

NCE PowerCab

Handheld
Controller
(and Power
Cab Panel)
13.5V DC
Power Supply

NCEUSB  pC - Windows (XP, Vista, 7, 8, 10 or 11)
Interface and A-Track Software

USB Cable

NCE Cab Bus
Track -o) . Program Track
Select O_l
Switch—o)
O= j Mainline Track
AUooouorooorougoioooooooooo
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No HGE RN
ProCab PowerCab En s At =
Handheld Handheld ‘
Controller Controller
NCE UTP PC - Windows (XP, Vista, 7, 8, 10 or 11)
NCE Smart Panel and A-Track Software

Booster

NCE USB
Interface

USB Cable

n[ nl
[T Mainline Track
ut U U

16VAC / 22VDC ©
Power Supply

No Program Track - use PowerCab alone with PowerCab Panel

NCE PRO CAB

NCE ProCab
(PowerCab)

Handheld
13.5V DC Controller
Power Supply
NCE UTP PC - Windows (XP, Vista, 7, 8, 10 or 11)

Panel

and A-Track Software

NCE Cab Bus

NCE USB
Interface

USB Cable

NCE DCC Twin

Program Track

Mainline Track

-+
Track Select Switch
S|
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Alternatively, with an NCE Power Pro Command Station, A-Track connects via a
standard Serial Port, if you have an older PC which is fitted with one, or via a USB Port
and any readily-available USB-to-Serial (RS232) converter unit, as shown below —

PC - Windows (XP, Vista, 7, 8, 10 or 11) -
and A-Track Software % i

]

atoce | A

USB-Serial (RS232)
Converter Unit

usB
RS232 Cable Cable

NCE Power Pro | (if required)
Command Station

Programming Booster

(Recommended)
Mainline Track Program Track
o 1128-1 288\(’4;% / NCE Cab Bus i:
% 5 i
—©  power Supply NCE ProCab
NCE UTP Panel Handheld Controllers

Note that the NCE Power Pro has limited Program Track drive capabilities so that,
particularly where sound decoders are fitted to your locomotives, it is strongly
recommended that a programming track booster unit (such as the SoundTraxx PTB-
100 — note that the alternative DCC Specialities PowerPax is not recommended by
NCE) is inserted between the Command Station and the Program Track. Once fitted the
unit can be left permanently connected for programming and verifying all types of
decoders. A programming track booster unit is not required when using an NCE Power
Cab which has a comparatively higher drive capability in Program mode.

When used with either an NCE Power Pro, a Power Cab or Smart Booster Version 1.65
system, or a DCC Twin (and a Version 7 USB Interface where appropriate), A-Track will
also let you monitor, set up, save, and restore the complete status and operational
parameters of the NCE Command Station and all attached Cabs from your PC

¢ No need to set everything up from scratch at the start of a session — more time to
enjoy your model railroading

e If using a DCC Twin, A-Track lets you perform these functions instead of having to
purchase an NCE ProCab for the purpose.
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Note, however, that these set-up facilities are not available when A-Track is used with
the earlier Version 1.28 of the NCE Power Cab and Smart Booster systems, or with a
Version 6 USB Interface.

Safeguard Your DCC Decoder Configurations
Using A-Track, you can —

e Read and save the status and parameters of each new locomotive decoder as
delivered by the manufacturer

e See the complete configuration details of the locomotive at a glance, on the PC
screen, rather than only one parameter at a time by using a standard handheld Cab

e Handle all types of decoders, including sound decoders, from all manufacturers who
comply with National Model Railroad Association (NMRA) DCC standards. A-Track
has been successfully tested with Bachmann, Broadway Limited (Paragon 2), DCC
Concepts, Digitrax, ESU (LokSound), Hornby, Lenz, NCE, Model Rectifier, MTH, QSI
(Quantum), SoundTraxx, Tam Valley Depot, Train Control Systems (TCS), Zimo,
and ZTC decoders.

¢ Make changes to the decoder parameters directly on the PC screen, without having
to compute or type in complicated numerical values, and immediately try out the
effects to see whether to keep the alterations or go back to the original values

e Keep back-up copies of each decoder’s settings — especially valuable if you make an
error in programming one or more parameters, and completely upset your careful
tailoring of a locomotive’s performance and characteristics. A-Track lets you to
retrieve the previous decoder set-up and restore the locomotive to its previous state
(as long as you remembered to save the earlier set-up version before making the
changes !).

e Look at the decoder set-ups for several locomotives at the same time, see the
differences between them, then tune their speed (and function) characteristics to
run together in a consist

e Copy decoder parameters from one locomotive to another — very useful when you
purchase a new locomotive similar to one already in your roster, saving a lot of
programming time and effort — just make sure you use A-Track first to make a
back-up copy of the original settings in the new locomotive (just in case !). Then
give the new locomotive an appropriate description and its own DCC address, plus
any minor enhancements that you might want to make.

Control and Monitor Your Layout

As well as handling locomotive decoders, A-Track also lets you program and operate
accessory (or stationary) decoders, primarily to control turnouts on your layout.

To make operation as simple as possible, A-Track allows you to construct an on-screen
graphical view of all your layout turnouts, such as that shown in the two example
panels shown below.

e Double-click any turnout and the commanded position is shown immediately on the
panel, together with which track sections are accessible (green) or not (red)

e With either an NCE Power Pro or a Version 1.65 Power Cab system, wire up your
turnouts to one or more NCE Auxiliary Input Units (AlUs) and A-Track will be able to
sense the actual position of each turnout — checking that the command has worked
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Connect block occupancy detectors to one or more AlUs, and A-Track will also show
which track blocks are currently occupied (yellow highlight)

A-Track lets you select the start and end points of a required route (plus an optional
mid-point) and then immediately display the necessary intermediate turnout
settings. All turnouts can then be switched with a single click and, if you wish, their
settings saved as a Macro for future use.

Macros are fully supported for NCE Power Pro and all versions of Power Cab
systems, and A-Track expands the limited Macro facilities of Power Cab systems to
equal those of Power Pro systems.

1.4 Protect Your Decoder, Command Station and Handheld Cab Setups

With NCE Power Pro and Version 1.65 Power Cab systems, A-Track gives you full
access to the Command Station, and the ability to display all of the key parameters
stored in its internal memory on the PC screen —

Perform Command Station and Handheld Cab setup directly from the computer
Define and manipulate the composition of Consists and any stored Macros

Selectively save (back-up) all parameters stored in the Command Station memory
(System, Macros, Consists, and Cab Status) to files on the PC’s hard disk, CD-R /
DVD-R or USB flash drive (memory stick)

Restore the Command Station and its attached Cabs to a state corresponding to a
previously-recorded operating session

Save all or part of the equipment roster to files on any of the media listed above,
simply for safe-keeping or for loading into another A-Track / NCE system elsewhere

Given the current size of hard disks and the amount of RAM fitted in a modern
personal computer, there is no practical limit to the number of different Command
Station, Cab or decoder setups which can be saved to, or restored from, the
computer’s permanent or removable storage. A-Track can handle equipment roster
lists stretching to hundreds (or even thousands) of equipment items. However, such
large lists tend to be unwieldy to view and manipulate, so it is usually easier to
compose and save shorter rosters — corresponding, for example, to an operating
session.
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1.5 Additional Facilities

A-Track can handle simultaneous connections to several Command Stations where, for
example you use a Power Pro to run your main layout and have a Power Cab
connected to the programming track. In such a case, you can have two instances of
A-Track running on your computer at the same time, allowing you to switch from
operations to programming, and back again, at the click of a mouse.

As well as its primary purpose of storing and manipulating the contents of DCC
decoders and your Command Station, A-Track also allows you to control any selected
locomotive or set of turnouts on the main track directly from the PC, using the mouse
and a ‘soft’ on-screen controller to issue DCC commands directly to the NCE Command
Station. Although this control function is really intended as a test facility, to check the
results of programming a locomotive decoder, for example, you can call up and
operate as many as eight ‘soft’ controllers on the screen simultaneously - if you think
you possess the capability and dexterity to run eight locomotives simultaneously on
the layout by yourself !

1.6 Obtaining Your Copy of A-Track
A-Track may be downloaded from the A-Train Systems website at —

http://www.a-train-systems.co.uk/getatrack

- completely free of charge for your personal or club use. Support to resolve any
problems which you may encounter in using A-Track is also available free through the
website (see Section 11.2).

You can either download A-Track as a simple executable Setup File, and then
separately download the Reference Manual and/or User Guide and Installation
Notes, or else download a complete Installation Package (including Adobe Reader).

Click on the selected file to download, then select Save (not Run) either file or link, to
copy the file to a folder on your computer. In Windows XP the default location will be
My Documents, or Downloads in Windows Vista, Windows 7, 8, 10, or 11, although you
can choose any other folder as a destination if you wish — but take note of where the
file is saved so that you can locate it later for installation.

Once installed (see Sections 3.1 through 3.4), you have the option of registering your
copy of A-Track, also without any charge, as described in Section 11.1. Registered
users will have priority with regard to support and assistance in rectifying any
problems which they come across.

If, after using A-Track, you think that it is of benefit to your model railroading
activities, and would like to support future A-Track development and enhancements,
then you are welcome to make a voluntary donation - but you will not be ‘nagged’ or
pressured to do so.

Donations can be made safely and securely via PayPal, using any credit or debit card,
even if you do not have a PayPal account of your own

Very Important : Please note that the term "completely free of charge" must not be
confused with "free for you to exploit as you wish". A-Track is copyrighted software,
and not a public domain product. You may not distribute or sell A-Track either alone or
as part of any commercial item, as set out in detail in the terms of the A-Track licence
in Chapter 16.
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2 SYSTEM REQUIREMENTS

2.1

2.2

Personal Computer

e Pentium 3 processor or better, running at 500 MHz or faster (1 GHz for Windows
10 and 11)

e At least 512 MByte RAM to get the best performance from the Windows
Operating System (2 GByte recommended for Windows 7, 8 and 10, 4 Gbyte for
Windows 11) — A-Track itself requires minimal memory

e At least 60 MByte of hard disk space available for installation

e Minimum screen resolution of 800 x 600 pixels (1024 x 768 preferred) showing
at least 256 colours (8-bit colour setting) or better

e One available RS232 Serial port or USB 2.0 port

e CD-R drive (if installing the software from a distribution CD)

e Printer (optional)

It is assumed in this Reference Manual that the reader is familiar with the basic
operation of a Personal Computer using a Windows operating system, including the use
of mouse and keyboard, and is able to find his or her way through file and folder
structures to store and retrieve any required files or other data.

In this Reference Manual, ‘click’ means a left-click of the mouse, ie. press and
immediately release the left mouse button. ‘Right-click’ means the same action applied
to the right mouse button, and ‘double-click’ means two left-clicks performed in rapid
succession.

As far as possible, A-Track uses only common Windows operations to manipulate the
data involved in handling DCC decoders and the NCE Command Station and Handheld
Cabs. Hence, if anything in the descriptions is not clear, you should be able to find
further information and more detailed explanations in any of the multitude of
introductory personal computer and Windows books available on the market.

Most of the illustrations in this Reference Manual have been captured from the screen
of a machine operating under Windows 10 or Windows 11. Where operations are
significantly different under Windows XP, Vista, Windows 7, 8, or 8.1 screen shots from
one of these operating systems are shown as well, or an explanatory note is at least
included in the text.

Operating System
A-Track can be installed under, and will operate with, any of the following Windows
operating systems —

e Microsoft Windows XP (Service Pack 2 or later)
(Home, Media, or Professional Edition)

e Microsoft Windows Vista (Service Pack 1 or later)
(Home Basic, Home Premium, Business, or Ultimate Edition)

e Microsoft Windows 7
(Starter, Home Premium, Professional, or Ultimate Edition)
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e Microsoft Windows 8 and 8.1
(Standard, Professional, or Enterprise Edition)

- but note that A-Track cannot be run under Windows 8 RT, as
installed on tablet machines (now discontinued by Microsoft), since
this version does not support desktop applications

- throughout the Reference Manual, any reference to operation under
Windows 8 applies equally to Windows 8.1

e Microsoft Windows 10
(Home, Professional, Enterprise, or Education Edition)

e Microsoft Windows 11
(Home, Professional, Enterprise, Education, or SE Edition)

2.3 DCC Command Station

A-Track will operate in conjunction with any of the following items of NCE equipment —

e NCE Power Cab (Versions 1.28 or 1.65B — note that the original version 1.65 had
a serious bug, so you should contact NCE to obtain a 1.65B upgrade EEPROM)

e NCE Smart Booster (SB3, SB3a or SB5 — with Version 1.65B EEPROM)
e NCE DCC Twin
e NCE Power Pro 5-Amp System (PH Pro or PH Pro R)

e NCE Power Pro 10-Amp System (PH-10 or PH-10 R)
(NCE CS02 Command Station plus PB110 Power Booster)

Again, it is assumed in this Reference Manual that the reader is familiar with the
functionality provided by the NCE Power Cab, Smart Booster, or Power Pro Command
Station and any associated Handheld Controllers (Cabs), so that the standard details of
their operation are not covered in this Reference Manual.

Please refer to the NCE Power Cab or Power Pro System Reference Manuals, and other
available NCE documentation, for full specifications and operating instructions.
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3 GETTING STARTED

3.1

To help you locate the information you need from this large Reference Manual, if you
use the electronic version (the .pdf file) in Adobe Reader, for example, you will find
that all chapter and section headings are hyperlinked, so that you can jump to any part
of the document from the Contents listing, shown by clicking on the Bookmark icon (
or ﬂ ), or via the Adobe Reader View menu by going to Navigation Panels /
Bookmarks (or Show/Hide / Navigation Panes / Bookmarks in later versions).

In addition, you can also click on any reference in the text to another section of the
Reference Manual, which will take you straight to that section. Click on the Back or
Previous View button to return to where you started. If these buttons are not shown,
search for the relevant set of Toolbar buttons from the Adobe Reader View menu. As
an example, click on the reference to Chapter 13 here, or in the next paragraph, to
find out about installing USB-to-Serial devices.

If you cannot find the information you need, remember that the full Reference Manual
is available as Help pages whenever you are running A-Track. All you have to do is
press the F1 key on your keyboard, to display the most relevant Help page.

Note that, if you are planning to use a USB-to-Serial Converter or the NCE USB
Interface unit to connect your PC to the NCE equipment, the associated driver software
can be installed either before or after installation of the A-Track program, although
both have to be correctly installed before the full functionality of A-Track will be
available. Some guidance on the installation of the various varieties of driver software
can be found in Chapter 13, near the end of this Reference Manual.

Before starting installation of A-Track from the Full Installation Package, from a
Distribution CD, or directly from the Setup File, ensure that no other applications are
running on the PC, and that the active User has administrative rights (this is the
normal status when the operating system is either Windows XP Home or Media Edition,
in Windows Vista or Windows 7 Starter or Home Editions, in Windows 8 Standard
Edition, and Windows 10 or 11 Home Edition, but you may need to log on as an
Administrator when using Windows XP Professional Edition, Windows Vista and
Windows 7 Business, Professional, or Ultimate Editions, or Windows 8, 10, or 11
Professional, Enterprise or Education Editions).

Once all of the necessary driver and program software is installed, A-Track can be run
by any User - no aspect of A-Track operation requires administrator privileges.

Installation from the Full Installation Package

Having downloaded the Installation Package from the A-Train Systems website (see
Section 1.6), ‘unzip’ the compressed file (A-Track4 Install.zip) to a convenient
folder by right-clicking on the file, and then on the Extract All option on the pop-up
menu (if you do not have a dedicated file-compression program such as WinZip
installed on your computer).

The installer program (A-Track4_Install.exe) can be run directly from the folder into
which you ‘unzipped’ the Package by double-clicking on it. Alternatively, you can copy
the complete set of unzipped files and folders to a USB flash drive (memory stick), or
write them to a CD-R disk, if you wish to install A-Track on another computer (such as
one without Internet access) — ensuring that you preserve the unzipped folder
structure. Once copied to a CD-R, the A-Track installer should run automatically when
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loaded into a suitable CD-DVD drive (provided that your computer’s ‘Autorun’ options
are set appropriately), as described below for installation from the Distribution CD.

If you have copied the Installation Package to a USB flash drive then, after plugging
the device into an available USB port, it is unlikely that the installer will run
automatically. Hence, click on My Computer in XP, Computer in Vista, Windows 7 or
8, or This PC in Windows 8.1 or 10, and locate the USB drive (usually D: or E:). In
Windows 8 or 10 you will first need to open File Explorer on the Desktop in order to
locate the USB drive in Computer or This PC. Double-click on the drive icon to reveal
the list of files and folders, then double-click on the file named A-Track4_Install.exe.

When the A-Track installation window opens, and presents you with a set of simple
options, follow the instructions given below for Installation from the Distribution CD.

Installation from the Distribution CD

Insert the distribution CD into your DVD / CD drive, ensuring that no other applications
are running on the PC.

Although the installation program will normally run immediately under Windows XP, in
the case of either Windows Vista, Windows 7, Windows 8 (8.1), or Windows 10 the
standard operating system in-built security measures will first display an AutoPlay
window to confirm that you wish to run the program —

DVD RW Drive (G:) A-Track...
q DVD Drive (E) A-Track4_Install Choose what to do with this disc.

Install or run program from your media

Always do this for software and games:

Run A-Track4_Install.exe
Install or run program from your media get:d Publisher not spedified

Run A-Track4_Install.exe
o3 Publisher not specified

Other choices

General options Open folder to view files
File Explorer
Open folder to view files a
} using Windows Explorer .
@ Take no action
View more AutoPlay options in Control Panel

Click Run A-Track4 _Install.exe to continue, and then click Yes on the following
security prompt, similar to one of those shown below, to allow the A-Track installation
to proceed —

User Account Centrol x
Do you want to allow this app from an

unknown publisher to make changes to your
device?

Do you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name:  A-Track4_Install.exe

Publisher: Unknown A-Trackd Install.exe

File origin: CD/DVD drive Publisher: Unknown

File origin: Hard drive on this computer

(~) Hide details

Show more details

Help me decide Change when these notificaticns appear Yes No
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If, for any reason, the Autorun (or AutoPlay) facility has been disabled on the PC, and
the CD-R fails to run automatically, click on My Computer, Computer, or This PC,
depending on your version of Windows, and locate the DVD / CD drive (usually D: or
E:). In Windows 8 or 8.1 you will first need to open File Explorer on the Desktop in
order to locate the DVD / CD drive in Computer or This PC. Double-click on the drive
icon to reveal the list of files and folders, then double-click on the file named
A-Track4 _Install.exe.

With Windows 10 or 11, because A-Train Systems is not an organisation known to
Microsoft, and A-Track is an unrecognised application, you are likely to receive a
warning as shown below. A-Track does not contain malware nor pose any kind of
danger to your computer. To proceed, click More info and then the button labelled
Run anyway, which appears at the bottom of the window —

Windows protected your PC

Windows Defender SmartScreen prevented an unrecognised app from
starting. Running this app might put your PC at risk.
More info

Windows protected your PC

Windows Defender SmartScreen prevented an unrecognised app from
starting. Running this app might put your PC at risk.

Application: A-Track4_|nstall.exe
Publisher:  Unknown publisher

I

You may also receive some cautionary messages from any anti-virus or Internet
security software which is installed on your machine.

The A-Track installation window opens and presents you with a set of simple options —
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sarTRECKk

Digital Command Control
with NCE Power Cab and Power Pro

Installation Guidance D ‘ View Notes |
Install A-Track Program [ Install
View User Guides [> Open Folder

Install Adobe Reader D Adobe Reader ‘
Close ‘

Copyright & 2007-2020 JT Chamberlain

Installation Guidance — View Notes opens a copy of these instructions in webpage
format (.htm), and displays them in the browser program installed on your computer.
If no browser is found, then Windows will display an error message.

Install A-Track Program — Install will close the installation window and then run
the A-Track SetUp process, as described for installation from the Setup File in Section
3.4 below. However, note that, if you have a previous version of A-Track installed on
the PC, then it is recommended that you uninstall it before proceeding to install the
latest version - most easily done by using the Uninstall A-Track option from the Start
Menu or Start Screen (also described in Section 3.4 below).

View User Guides — Open Folder will open a folder containing the A-Track User
Guide, Installation Guides, and Reference Manual in Portable Document Format (.pdf)
which can be read using the Adobe Reader program.

Install Adobe Reader will install a copy of this free program (Version 11.0.8) if you
do not already have a suitable version installed on your computer — just follow the
prompts to complete the straightforward set-up. Note that Adobe is likely to update
this version immediately to the latest Version 11.0.23, which was not directly
accessible for download.

Close removes the A-Track installation window from the screen — you can open it
again by re-inserting a copy of the Installation Package on CD-R into a DVD / CD drive,
by plugging a copy on a USB drive into a USB socket, or by locating and double-
clicking on the A-Track4 Install.exe file from wherever you stored it.

Installation from the Setup File

If you have chosen to download the simple Setup File (A-Track44-301-SetUp.exe or
a later version) from the A-Train Systems website (see Section 1.6) then locate the
file in the folder into which you downloaded it. With Windows 8 you will need to do this
from the Desktop, accessed by clicking the appropriate tile on the Start Screen, and
then opening File Explorer.
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If you have a previous version of A-Track installed on the PC, then it is recommended
that you uninstall it before proceeding to install the latest version. The easiest way to
do this is to use the Uninstall A-Track option from the Start Menu, as shown at the
end of Section 3.4.

Alternatively, you can open Control Panel and select Add or Remove Programs in
Windows XP, or Uninstall a Program in Windows Vista, Windows 7, 8, 10 or 11 (access
Programs and Features). Wait for the list of installed programs to be displayed then
click on the entry for A-Track, and finally click on the Remove button in Windows XP,
or the Uninstall button in Windows Vista, Windows 7, 8, 10 or 11. Once the A-Track
program is uninstalled, close the open Control Panel window.

Before running the Setup File (by double-clicking on it) ensure that no other
applications are running on the PC. Although the Setup File will normally run
immediately under Windows XP, in the case of either Windows Vista, Windows 7, 8, 10
or 11, the standard operating system in-built security measures, as described in the
preceding section on installation from the distribution CD, will prompt you to allow the
file to run — click Yes to continue.

With Windows 10 or 11, because A-Train Systems is not an organisation known to
Microsoft, and A-Track is an unrecognised application, you are likely to receive a
warning as shown below. A-Track does not contain malware nor pose any kind of
danger to your computer. To proceed, click More info and then the button labelled
Run anyway, which appears at the bottom of the window —

Windows protected your PC

Windows Defender SmartScreen prevented an unrecognised app from
starting. Running this app might put your PC at risk.

More info

Windows protected your PC

Windows Defender SmartScreen prevented an unrecognised app from
starting. Running this app might put your PC at risk.

Application: A-Track44-301-SetUp.exe
Publisher:  Unknown publisher

=
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You may also receive some cautionary messages from any anti-virus or Internet
security software which is installed on your machine.

3.4 Installing A-Track Step-by-Step

If installing from the Installation Package, click on Install Program, or otherwise
locate and double-click on the SetUp File (A-Track44-301-SetUp.exe or a later
version) in the appropriate folder to start the installation.

The default security settings in Windows Vista, Windows 7, 8, 10 or 11 (but not under
Windows XP) will then display a couple of warnings, requiring you to allow the set-up
program to run —

User Account Control X

Do you want to allow this app from an
unknown publisher to make changes to your
device?

A-Track44-301-SetUp.exe

Publisher: Unknown
File origin: Hard drive on this computer

Show more details

Yes Mo

— and you may also receive some cautionary messages from any anti-virus or Internet
security software which is installed on your machine — before the A-Track SetUp
Welcome screen shown below is displayed. Again, as noted in the SetUp window, it is
recommended that any other open programs or windows are closed before proceeding
further.

& Setup - A-Track for Windows

Welcome to the A-Track for
Windows Setup Wizard

This will install A-Track for Windows 4.4.301 on your
computer,

Itis recommended that you dose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.
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Click on Next to continue with the installation (or Cancel to quit SetUp) and to display
the end-user licence screen. Here the full text of the licence, under which the A-Track

software is provided, is available if you wish to read it (printed in full in Chapter 16 of
this Reference Manual).

You must accept the terms of the licence, by clicking on ‘1 accept the agreement’, in
order to display the Next button and to be able to continue with A-Track installation —

i Setup - A-Track for Windows

License Agreement
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

A-Track for Windows

Copyright 2007-2020 JT Chamberlain, A-Train Systems
All rights reserved.

www.a-train-systems.co.uk

IMPORTANT - READ CAREFULLY:
This licence agreement iz a legal agreement between you

(individual or legal entity) and JT Chamberlain (trading a=s
A-Train Systems)

YOU AGREE TO BE BOUND BY THE TERMS OF THIS LICENCE "

()1 do not accept the agreement

Click Next to display the default destination folder for A-Track. Unless you have very
good reasons to change the install destination (and understand the possible
complications of doing so) it is recommended that you leave it as shown at
C:\Program Files (x86)\A-Track (or C:\Program Files\A-Track) -

i Setup - A-Track for Windows

Select Destination Location
Where should A-Track for Windows be installed?

Setup will install A-Track for Windows into the following folder.

To continue, dick Mext. If you would like to select a different folder, dick Browse.

:\Program Files (x86)

Browse...

At least 45.6 MB of free disk space is required.
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Click on Next to continue. The set-up program will now ask you to confirm that it
should proceed to create a set of entries for A-Track on the computer’s Start Menu.
These will be complemented by the placement of an A-Track icon on the Desktop. As in
previous windows, you are also offered the options of returning to change your
previous selection (Back), or of abandoning the A-Track SetUp (Cancel) -

i Setup - A-Track for Windows

Select Start Menu Folder
Where should Setup place the program's shortouts?

o
Setup will create the program's shortcuts in the following Start Menu folder,
==

To continue, dick Mext. If you would like to select a different folder, dick Browse.

|m Browse...

Accepting the default option gives A-Track its own entry on the Start Menu, but you
can choose to place the A-Track entry within an existing Start Menu folder (such as
Accessories) by using the Browse button.

When you are happy, click Next to continue —

]it.zl Setup - A-Track for Windows

Ready to Install
Setup is now ready to begin installing A-Track for Windows an your computer.,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:'Program Files (x86)\A-Track

Start Menu folder:
A-Track
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On the confirmation screen, if you are satisfied with the installation settings, click
Install. Setup will then proceed to install all of the files required to support A-Track,
together with the A-Track executable program itself. If any of the Windows support
files are already installed in the PC then SetUp will only install a replacement version if
it is more up-to-date than the existing file -

i Setup - A-Track for Windows

Installing
Please wait while Setup installs A-Track for Windows on your computer.
Extracting files. ..
C:'Program Files (x86)\A-Track\Tutorial\Page27.rtf
Copyright © 2007-2020 A-Train Systems Installation by Inno Setup 5.5.9 4

Installed files are linked into the Windows Registry as required —

i Setup - A-Track for Windows

Installing
Please wait while Setup installs A-Track for Windows on your computer.

Registering files. ..

Copyright © 2007-2020 A-Train Systems Installation by Inno Setup 5.5.9 4

Cancel

- followed by some tidying of the installed files -
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i Setup - A-Track for Windows

Installing
Please wait while Setup installs A-Track for Windows on your computer.

Finishing installation. ..

Copyright © 2007-2020 A-Train Systems Installation by Inno Setup 5.5.9 4

- and then a final window is displayed to show that the A-Track installation is
complete -

]i.,zl Setup - A-Track for Windows =

Completing the A-Track for
Windows Setup Wizard

Setup has finished installing A-Tradk for Windows on your
computer. The application may be launched by selecting the
installed shortcuts,

Click Finish to exit Setup.

Click Finish to close A-Track SetUp and return to the Desktop.

To launch A-Track double-click on the program icon (#&) on the Desktop. In Windows 8
(and in Windows 10) a corresponding tile (#4) is placed on the Start Screen.

In Windows versions other than Windows 8, you can also launch A-Track from the
Start Menu by clicking on Start, then Programs (or All Programs, depending on
your selected Start Menu format). Locate and move the mouse to the A-Track folder,
and then click on the A-Track program as shown in both the Windows XP screen-shot
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below, which also shows the A-Track Desktop icon, and that from Windows 10 on the
right —

Acrobat Reader DC

Acronis

Acronis True Image

l@ O&0 Software
i/ s

&
B} Adobe Reader & #a A-Track
& Internst Explorer ﬁ! Uninstall A-Track
@ Microsoft OFfice PowerPoint Wiewer 2003
G @ Microsaft Works Task Launcher

A-Track

185 Morton SystemiWarks 3 zj:ook e
@) Set Program fccess and Defaulks
B2 Windows Catalog

“ Windaows Update

Adobe Acrobat Distiller X

tartup

@ A-Track Help Adobe Acrobat X Standard
Alarms & Clock

AMD Catalyst Control Center

Arduino

A-Track

|
[=o]
l A-Route
n

,,'_, Remate Assistance
&) Windaws Media Player
3 Windows Messenger

7 ck
[ ¥ windows Movie Maker EF A-Track Help

i )\ A-Track

|E; Programs

ﬁ i . |§ Uninstall A-Track
@ Docurments 3

G‘ Settings » l Asantum AxCrypt
‘.'J Search 3 5

) Help and Suppart

B e

Note that, as well as an entry for the executable program, A-Track, the A-Track Start
Menu folder also contains a link to the A-Track Help file. This file contains the full text
of the A-Track Reference Manual (this document) and, as will be described later, can
be accessed from anywhere within the A-Track program while it is running by using the
normal Help menu, or by pressing the F1 key at any time.

The third entry within the A-Track Start Menu folder is Uninstall A-Track which will
launch an Uninstall utility to completely remove A-Track from your computer. This is a
an alternative route to program removal compared to going through the Windows
Control Panel.

However, (for reasons known only to Microsoft) this option is not displayed directly on
the Windows 8 Start Screen, but can be accessed by a right-click on the A-Track tile —

e 9

System ODBC Data Windows
Configuration Sources (32-bit) PowerShell (x86)

Uninstall Run as Open file
i administrator location
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If an A-Track tile does not appear on the Start Screen, you can access the program by
a right-click on a blank area of the Start Screen, then on the ‘All apps’ option (or in
Windows 8.1 click the All Apps @ button on the Start Screen), and then locating the

A-Track group of tiles.

While you can click on ‘Uninstall’ and go through the normal Control Panel process, an
alternative is to click instead on the ‘Open file location’ option and then double-click
on the Uninstall A-Track option shown when the File Explorer window opens —

Shortcut Tools ] Application Tools

Home Share View Manage Manage
L\ -H <« Microsoft » Windows » Start Menu » Programs » A-Track v ¢ Search A-Track o
-
B Desktop ~ MName Date modified Type Size
[z Libraries @ A-Track Help 03/10/2013 20:11 Shortcut 2KB
@ Homegroup #h A-Track 03/10/2013 20:11 Shortcut 2KB
(B Tery [ Uninstall A-Track 03/10/201320:11  Shortcut 2KB

. AppData
) Application Data

This window also gives you access to the A-Track Help file, although alternatively this
can be reached from the Start Screen by a right-click on a blank area of the Start
Screen, then on the ‘All apps’ option (or, in Windows 8.1, click the All Apps @
button on the Start Screen), and then locating A-Track Help in the appropriate group
of tiles —

Services
System AN, A-Track ~=% Keyspan Serial
Configuration it b Assistant Filler 2(]

System Information oy A-Track Help

Task Scheduler Digital Certificate L1, Microsq
. for VBA Projects

Windows Firewall rse | Jasc Paint Shop Pro Digital Certificate
with Advanced... <8 8 | for VBA Projects

Returning to Uninstall, note that, when using Windows Vista, Windows 7, Windows 8,
Windows 10, or Windows 11 their default security settings will display one or two
warnings, requiring you to allow the uninstall program to run.

The Uninstall process then starts (except in Windows XP) with two requests for
confirmation —
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Do you want to allow this app from an
unknown publisher to make changes to your
device?

unins000.exe

Publisher: Unknown
File arigin: Hard drive on this computer

Show more details

Yes Mo

A-Track Reference Manual

Since the A-Track installer gives the uninstaller a rather anonymous filename
(unins000.exe), you can always check that this is the correct file by clicking on ‘Show
more details’, where you can see that this is, in fact, the A-Track uninstaller —

User Account Control e

Do you want to allow this app from an
unknown publisher to make changes to your
device?

unins000.exe

Publisher: Unknown

File origin: Hard drive on this computer

Program location: "C:\Program Files (x86\A-Track\unins000.exe" /
INITPROCWND=$3E0826

Change when these notifications appear

Hide details

Yes Mo

With or without showing the details, click Yes to proceed, when you will see the
second request for confirmation —

A-Track for Windows Uninstall

Are you sure you want to completely remove A-Track for Windows and
all of its components?

Yes . Mo

Click Yes again to continue (or No to abandon the uninstall process).
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During the uninstall process in Windows XP you may be presented with a set of
windows inviting you to remove shared files which were installed with A-Track, and
which are not believed to be used by any other installed program. For example —

A-Track for Windows Uninstall

Uninstall Status
Please wait while A-Track For Windows is removed from wour computer,

Remove Shared File? |

U The system indicates that the Following shared fils is na langer in use by any
programs. Would you like For Uninstall ko remove this shared File?

|i If any programs are skill using this file and it is remowed, those programs may
nok funckion properly, IF wou are unsure, choose Mo, Leaving the file on your
syskem will nok cause any harm,

File: narne: IATrack4CmndSvr.exe
Location: IC:'l,F‘rogram Files\f-Track.
‘es bo Al Mo Mo ko All |
Copyright ©)2008-2013 A-Train Systems Installation by Inno Setup 5.5.2 -

Zanicel |

Leaving these files in place will not cause any harm, nor slow down the performance of
your computer, and is the ultra-safe approach, but you can choose to uninstall them if
you wish, by clicking on the appropriate button shown above.

The A-Track program itself is then uninstalled —

A-Track for Windows Uninstall

Uninstall Status
Please wait while A-Track for Windows is removed from your computer,

Uninstalling A-Track for Windows...

Cancel

— followed by a final confirmation window —
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A-Track for Windows Uninstall

o A-Track for Windows was successfully removed from your computer.

Click OK to complete the uninstall process.

In some circumstances you may see a different confirmation window —

A-Track for Windows Uninstall

o A-Track for Windows uninstall complete,

Some elements could not be removed. These can be removed
manually.

Generally this will occur when changes have been made to the installation folders or
their contents following installation (not to be recommended at any time), or you have
saved some of your own files to an installation folder (again not really recommended),
and the A-Track uninstaller is unable to remove one or more installation folders
because they contain a file which is either unrecognised or is currently open.

After clicking OK in such cases, you can either leave the remaining files or folders in
place, since they will not generally have any adverse effects on your computer’s
operation, or you can open the A-Track installation folder in C:\Program Files (or
C:\Program Files (x86)) and manually delete, or move, the offending files or
folders.

One situation where this can arise is where, for some reason, A-Track has not shut
down correctly and the A-Track Command Server file is still running in the background.

In such a situation, one option is to open Task Manager, locate the file (A-Track4-4
DCC Command Server) in the list of background processes, and click the End task
button, as shown below —
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i Task Manager

File Options View

~
Name
Apps (5)
@ Microsoft Office Word (32 bit)
| 0] Microsoft Qutleok (32 bit)
B, Paint Shop Pro 8 (32 bit)
il Task Manager (2]

m Windows Explorer

Background processes (60)
[85] AMD External Events Service Module
[8z] AMD Fuel Service
[#5] AOMEI Backupper Schedule task service (32 bit)
B3 A-Track4-4 DCC Command Server (32 bit)
s~ Catalyst Control Center: Host application
% Catalyst Control Center: Monitoring program

da Classic Start Menu

| Fewer details

Processes  Performance App history  Start-up  Users Details  Services

Status

71%

CPU

0%
0%
0%
0%

0%

0%

0%

42%

Memory

45.5 MB
244 MB
454 MB
249 MB

78.8 MB

0.6 MB
0.8 MB
1.1 MB
14.8 ME
21.5 MB
3.1 MB

2.3 MB
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13%

0 MB/s
0 MB/s
0MB/s
0MB/s

0 MB/s

0 MB/s
0 MB/s
0 MB/s
0 MB/s
0 MB/s
0 MB/s

0MB/s

Disk

0%
Metwork

0 Mbps
0 Mbps
0 Mbps
0Mbps

0 Mbps

0Mbps
0Mbps
0Mbps
0 Mbps
0 Mbps
0 Mbps

0 Mbps

End task

After ending the A-Track Command Server task, you will then be able to delete the file

and the installation folder.

Alternatively, you can simply close all of your other programs and restart the
computer. Once restarted, and with no parts of the A-Track application running, you
should be able to delete the A-Track installation folder, if required, without further

problems.

Note that, in all cases, uninstalling A-Track will still leave a small set of A-Track custom
settings within the Registry. These settings are stored automatically during your
normal use of A-Track and reflect your preferences regarding window formats and
views, together with lists of the most-recently used files and any selected options. If
you then reinstall A-Track at a later time, your preferred settings will be re-applied to
configure A-Track. The custom settings occupy a very small proportion of the Registry
and will not have any discernable effect on the performance of your computer or other

applications.

Warning : unless you know exactly what you are doing, do not attempt to edit or
delete any item within the Registry, since any change made incorrectly can have
disastrous consequences (changes take effect immediately, and there is no Undo
facility), and may crash your computer completely or render it unable to run properly

in future.
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3.5 Starting the Program

Start A-Track from the Start Menu, as shown in Section 3.4, or by double-clicking the
A-Track icon (#4) on the Desktop, or in Windows 8 by clicking the A-Track tile (#&) on
the Start Screen.

A-Track displays a start-up window in front of its main window, and then checks to see
if any NCE Power Cab. Smart Booster, DCC Twin, or Power Pro Command Stations are
connected to any of the PC’s Serial or USB ports (and powered-on) —

#4& A-Train Systems Version 4.4.301

eacTRECK

Digital Command Control
with NCE Power Cab and Power Pro

Scanning for Awvailable COM Interface Connections

T B
Toc el AT

Copyright @ 2007-2020 JT Chamberlain A

If no connections are detected, then you will see the window contents as displayed
below —

5 A-Track - No NCE System Connected

File Edit View Item NCEXRoute Mimic Help

FEFfFsEE@ I NERY (o (R F TORENS Swe P

Description \\ IType ]Fiags l PtAddrI Emddr] Controller iSpStsl Speedl FL] FuncH-SI
NN

Window Title shows Connection Status

“ A-Train Systems Version 4.4.301

sarTRECEK

Digital Command Control
with NCE Power Cab and Power Pro

No Connections to NCE Systems Available

Register A-Track (Free) for Priority Product Su r ]
i E 0 (Free) rity ppo H:)cg_m

10110

Copyright ® 2007-2020 JT Chamberiain =N~

Connection Status for NCE Command
Station and Serial / USB Interface
(neither connected at this time)

Item List : None Loaded \ NCE @ @ COM @
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The three indicators on the status bar (in the bottom righthand corner of the main
A-Track window) are red to show that no NCE hardware unit is currently connected or
operational, and this status is also shown on the window title bar.

If any NCE Command Stations are connected to your PC, and switched on, the
presence of up to four such systems will be detected by A-Track, and you will then be
able to select which of those Command Stations you wish to use with A-Track at this
time. Each Command Station will, of course, be connected to a separate section of
track, such as the main layout, a fiddle yard, an isolated programming track or,
possibly, a separate accessory (turnout) network.

Power Pro systems are connected either via a suitable RS232 Serial cable or USB-to-
Serial converter plugged into the 9-pin Serial Port socket on the front panel of Power
Pro system, with the other end of the serial or USB cable plugged into the appropriate
PC port. Alternatively, Power Cab, Smart Booster, or DCC Twin systems are connected
via an NCE USB Interface unit connected between the Command Station’s Cab Bus and
one of the PC’s USB ports (either USB 2 or USB 3 ports can be used).

The handling and selection of multiple Command Station connections is dealt with in
detail in Section 9.6, but it is easier to start with the more usual case where only a
single Command Station is connected to A-Track. In all cases, a message appropriate
to the type of system being connected will be displayed in the start-up window —

) A-Track - PowerPro - COM 05
File Edit View [tem NCE Route Mimic Help

Description | Type | Flags | Préuddr | Ewéddr | Controller | SpSts| Speedl FL| Funct 1-8

“ A-Train Systems Version 4.4.201

sarTRECEK

Digital Command Control

with NCE Power Cab and Power Pro

System Found - NCE PowerPro - COM 05

i IDCCL
7o el R

Copyright ® 2007-2020 JT Chamberlain

Itern List : Mone Loaded NCE @ | @ COM @

If a connection to an NCE Power Pro Command Station exists when A-Track is started,
successful completion of the connection will cause both the left- and rightmost
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indicators to turn green (assuming the Command Station is switched on) and the
identity of the connected Command Station will appear in the title bar of the window,
as shown below. The program then transfers the data representing the status of all
Consists (sets of locomotives to be controlled as a single unit), as currently held in the
Command Station, to the memory of the PC. Retrieval of the data block takes less than
10 seconds to complete, with progress displayed on the screen, again as shown below.

During the transfer period, you should not operate any of the NCE Handheld
Controllers (Cabs) since there is a small risk that communications between A-Track
and the Command Station can be disrupted —

s

File Edi NCE Route Mimic Help

I TL L tRXM | oo | BRI TSNS Swe|?

Description \\ lT_l.ape lF[ags I PrAddr] ExAddr[ Controller lSpStsl Speed] FLI Funcl1-8]
N

Connected System

#4& A-Train Systems Version 4.4.301

) NCE Data Transfer - Consist Status

Please wait for data transfer to complete . . . .
Do not operate NCE Handheld Cabs at this time

Register A-Track (Free) for Priority Product Support M
= P DCC
g Copyright © 2007-2020 JT Chamberiain AR

Connected to NCE Power Pro Command
Station and USB / Serial Interface

e NCE @ ®)/C0M @

If you hover your mouse cursor over the status bar panels containing the NCE and
COM indicators, pop-up labels will appear displaying, respectively, the Command
Station Software Version, and which of your computer’s COM ports is currently being
used by A-Track to connect to the Command Station, together with the bit (baud) rate
at which the serial link is operating, as shown below —

[ [
NCE & COM & NCE & COM ﬁ

Item List : None Loaded

|Cor|r1ected - Power Pro Ver 5.2.1| |C0nnected -COMS @ 1920D|

You will also notice the display of a banner in the lower part of the start-up window
inviting you to register (free) for full, priority support of A-Track. Registration is purely
voluntary, and A-Track is fully functional in all respects after installation.
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If you do choose to register your copy of A-Track, by following the simple steps
described in Chapter 11 of this Reference Manual then, whenever you subsequently
start A-Track, your name will be displayed in the start-up window instead of the
registration invitation.

You may install and operate A-Track on as many computers as you like, but note that
each installed copy of the application will have a different serial number. Although this
means that each installation has to be registered separately (if you wish to do so), the
online registration process via the A-Train Systems website, as described in Section
11.1, is fully automated, and so does not require a great deal of time nor effort.

If an NCE Power Pro Command Station is not connected until after A-Track has
completed its initialisation, loading of the Consist data block is postponed until the
Command Station is plugged in, and powered on. Loading will then proceed as before
(although it may take up to 10 seconds before A-Track recognises the new connection
and the data transfer starts), with display of the progress bar in the centre of the
A-Track window. Allow the data transfer to complete without interruption.

The third, middle indicator on the status bar, which is initially red, then replaced with
an icon indicating the type of connection established (@ here), is used to show the
progress of A-Track in acquiring the status of all NCE Handheld Cabs connected to the
NCE Power Pro Command Station. After retrieval of the Consist data, the lefthand
panel of the status bar will turn red and will show which Cab details are being
accessed, firstly whether a particular Cab is connected and then loading the data for
each active Cab, as shown in the examples below —

| [
5 ¥ Reading Status of All Cabs [including AU ) << Please Wait »> Cab 38 Status <<< MNCE & |@ COM &

s »>» Reading Status of &l Cabs (inchuding A11s] << Please W ait »> Cab 02 Data <<< WCE & | COM & ‘

|Reading Data from Cab DEl

During this process, the middle indicator on the status bar will alternate between red
and yellow while the status of all Cabs is being read, then between yellow, and
green while the full data from all connected Cabs is retrieved. If any Auxiliary Input
Units (AlUs) are connected to the NCE Cab Bus, the middle indicator will briefly flash
blue while the state of their inputs is being loaded. Hovering your mouse cursor over
the middle indicator will also display a pop-up label showing the current operation in
progress, as can be seen above. After the full scan is completed, the middle indicator
returns to the icon representing the type of connected Command Station ({fg here).

The time taken to complete this full scan is 2 to 3 seconds per connected Cab if
connected to an NCE Power Pro, or about 5 to 7 seconds per Cab when using an NCE
Power Cab or Smart Booster Version 1.65 system, or a DCC Twin system. Including
setup time, and because the complete status for Cab Address 02 is always transferred
to A-Track, whether or not a Cab with this address is actually connected, the minimum
total scan period is about 15 seconds.

Thereafter, A-Track will monitor the status of the Locomotive allocated to, and
currently under control from, each connected NCE Cab (but not those in the Cab Recall
List), reading the status of each Cab in turn at approximately 1-second intervals,
together with the status of any connected AlUs (and hence the position of all
connected layout turnouts and/or occupied track blocks). If you are using a USB-to-
Serial converter which is fitted with one or more LED indicators, then you may see the
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indicators flash to show the transfer of the relevant commands and responses. This will
definitely be the case when you are using an NCE Power Cab or Smart Booster Version
1.65 system, or a DCC Twin system, with a Version 7 NCE USB Interface unit, as
described later in this Section.

While a Command Station is connected, you can update the displayed Cab allocation
and full Cab status at any time by clicking the Refresh (&) icon on the A-Track
toolbar or by clicking on View on the A-Track menu bar, followed by Refresh Item
Allocation & Status (See Sections 4.1, 9.4, and 12.3).

In normal operation you really only need to use the Refresh (&) facility when you
plug in a new Handheld Cab or connect an extra Auxiliary Input Unit to the Command
Station.

When you use the View menu option, you will be asked whether you wish a periodic
scan (every 6 minutes) of attached NCE Cabs to be performed automatically —

Cab Status - Automatic Update

=% Automatic update of NCE Cabs Status

. / (every & minutes) is currently disabled

After this manual status update, do
you wish to enable automatic updates 7

Click Yes to enable future automatic scans of NCE Cab status, or No to leave further
scans disabled (a scan will be performed this time). Leaving scans disabled is preferred
if you are actively using A-Track, particularly if are intending to adjust the setup of the
NCE Command Station or Cabs, or to change Consist or Macro settings, without being
interrupted periodically (all editing is disabled during a Cab status scan). Further
details of the way in which the NCE System Status data is handled can be found in
Chapter 9.

A tick mark next to the Refresh Item Allocation & Status option on the View menu
will be displayed to indicate that periodic scans of attached NCE Cabs are enabled. In
this state, every 6 minutes, A-Track will automatically re-scan the status of the NCE
Cabs attached to the Command Station. The current Cab allocation and status will be
cleared from the Item List (as described in Section 3.7, and in detail in Chapter 4),
the lefthand panel of the status bar will turn red and will show the scan details, and
the middle indictor on the status bar will sequentially show red, yellow and green,
returning to the appropriate connection icon when the full re-scan has been completed.
Your choice of whether to enable or disable periodic scans of attached NCE Cabs is
saved by A-Track and will be applied each time the program is subsequently started
(until you change the setting).

Connecting your computer (and A-Track) to an NCE Power Cab, Smart Booster, or DCC
Twin via an NCE USB Interface unit, will also result in both the left- and rightmost
indicators turning green, assuming that the relevant NCE equipment is powered on.

However, when using an NCE Power Cab, Smart Booster, or DCC Twin as the
Command Station, the third, middle indicator on the A-Track status bar will now be
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replaced by an icon showing the type of connected unit reported by the NCE USB
Interface. Note that the NCE USB Interface does not actually identify the type of NCE
equipment to which it is connected, but simply reports the current setting of its three
active configuration jumper links (JP2, JP3, and JP3 — JP1 is not used). See the latest
NCE USB Interface documentation for full details.

Important Note : When an NCE USB Interface is connected between the PC and a
Power Cab, Smart Booster, or DCC Twin system, the USB Interface uses one of the
available Cab Addresses. A Version 6 USB Interface always uses Cab Address 03,
while A-Track will set a Version 7 USB Interface to Cab Address 10. Hence, to
prevent any interference and ensure correct system operation, you should make
certain that none of your attached Handheld Controllers (Cabs) are set up with
either Address 03 or 10, depending on the type of USB Interface being used.

Version 1.65 Power Cab systems reserve address 08, 09, and 10 for AlUs and like
devices, and you can use addresses 03, 04, or 05 for connecting Handheld Cabs or
additional AlUs (address 02 is used by the Power Cab itself). When using a Smart
Booster or DCC Twin system, addresses 02, 06, and 07 are also available for use by
either Handheld Cabs or AlUs. Refer to your NCE system documentation for details
of how to set the Address assigned to a particular Cab.

Connecting to an NCE Power Cab Version 1.65 through an NCE USB Interface results in
the A-Track window shown below —

) A-Track - PowerCab - COM 10

File Edit View |lte NCE Route Mimic Help

B B iE & : ) ) 3 ¢

Description \\ I Type I Flags l PrAddr] ExAddr[ Controller I SpStsl VSpeed] FLI Funct 1-8]
NN

Connected System

#4& A-Train Systems Version 4.4.301

sarTRECK

Digital Command Control
with NCE Power Cab and Power Pro

NCE USB Interface - Connecting - NCE PowerCab - COM 10

Register A-Track (Free) for Priority Product Support H
*? P 2A lﬂE]"I‘.n:Eln
3 Copyright @ 2007-2020 JT Chamberiain 'L=8'1= 8]

Connected to NCE Power Cab
via an NCE USB (V7) Interface

\ NCE @ @)COM ©

The icon displayed in the middle indicator position on the A-Track status bar reflects
the jumper link settings which are automatically read by A-Track when it is connected

| Item List : None Loaded
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to the NCE USB Interface, and depends on which version of the USB Interface unit you
are using, as well as the setting of the configuration links.

For the two versions of the USB Interface unit currently in use (Versions 6 and 7), the
displayed icons are shown in the following tables. Note that jumper 1 (JP1) should
always be set to OFF to ensure that the speed of the USB COM port (the connection to
the PC) for the Version 6 USB Interface is maintained at the required 9600 bps —

NCE USB Interface Version 6 (pre-2013)

Icon |Connection Jumpers Icon |Connection Jumpers
(M) |Power Cab All OFF (@5 |All Systems JP3,4 ON

@ Smart Booster JP4 ON

Power Pro 2007 JP3 ON @ Undefined All other settings

NCE USB Interface Version 7 (2013 on)

Icon|Connection Speed|Jumpers|lcon|Connection Speed|Jumpers
Power Cab Power Cab
@ Version 1.28c 9600 | All OFF @ Version 1.28c 9600 | JP2 ON
Smart Booster Smart Booster
(1) |sB5 7 sB3a |19200| JpaoN | [B] [sB3/SB3a  [19200 |3P2,4 ON
Version 1.65 Version 1.28d
Smart Booster Power Pro
(@ |sB5/sB3a | 9600 | JP3ON | [B] 9600 |JP2,3 ON
| / 2007
Version 1.65
Power Cab /
. All Systems JP2,3,4
(@ |pcc Twin 19200 | JP3,4 ON Verdion 1 65 |19200] o
Version 1.65

Again, if you hover your mouse cursor over the status bar panels containing the NCE
and COM indicators, pop-up labels will appear displaying, respectively, the NCE USB

Interface Software Version , and which of your computer’s COM ports is currently being
used by A-Track to connect to the Interface, together with the bit (baud) rate at which

the serial link is operating, as shown below —
MCE @ [Z1/COM C&_I

[Connected - COM10 @ 19200|

NCE @ (@) coM @
Ly

|Connected - USE I/F 7.3.3 - Power Cab Ver 1.658)|

Note that, as here, when using a Version 1.65 NCE Power Cab system with a Version 7
NCE USB Interface, the System Type can actually be read from the Command Station
and so can be displayed accurately. With a Version 6 NCE USB Interface and/or a
Version 1.28 NCE Power Cab system, the System Type cannot be read from the
Command Station, so can only be assumed from the state of the USB Interface
configuration links.

Important Note : To ensure that A-Track will generate the correct set of
commands when communicating with the NCE equipment, it is highly
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recommended that you set the NCE USB Interface configuration links so that their
positions correspond to whatever type of NCE Command Station is connected to the
other side of the NCE USB Interface. Failure to do this can cause the complete
system to lock up. The position of the configuration links should only be changed
when the NCE USB Interface unit is not powered, ie. disconnected from the Cab Bus
(unplug the lead from the 6-pin RJ12 socket). While changing the links while the
NCE USB Interface unit is powered will not cause any ill effects, such a change will
be ignored both by the Interface unit itself and by A-Track until the unit is
disconnected then re-connected.

While setting the NCE USB Interface configuration links to the All Systems position
(JP3 and JP4 ON for a Version 6 unit, or JP2, JP3 and JP4 ON for a Version 7 unit)
will generally work for most connected systems, this configuration makes it more
difficult for A-Track to identify the type of connected system, and to ensure that
only appropriate commands are generated.

Since a Version 6 NCE USB Interface, regardless of the type of Command Station to
which it is connected, does not provide access to the Command Station internal data
store, A-Track is unable to access either the Consist data block or the status of any
connected NCE Handheld Cabs (including a Power Cab and any attached Auxiliary
Interface Units), and no subsequent data transfer or scan of Cabs or AlUs takes place.

If either the interface cable, USB-to-Serial converter, or NCE USB Interface is not
plugged in, or the relevant NCE Command Station is not connected or switched on,
when A-Track is started, then the status indicators will remain red. All program
functions will be fully operational except, of course, those which deal directly with the
NCE equipment.

Whenever a Command Station is subsequently connected, A-Track will proceed to
identify automatically the type of NCE equipment which has been connected, as far as
possible, and to set both the left- and rightmost indicators to green. After connecting
to an NCE Power Pro Command Station or to a Version 1.65 NCE Power Cab system
with a Version 7 NCE USB Interface, A-Track will then retrieve the Consist data block
and start the scan of the attached NCE Handheld Cabs (including Auxiliary Input
Units), with the middle status indicator changing colour appropriately, as described
previously. However, with any equipment connected via a Version 6 NCE USB
Interface, A-Track will simply display the appropriate icon in place of the middle
indicator.

Recommendation : The best way to establish a fully-reliable connection to an NCE
Command Station is to connect the Command Station through the appropriate
interface to your PC, power up both PC and NCE equipment, then start A-Track. If
A-Track is already running on the PC before connecting and powering up the NCE
equipment, ensure that only the main A-Track window is open.

Note that, once a connection has been established, if the NCE Command Station is
disconnected or switched off, the leftmost indicator will change to yellow, returning to
green when the unit is again operational. Be aware that A-Track can take between 10
and 20 seconds to react to any change in the state of the Command Station,
depending on the number of active COM ports on your computer which have to be
scanned.

If, at any time when A-Track is running, the interface cable is disconnected from the
PC, then both of the left- and rightmost indicators will change to yellow within 2
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seconds, returning to green within 15 seconds after the connection is re-established
(and the Command Station is operational). However, it is recommended that the
Command Station is not deliberately disconnected from the PC Serial or USB port
while the A-Track program is running, to avoid any possible data corruption, although
such disconnection will not result in any physical damage to the equipment.

If the switch-off, disconnection, or other communication error does occur at a critical
time when data is being transferred to or from the Command Station, then the
hardware or software may be left in a state from which an orderly recovery is not
possible. This is very likely to occur if the disruption occurs during the A-Track
initialisation period, or if the equipment is re-connected very quickly after any
disconnection. In such cases, first disconnect the serial or USB cable, then close down
A-Track (see Section 4.3), and switch off the NCE Command Station. Allow around 20
seconds for the Command Station to power down fully, then switch it back on,
reconnect the cable to the PC, and start the A-Track program again.

With all types of Command Station, the middle status indicator will revert to red after
any disconnection, then subsequently show yellow and green followed by display of
the relevant system-type icon, after reconnection and completion of a full Handheld
Cab status scan where appropriate.
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3.6 An Introductory Tutorial

Once A-Track has completed its initialisation, the start-up window disappears and will
be replaced by a Tutorial window which you can use to get a feel for the basic
facilities provided by the A-Track program, including how to access the key menus and
functions, and which will then guide you through the first steps in using A-Track with
your own roster of locomotives.

The opening page of the Tutorial is shown below, with its straightforward controls.
Having read the first page, click on the Next button to display the next page.
Thereafter, you can return to a previous page by clicking the Back button, which will
then be enabled. For your information, the number of the current page is displayed in
the bottom righthand corner of the Tutorial window.

If you want further information about the topic described on any Tutorial page then a
click on the More Info button will open another window showing the appropriate
section from the full A-Track Help Topics (the contents of this document).

You can stop viewing the Tutorial, and remove it from the screen, at any time by
clicking on the Close Window button.

=
File Edit View [tem MNCE Route Mimic Help

AEEtdE@S ] br &) & 2

Diescription T unct 1-8

Getting Started - A Tutorial - to Follow a Bit at a Time

| Welcome to A-Track - Your DCC Buddy

This short tutorial will get you started with the program - and will stay on the screen
while you try out the A-Track controls - just drag it aside (click on the title bar with
the words "Start-Up Tutorial” at the top of this window, hold down the left mouse
button, and move the mouse) so that you can see the contents of the main A-Track
window as well as the tutorial - and can click on the A-Track menubar and toolbar
to investigate the available menus and options as you follow the tutorial pages -
hence, maximising the A-Track window at this time is not recommended.

During the tutorial, click More Info below to view full, detailed information about
the current tutorial page by displaying the relevant section of the A-Track Help
Topics - which are always accessible when using A-Track by pressing the F1 key.

Click the Close Window button to remove the tutorial completely from the screen.
If you no longer want this tutorial window to appear each time you start A-Track,
then tick the 'Do not display at start-up' checkbox below, before closing the window.

Wait, if your NCE system is on and connected to the computer, for the scan of
attached Cabs to finish, and until the Next button is enabled, then click Next to
proceed with the tutorial -

[ Donaot display at start-up | NeH}\A Index ‘ More Info Cloge Window 1
|

|G0 to Mext Tutorial Topicl

i35 Item List : Mone Loaded NCE @ [BICoM @

Although the Tutorial window is always displayed in front of the main A-Track window
(and all other open windows), you should drag it to one side, to leave the Tutorial
window on the screen where you can see most of the main A-Track window as well the
contents of the Tutorial (move the mouse pointer to the window title bar, where the
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text ‘Start-Up Tutorial’ is shown, hold down the left mouse button, and move the
mouse to drag the window to where you want it to be, then release the mouse button).

As you step through the Tutorial, various A-Track functions and features will be
demonstrated, with additional windows being opened as necessary. It is important to
note that all of the main A-Track controls, and those in all of the demonstration
windows, are fully operational when the Tutorial is running, especially if an NCE
Command Station is connected and powered-on (like the Power Cab Version 1.65
system indicated here). Hence, you are free to explore further, at any time, any
particular A-Track feature which is of interest to you — which is by far the best way to
get to grips with A-Track. You cannot cause any damage to the program or its files by
doing so.

However, note that, after branching off on your own from the Tutorial, and changing
the state of the loaded A-Track data, it may not be possible for the Tutorial to continue
on its intended course when you click the Next or Back button. A message to this
effect will be displayed, inviting you to click Close Window, after which you can, if
you wish, restart the Tutorial by clicking on Help on the A-Track menu bar, followed
by Start-Up Tutorial (See the menu details in Section 12.8).

The Start-Up Tutorial window will appear each time you start A-Track unless you click
on the ‘Do not display at start-up’ checkbox in the bottom-left corner of the window.
At any future time after you have done this, the Tutorial window can be displayed once
more from the Help menu by selecting Start-Up Tutorial.

If you want to print out any page shown in the Tutorial window for reference, you can
highlight the text by using the normal Windows procedure with the left mouse button,
copy the highlighted text (hold down either Ctrl (Control) key, then press the C key),
and paste it into any word processor.

A more comprehensive set of Help pages (the full text of this Reference Manual) can
be viewed by clicking on Help / Help Topics on the A-Track menu bar, or on the §
icon on the A-Track toolbar, or by pressing the F1 key on the keyboard at any time.
Using the F1 key will open the Help Topic most appropriate to the current A-Track
activity in progress.

As noted in Section 3.4, you can also access the Help pages directly (without running
the A-Track program) from the Windows Start Menu, by clicking on Program Files or
All Programs, selecting A-Track, then clicking again on A-Track Help.

From the Windows 8 Start Screen, the link to the A-Track Help file is revealed by right-
clicking on a blank area of the screen, then on the ‘All apps’ option, and then locating
the Help entry in the A-Track group of tiles.

Although the Tutorial has been kept as short as possible, while still covering all of the
main A-Track features, you will probably find it difficult to absorb all of the information
presented in a single session. Hence, the Tutorial has been split into nine sections,
each covering a single topic. After following one or two sections you can quit the
Tutorial, try out the features described for yourself, and then return to the Tutorial at a
later time, to pick up at the next section.

After clicking the Next button on the Welcome page, the Section Index page will
appear, as shown below —

Chapter 3 Page 40 of 538 Version 4.4.34



A-Track Reference Manual

2 Start-Up Tutorial — ®

Getting Started - A Tutorial - to Follow a Bit at a Time

Index to Tutorial Sections

The sections of the tutorial are listed below in the order in which they are presented.
This index can be displayed at any point in the tutorial by clicking the Index button.

You can either continue to follow the tutorial in sequence, by simply clicking the
Continue button below at this point, or choose to skip to a particular section (page
number) by clicking on the relevant option below, and then clicking Continue -

0

Items and Item Lists (2)

Editing Items and Configuration Variables (5)
Item List Operations (18)

NCE System Parameters (22)

Control of Locomotives and Accessories (23)
Defining Routes and Macros (26)

Mimic Diagrams, Block Detect & Route Select (29)
Help, Registration and Support (37)

Creating Your Own Item List (39)

SIS NS TS NS IS IS IS

[~ Do not display at start-up | | | tare Info Cloze Window 1

To start viewing the first section of the Tutorial, simply click the Continue button or, if
you wish to skip forward to a later section, click on the name of that section before
clicking Continue. The starting page number of each Tutorial section is shown in
brackets after the title of the section.

Wait until the necessary part of the Tutorial has been loaded (or reloaded) and then
proceed with the Tutorial. You can move forward or back through the complete Tutorial
from any selected section by using the Next and Back buttons.

At any point, a click on the Index button will display the Section Index page from
which you can skip to any other section —

H;E!earéa Up to 256 macros can be defined and all can be stored in an NCE Power Pro system 0000008
% &= (first 16 in a Power Cab V1.65 system) if you wish to run them from a Handheld Cab
S&Eme E'g - or all 256 macros can be run directly from A-Track using any type of NCE system. —
i . .

D&H;:; Pe See the Reference Manual, or click More Info, for further details. >
I:I&;SilverP Click Mext to continue - 000
% Fire Crs 20050
ﬁ ForestF| [~ Da nat display at start-up Back ‘ Next ‘ IndexIJ Mare Info ‘ Closewindow | 26 |030
1% McGilig — | o
Dﬁ MecGiligan Lumber #2 - HCE Switch-lt ME2 Access'y F - = — - 10

— — |Display Index of Tutorial Secti ==
[ D4R G 2-Truck Shay - D142 Laea P [Disp O e O e S ions & Fom
A7 Itern Lizt - T\ sers\UsertD ocurments'd-Track Item ListzWAT-Tutarial-Derno-44 it & lternz - 27 Curent: 27 |NCE @ [BICOM &
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3.7 Making a Quick Start

If you do not wish to work your way through the complete Tutorial, the final part,
which takes you through your first practical steps in using A-Track, where you can
collect details from selected locomotives in your roster, is detailed in this Section of the
Reference Manual for your convenience.

It is assumed that you have gleaned enough from the Tutorial to understand that the
details of each of your locomotives (or other pieces of equipment) in your roster will be
held by A-Track as an Item, with a group of Items forming an Item List. Full details of
Item Lists, and of Item List operation, are covered later in Chapter 4.

Ensure that your computer is connected to, and communicating with, an operational
NCE Command Station — either a Power Cab or Power Pro system — with the status
indicators in the bottom righthand corner of the A-Track window showing green, as
described in Section 3.5 above.

Next, click on File on the Menu Bar, and then New, as shown below —

) A-Track - PowerPro - COM 05

File Edit View Item NCE Route Mimic Help
GENNE (I POy e S

New
gpen\h Ctrl+0 Exaddr | Controller | SpSts|  Speed|
Open Merge Ctrl+M

Close Click ‘New’ to create
Auto Load tem List | yoOur initial Item List

Save As... Ctrl+5S
Save Checked...

Properties

Combo Data Restore Setup

Item List used for
‘Getting Started’ Demo

Auto Load AlU Allocation

Auto Load Mimic Set

Print... Ctrl+P

C:\Users\Use ... -Track Item Lists\AT-Tutorial-Demo-44.itl

Exit

- which will create your first Item List, containing a single blank Item, that you can
then use to collect full details of the first locomotive in your roster —

B A-Track - PowerPro - COM 03
File Edit WView [tem MNCE Route Mimic Help

NEFfFe @S & @ MmBAY R BHENE S Kl

Préddr
»000

Funct 1-8

Type Controller

Hone

Description
[MP T Elank Item #1

At this point you can, if you wish, click on Edit, and then on Insert Blank Item, to
add further blank Items to match the number of locomotives you have. Alternatively,
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you can repeatedly click on the E'i icon on the Toolbar to perform the same operation
— or you can leave this step until later —

) A-Track - PowerPro - COM 05

File Edit View Item NCE Route Mimic Help
A @ Undo -z B o> mBRAQR HENREE S
| Desc Redo Ctri+Y Type I Flags l PlAddrl Ex&ddtl Controller | SpSlsl Speedl
C#x None P >000 0000
O&  Eind CtlF | None  _P_ >000 0000
Cléa Cut CtlsX 00 0000

Cut Append Ctrl+U

Copy Ctrl+C

Copy Append Ctrl+D

Paste Ctrl+V

Empty Buffer Ctri+E

Insert Blank ltem k Shift+|ns\

Delete tem Del N

Check All Ctrl+K

Check Selected cui«L | Click to add a new blank

Inyert Checked cti+) | 1tem to the Item List

Select Al culen | ~ OF use the Toolbar icon

Invert Selection Ctrl+1

Now, double-click on one of the blank Items in the Item List — which will open an
Edit Configuration Variables window. Full descriptions and details of all of the
features and functions of this window can be found in Chapter 5.

However, for the moment, press the F1 key on the PC keyboard which will open
A-Track’s Help Topics, and show you the page describing the 'Edit Configuration
Variables Window'. Now click, in the lefthand panel of the Help Topics window, on the
topic 'Initialising a Blank Item' under 'General Item Operations' —

E? A-Track Help 44-3 - m] X
& 2> o &
Hide Back Forward Home  Print

Contents | Search | Favourtes | Edit Configuration Variables Window A

] Q A-Track and Your DCC System
u.] System Requirements
® Q Getting Started
@ tems and kem List Operations
= Q_J] General tem Operations
et Configuraton Variabes Wi
] Setting Key tem Parameters
Initialising a B ftem
£] Editing CV Values
0 Locomotive item Operations

Click on Edit CVs in either menu, or on the & icon on the toolbar (see General Item
Operations), or simply double-click on the Item itself in the Item List to open the Edit
Configuration Variables window for the selected Item -

Item #6 - Addr 2011 - Configuration Variables

‘ Item Description [DERGW 2-Truck Shay - DN142 Item )
o = : : : = Description
Piogion CVs | [Identity| Config | Speed | Funct'n) Pages | SUSI

|

\ _ReadNedy OVs
Click to switch to the Help Topic
on ‘Initialising a Blank Item’

Item Type Primaty Address

In this Help Topic you will be able to see the steps required to change the blank Item
into a Loco Item with a Description which matches one of your locomotives. The same
information can be found in Section 5.3 of this Reference Manual —
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Hide

I EA

Back Forward Home

=5

Prirt

Contents |§earch | Favourtes |

@ A-Track and Your DCC System
':Q System Reguirements
@ Getting Started
@ ltems and ftem List Operations
= I:QI General tem Operations
@ Edit Configuration Variables Win
@ Setting Key tem Parameters
i niteising s Bani ten)
[£] editing CV Values Directly
@ Locomotive ftem Operations
@ Accessory tem Operations
@ Mimic Diagrams, Turnout Control anc
@ WCE Command Station and Cab Ope
@ Printing Lists and tem Details
@ Registration and Support
@ A-Track Menus - Reference
@ Installation of USB-to-Serial Interfac
@ Using MCE Auxiliary Input Units.
A-Track Revision History
@ A-Track End-User Licence Agreeme

Initialising a Blank Item ~

Before looking at the other Parameter Tabs, it is worth going through the initial actions
you need to perform under the Identity and Config Tabs when adding a new Item to
the Item List, ie. starting with a Blank Item inserted using the Edit action described at
the end of Editing - Cut, Copy, and Paste. Part of this process was previously covered
in Making a Quick Start as a quick, practical introduction to the usage of A-Track.

A double-click on the Blank Item opens an Edit Cvs window as usual, but showing all
Item parameters with zero values.

Your first action must be to select the Item Type - the available choices are
Accessory, Consist, and Locomotive, as shown below. You cannot proceed to define
any other parameters while the Item Type remains at None. Your selection will change
the Item Description appropriately, and highlight it in pink, indicating that it has
been changed since the Edit CVs window was opened. Note that once you have
selected an Item Type you cannot change it to another Type - if you select the wrong
Type by mistake, simply click Close, select No when prompted to update the Item,
then double-click on the original Blank Item to re-open it in a fresh Edit CVs window.

Ibem 228 - Addr 000 - Configuration Variables

“ Item Description [[lar lem 520

| Idcnnlvl Config | Speed IFunct'nl Pages | SUSI
g Item Type Pimary Adcresz @ [000
™ Accessay Exiended Address i}

st Wi  Corsist Consist Address 00127
. " Locomotive User ldertifier 000
et — User Idenitiar H#2 o0
&N Manuiac Version Mo, (000
L | Manufactures ID (]} v
| —

In accordance with the instructions, click on the Locomotive option in the Item Type
section of the Edit CVs window, as the first step in entering your first locomotive’s
details into A-Track —

Item #28 - Addr 000 - Configuration Variables

Item Description |Blank Lacomotive #3
Program O | IdenlityT EunfigT SpeedTFunct'nT PagesT Susl
Ml Item Type Prirnary &ddress o3
Copy &Il Cvs | r ﬁﬁcessTry Extended Address [
Paste Main CYs - Eg::iz? I | Consist Address 1]
| e e
" Multiple . —
Paste Index'd Cvs | Marnufac Yersion Mo. 000
" None Manufacturer |0 o0
|Jpdate [tem |
& MNetalocated [0 € Edted € NotProgd
Cloze |
CV | Ox | 12| 2% | 3x | 4x [ 5% | Bx | 7x | 8x | 9% [10x[11x[12x
0 000 | 000 000 | 00O 000 000 | 000 OO0 | 000 000 000 000
1 | 003 000 000 OO0 000 000 | 00O 000 000 000 000 | 000 000
2 | 000 000 000 00O 000 000 | 00O 000 | 000 000 000 | 000 000
3 | 000 000 000 000 000 000 000 000 000 000 000 | 000 000
4 | 000 000 000 000 000 000 00O 000 | OO0 000 000 | Qo0 000
5 | 000 000 000 000 000 000 00O 000 | OO0 000 000 | Qo0 000
6 | 000 000 000 000 000 000 00O 000 | OO0 000 000 | Qo0 000
7 | 000 192 000 000 000 000 | 00O 000 | OO0 000 000 | 000 000
g | 000 003 000 000 000 000 00O 000 | OO0 000 000 | Qo0 000
9 | 000 000 002 000 000 000 000 OO0 OO0 000 000 DDD!
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- then click in the Item Description box and type a suitable description for that
locomotive, to replace the ‘Blank Locomotive’ caption which A-Track generates
automatically.

Next, click on the Pages Parameter Tab, where you should click the Specific
Manufacturer option button in the Decoder Manufacturer section.

If the make of decoder fitted appears in the drop-down list when you click on the
down-arrow () at the righthand end of the listbox, then click on that maker’s name.
Otherwise (or if you do not know the make of decoder) click the Basic /7 Other
(NMRA CV Definitions) option button. Remember that full help with setting up Item
details can be accessed by selecting the appropriate section of the A-Track Help Topics,
displayed by pressing the F1 key again if necessary.

Item #3 - Addr 000 - Configuration Variables
Item Description |AT&SF GE44 Switcher Basic | Conlig

Acceleration Adjustment

Identity| Config | Speed | Funct'n| P SUSI | | [Acceleration Rate
PT gT P T T agesT Alternate Mode Function Status F1-F8

Read ey Cv's Decoder Manufacturer Alternate Mode Function Status FL, F3-F12
Bi-Directional Communication Configuration

Coopy Al Cyg gl e [Uise) r Configuration Data

Proaran Ci's

Specific Manufacturer ©¢ Select from ligt below - Consigt Address
— Consizt Address Active for F1-F8
|Br-:nau:|'eva|5J Lirnited - Paragon 2 j Conzist Address Active for FL, F9F12

Dreceleration Adjustment

Deceleration Rate

Decoder Access Unlock,

Decoder Automatic Stopping Configuration

Decoder Lock 1D Code

EMF Feedback Cutout

Extended Address LS 8 Bits

Extended Address M5 B Bits

Forward Trim

Indexed Page Addrezs High Byte

Indexed Page Address Low Byte
| i Kick. Start

000 | 000 | ooo ngDUEJEkUEEth oo oo oo oo T ooo oo w00 Dutpu[ Contral for Function FO1

000 | oo 000 000 000 0oo 000 000 000 | 000 000 000 000 | || Output Control for Function FO2

000 | 000 000 | 000 | 000 000 | 000 000 000 000 000 000 000 || |CutputConbol for Function FO3

000 000 000 000 OO0 000 000 000 000 000 000 000 00 || [Quteut Contiol for Punction FO4

Dutput Control for Function FO5
000 000 000 000 000 000 000 000 000 000 000 000 000 | | |q skt Comtrol for Function FO
000 192 000 000 000 000 000 000 000 000 000 000 000 | | |Dutput Control for Function FO7
000 | 003 000 000 000 000 000 000 000 000 000 000 000 | | |Output Control for Function FOS

000 000 002 000 000 000 000 000 000 ood ooo ooo [ | /Cuteut Control for Function FOS

Bazic / Other [MMBA CW Definitions)

Update Iltem Lenz Elektronik

Model Rectifier Corparation [MEC)
Cloze |__|MTH Electric Trainz - Proto-Sound 3
MCE Corporation

Ox | 1x | 2x | 10SI Solutions - Quantum
000 000 (SoundTrass
on2 oo | ono | Train Contral Systems (TCS)

[ Peste o ovs |
|Postiendcr)
[Pese Incen d 0 |
| Upiebion |
| @ ]

w (o~ |o o[ || = 2|

Before adding any more details to your newly-created Loco Item, the safe way forward
is to click the Update Item button to save the basic Item back to the Item List.

With the first initialised Item shown in the Item List, you can repeat the same steps
with each of any other blank Items you added to the new Item List, by double- clicking
on them to open their own Edit CVs window, and finally saving the updated Items back
to the Item List.

At this point, before proceeding to the next stage of collecting each Item’s
Configuration Variable values from the actual locomotives, it is a good idea to
safeguard your initialised Item List, by saving it to a folder on your PC. To do this, click
on File on the Menu Bar, followed by Save As, on the drop-down menu.

When the A-Track - Save Item List window appears, a suggested filename with
today’s date is displayed (New-IltemList-09-March-20.itl in this example) — you are
free to change it to whatever other format you prefer.
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If you ran the Tutorial to the stage of loading the demonstration Item List, then the
destination folder offered will be Documents / A-Track Item Lists (otherwise
Documents or My Documents), but you can select any other folder if you wish.
Select a folder from the folder list in the lefthand pane in Windows Vista, Windows 7,
Windows 8, or Windows 10 (as shown below), or click the down-arrow (+) at the end
of the Save In: listbox for Windows XP, or choose to create a new folder, into which to
store the Item List (see Section 4.2) —

Y A-Track - Save ltem List *

1+ » This PC » Documents » A-Track ltem Lists v~ 0 Search A-Track Item Lists 2
Organise - Mew folder == v [ 7]
& This PC ~ Name Date mccl‘i;"irzcl Type Size
# 3D Objects #4 AT-Tutorial-Demo-44.itl 13/02/201916:53  A-Track ltem List 43 KB
I Desktop

|| Documents
Add-in Express
Arduino
Aszessment Results
A-Track Item Lists
Contacts

Eagle

HelpMDoc v
[ N ew- [tem List-09-Mar-20.itl v
Save as type: | Item Lists (*.itl) ~
~ Hide Folders Cancel

Once you are satisfied with the choice of destination folder, and the filename, click
Save to save your new Item List file to the selected folder (or Cancel to abandon the
operation).

The next step is to again double-click on your just-initialised Item in the Item List to
re-open its Edit CVs window.

Now, place your first locomotive on your programming track (or, if you are using a
Power Cab and do not have a separate, switched programming track as shown in the
connection diagram in Section 1.1, ensure that it is the ONLY locomotive on the main
track). Note that, if your locomotive has a sound decoder, and you are using an NCE
Power Pro system, then you will generally need to connect a programming booster
unit (such as the SoundTraxx PTB-100 — note that the alternative DCC Specialities
PowerPax is not recommended by NCE) between the Power Pro and the programming
track — a booster is not required with an NCE Power Cab system.

Click the Read/Verify CVs button in the Edit CVs window (as shown below) to display
the Read/ Verify Configuration Variables panel where, for a first attempt at
reading your locomotive decoder’s CV values, you should set the CV Range and
Scope options to Current View and All CVs, and the Mode to Paged. While Direct
Mode will read CV values more quickly, it is not always supported, particularly in older
decoders. Paged Mode is generally guaranteed to work but, the higher the
programmed value of a CV, the longer it takes to determine the actual value of the CV

Chapter 3 Page 46 of 538 Version 4.4.34



A-Track Reference Manual

from the decoder (since the Mode tries every possible value starting at zero until the
trial value matches the actual CV value) —

|

Item #3 - Addr 003 - Configuration Variables

Click ‘Read/Verify CVs
to open Options Panel

[ Functn] Pages | SUSI

Read/Verify Configuration Yariables
CV Range C¥ Scope
& Current View & AlCVs
" Al CV Blocks " Selected

Confirm |

Mode

* Paged

" Direct

" Register
" Address

0
p

[cv Ox [ 1x | 2x | 3x | 4x [ 5x [ 6x | 7x [ 8x | 9x [10x[11x]12x]
n

nAN NNN NN AN ANA AN AN ANA NNA T ANn - Ann - nna |

When you have set the options, click Confirm to start the Read/Verify operation.

During the Read/Verify operation, the CV currently being accessed will be highlighted
in red in the grid in the lower half of the Edit CVs window. Once the CV value held in
the decoder has been determined, it will be displayed in the grid and highlighted in
light green if the value read is the same as that held in the Item, or highlighted in
pink if it differs from the Item’s stored value.

[tem #3 - Addr 003 - Cenfiguration Variables

Item Dezcription |AT&SF GE44 Switcher

Frogram Ci's

IdentilyT Config T SpeedT Funct'nT Pages T SUSI

Read/¥erify Configuration ¥ariables

% Current View * AllCvs
" AllCY Blocks " Selected

(* Paged

" Direct

"~ Reaqister
" Address

&

Ox

Tx | 2% | 3x [ 4x | 5z [ 6x | 7x | 8x | 9% [10x] 11122

064
oz
00na
00na
00na
00a
106
129
00a

wmﬂmm-ﬂ-wm-lcg

00na
00a
oo
00na
00na
00na
00a
133
208
00a

00na
00na
00na
00na
00na
00na
00na

00na
00na
00na
00na
00na
00na
00a

o0na
o0na
o0na
o0na
o0na
o0na
o0na

oo0 [ oo

000 000 | oo
054 000 000

o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
00na

o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
00na

o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
00na

o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
00na

o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
00na

o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
00na

o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na

ooo [

o0na
o0na
o0na
o0na
o0na
o0na
o0na
o0na
00na

Wait patiently while the first 128 CV values are read from the decoder and displayed in
the grid. If required, the whole operation can be stopped at any time by clicking the
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Cancel button, although you will have to wait patiently for the current CV Paged Read
operation to complete (up to 20 seconds).

If you need further assistance with the Read/Verify operation, you can read the
instructions in the Help Topic 'Reading and Verifying CV Values' (press the F1 key to
open up Help again if you closed it down), or refer in this Manual to Section 6.6.

When the Read/Verify operation is complete click the Finish button in the Edit CVs
window. If an error occurred because of a connection problem, correct it and restart
the Read/Verify operation (this is fully explained in the Help Topic).

g o Read/¥erify Completed Successfully

Ox | 12| 2% [ 3 | 4z [ 5x | Bx | 7x | 82 [ 9% [10x]|11x]12x

000 000 000 000 OO0 OO0 096 153 209 000 000 000
OF4 000 000 00D OO0 OO0 000 102 158 215 000 000 000
012 001 000 000 OO0 D00 000 108 164 220 OO0 000 000
000 D00 000 000 000 D00 000 112 170 226 000 000 000
000 000 000 000 OO0 D00 128 119 175 232 000 000 128
000 000 000 000 OO0 D00 004 125 181 128 000 000 0S4
000 D00 000 000 OO0 D00 128 130 186 OO0 000 000 032
106 193 000 000D 000 D00 080 136 192 000 000 000 000
1239 208 000 00D OO0 OO0 085 141 198 000 000 000 OO0
o0 o0 054 o000 oo0 ooo o9 147 203 ooo oo ooo [

3

=

w (o |~|o || || = ||

If all went well, you may now wish to read all of the decoder’s CVs by changing the CV
Range option to All CV Blocks, and perhaps the Mode to Direct.

Click the Update Item button at any point to save the Item’s CV data back into the
Item List and close the Edit CVs window. Repeat the operations as often as required to
obtain the full set of CV values currently programmed into this locomotive’s decoder,
then use File / Save As to save the updated Item List as your reference before
making any of your own changes to the locomotive decoder’s CV settings.

Repeat this acquisition of CV Values for all of your locomotives, then again click File
and Save As to save your Item List - which is now a record of the original setups of
your locomotive roster, and which (if you keep it safe) will give you the ability to
restore these settings should any later changes you make to CV values prove to be
less than optimum.

There is no need to complete the recording of your locomotive roster’s decoder setups
in a single session. You can close A-Track at any point by using the standard Windows
Close button (EJ or %) in the top righthand corner of the window, or by clicking Exit
from the File menu. If necessary, A-Track will prompt you to save any changes you
have made to the Items or Item List before closing the program.

When you are ready to continue with A-Track, you can start the program again as
explained previously in Section 3.5. Alternatively, if you are intending to resume work
with a saved Item List, you can simply locate the Item List file in the folder where you
saved it, and then double-click on the file. This will open A-Track and load the Item
List with a single action.
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4 ITEMS AND ITEM LIST OPERATIONS

A-Track operations are based completely around a list of ‘1tems’. Each Item
represents a real DCC decoder which can be programmed or controlled on the model
railroad layout, using DCC commands issued via whichever type of NCE Command
Station is connected to your computer. Items include each locomotive in your roster,
each definition of a consist, ie. a set of several locomotives to be controlled as a single
unit, and any accessories such as remotely-controlled turnouts or signals.

Groups of Items are collected together in an Item List. Each entry in the Item List
contains a description of the Item with its key parameters, including the values of all of
the Item’s decoder Configuration Variables (CVs), and the type of DCC decoder fitted

in the Item. Specifying the type of decoder is most important where a sound decoder is
fitted, since this affects the method which A-Track needs to use to program the Item
CVs.

Once an Item List is constructed, the user can view and edit its composition, adding or
removing Items as required, or selecting any individual Item in order to control it or to
amend that Item’s operational parameters.

Item Lists can be stored on, and retrieved from, the PC’s hard disk (or any other type
of storage medium which can be accessed by the PC) by the A-Track program. The key
advantage of A-Track is that you can easily view the complete set-up of any Item’s
decoder, compare it to other similar decoders, and perform complex settings, such as
function re-mapping or defining speed tables, much more easily than trying to do so
when you only have access to a single CV value in one decoder at a time.

You are also not totally reliant on the retention by the Command Station and individual
decoders of your Item settings between operating sessions on the layout. Backups of
your Item List files can be made easily on to removable media such as USB flash drives
(memory sticks) or CD-R disks, and stored elsewhere for security. If any decoder has
its settings corrupted for any reason, it is a matter of minutes to use A-Track and the
appropriate stored Item List to re-program and restore the decoder to its previously
programmed state.

It cannot be over-emphasised that you should always keep back-up copies of your
Item Lists — at least in a separate folder on your PC’s hard disk and preferably in a
physically-separate location. Then you will always be able to recover, not only from
major disasters, but also from inadvertent editing errors made when using A-Track.

Although, in theory, given the size of hard disks and the amount of RAM in a modern
PC, there is essentially no limit to the size of Item Lists which can be handled by A-
Track, an upper limit of 32704 Items per Item List has been set in the software. This
limit should be more than adequate to build Lists for all practical purposes — even in
Clubs with very large locomotive rosters.

However, very large Lists tend to be unwieldy to view and manipulate so, while you
may choose to keep a master reference Item List containing every Item of your (or
your Club’s) roster, it is usually more convenient, for day-to-day use, to compile
shorter Item Lists — corresponding, for example, to an operating session. The Item List
operations available in A-Track allow you to create these working Item Lists, either
directly from your master List or from scratch, and to copy and move Items easily from
one Item List to another.
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4.1 Accessing and Viewing Item Lists

To illustrate the features of A-Track, an example Item List has been provided as part of
the A-Track installation, (AT-Tutorial-Demo-44.itl. Although this file will have been
installed into the folder C:\Program Files (x86)\A-Track\Example_Item_Lists, it
is not a good idea to try to open the Item List directly from this system folder location
because of file security restrictions which may be imposed by Windows Vista and
above. These restrictions are likely to prevent you saving any changes back to the file,
or saving any changed version of the file back to the folder location.

To avoid such difficulties, when A-Track is first run, all of the demonstration files and,
in particular, the demonstration Item List, AT-Tutorial-Demo-44.itl, will have been
copied to a subfolder, A-Track Item Lists, created within your main Documents (or
My Documents) folder, and you are free to access it there.

If this does not fit in with the way you wish to manage your files and folders, then you
should create the same (or a similar) folder either within another part of your User
area or on another drive on your computer, and copy the demonstration files to this
location from the C:\Program Files (x86)\A-Track\Example_Item_Lists folder
(an example of creating a new folder is shown in Section 4.2).

Although the Tutorial described in Section 3.6 will guide you step-by-step through the
basics of accessing Item Lists, you can, if you wish, investigate the process directly by
moving the Tutorial window out of the way (or closing it entirely), then clicking on File
on the Menu Bar of the main A-Track window to reveal the File menu, where you
should click on Open, as shown below. Item Lists can be accessed and edited whether
or not your NCE equipment is connected to the computer.

See Chapter 12 for itemised, detailed descriptions of the relevant File, Edit, View, and
Item menu entries which cover most aspects of handling the Item List.

As with other standard Windows applications, you can also access the File menu by
pressing Alt-F on the keyboard (hold down the left Alt key and then press the F key),
followed by a press of the O key, or by pressing Ctrl-O directly (hold down either Ctrl
(Control) key and then press the O key) —

a A-Track - PowerCab - COM 10

File Edit VWiew [tern MNCE PRoute Mimic Help
Mew Ctrl+MN 'g,p [ E _" ?
Open Ctrl+0 pe | Flags | F‘rAddrl E:-:Addr| Caritraller | SpSts| Speed| FL| Funct1-8|
Open Merge Ib Ctrl+M &
Close

Getting Started - A Tutorial - to Follow a Bit at a Tin

Auto Load ltem List

Frvm e Ctrles Welcome to A-Track - Your DCC Buddy

Save Checked... This short tutorial will get you started with the program - and will sta
while you try out the A-Track controls - just drag it aside (click on -

Properties the words "Start-Up Tutorial” at the top of this window, hold down tf

button, and move the mouse) so that you can see the contents of tf

Combo Data Restore Setup window as well as the tutorial - and can click on the A-Track menub

Auto Load AlU Allocation to investigate the available menus and options as you follow the tuto

A _— hence, maximising the A-Track window at this time is not recommen
uto Load Mimic Set

) During the tutorial, click More Info below to view full, detailed inform
Print... Crl+P the current tutorial page by displaying the relevant section of the A~

- Topics - which are always accessible when using A-Track by pressing

Click the Close Window button to remove the tutorial completely fro
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In the standard File Open window which then appears, locate the folder containing the

copied Item List(s). If the folder is in your Documents area, then it should be

immediately visible, and the copied Item List(s) can be revealed with a click on the

folder name.

Alternatively, if you have put them somewhere else, then drop down the folder list

from the ‘Look in’ listbox in Windows XP, or shown in the lefthand pane in Windows
Vista, 7, 8, or 10, and then progressively select folders and subfolders until you reach

the Item List folder (A-Track Item Lists here) —

5 A-Track - Open ltem List

A4 @ Documents
Add-in Express
Arduino
Assessment Results
A-Track Item Lists %
Contacts

Eagle

1 » ThisPC » Documents » A-Track ltem Lists v O Search A-Track [tem Lists
Organise « Mew folder ==« [
v O This PC ~ Name Date mccl\i}iecl Type Size
-8 3D Objects #& AT-Tutorial-Demo-44.t 13/02/2019 1653 A-Track ltem List
[ Desktop

Select an Item List from the A-Track Item Lists folder, by clicking on the filename,

and click on Open to load it (or just double-click on the filename) -

a A-Track - Open ltem List

|ﬂ3 Documents
Add-in Express
Arduino
Assessment Results
A-Track Item Lists
Contacts
Eagle
HelpMDoc
Insight Seftware
MOBILedit! & (A8

File name: | AT-Tutorial-Demo-44.itl ~ | Itern Lists (*.itl)

Cance'

1 » ThisPC » Documents » A-Track ltem Lists w @& Search A-Track [tem Lists
Organise * New folder =« [
E This PC ) MName Date mccl\i}iecl Type Size
-3 3D Objects #% AT-Tutorial-Demo-44,tl & 13/02/201916:53  A-Track Item List
I Desktop

o
7]

43

- which will display its contents in the A-Track main window, the significant features

of which are indicated in the picture on the following page.
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A-Track A-Track Item List Column Headers -
Menu Bar Toolbar Click to Sort Item List by
parameter in that column

) A-Track - P

File Edit View Item NCE [/Route Mimic Help
WEFsHES ¥ @M o wAOF HONOE* Sa/p| P
Description [ Type [ Flags [ " Prisddr [ ExAddr [ Controller l SpSts [ Speed [V / Funct 1-8 [
[19@; Faimers Union Coop EMD40 - NCE-Z14SR Loco C__ >009 0803 nc02 28 F 000
[ Colorado Mining 0-6-0 SaddleTank - Econami  Loco _ 001 >1001 28 F 00
148 Greenbrier & Elk River 3-Truck Shay - LokSn... Loco _P 005 >1005 20, L
El: DERGW 2-6-0 Mogul - TCS-MCE Loco 07 2917 Window Control -
(1 Gandy Dancer - D2120 a >08 0218 nc02 Thimi mi
14 DERGW 2-Truck Shay - DN142 A Trac.k o1 »20m Minimise, Maximise,
D&Accessuw Decoder - Wangrow SM-104 Item List >0260 1037 and CIOSE
[ AT4SF GE44 Switcher - DN140 Coco P 064 >0464 28 Fooo  _
[0 ATRSF GE44 Switcher - DN135D Loco _P 063 >0463 28 Fooo _
[19® DRGW GE 44 Switcher - DN135D Loco _P 036 >0436 28 Fooo _
[Cles» Switcher Consist #2 Consist _P »>120 Fooo _
14 Union Pacific Challenger - QS| Titan Steam Loco _P_ >089 3983 28 Fooo _
D‘ Southerm 4-6-0 Baldwin - SoundTraxx Tsunami  Loco _P 075 >0750 28 FooD _
[ Union Pacific 2-6-2 Prairie SDN144PS Loco _P 024 »3024 128 Fooo  _
148 DERGW FMH10-44 - Quantum Loco _P »122 2122 28 Fooo _
(1@ DERGW 2-8-0 Consolidation - LokSnd Select  Loco _P >015 2515 28 Fooo _
[ Union Pacific EMD Nw2 BL-Paragon2 Loco _P 094 >1094 28 Fooo _
D‘ Clear Lake Lumber 2-Truck Climax - ZimoMX... Loco _ 006 >0606 28 FooD _
D& Pine Creek Yard - NCE Switch-8 Access'y __P_ 0026 >0102 00305608
D& Fine Pine Fumn Sidings - NCE Snap-It Access'y __P_ 0031 >021 1
I:I% Heath Sawmill Siding #3 - NCE Switch-Kat Access'y __P_ 0031 >0122 0
14 High Peak - Digitrax DS52 Accessy _P_ 0033 >0131 00
D& Silver Pass - DCC-Concepts - Cobalt D4 Access'y __P_ 0036 >0143 1034
D% Pine Creek West - Lenz L5150 Access'y __P_ 0038 >0151 003450__
D& Forest Flat - Tam Valley Quad-PIC Access'y __P_ 0051 >0201 0030____
(15 McGiligan Lumbe; - - | P_ 0053 >02 K 00,
DgMcGilligan Lmte| Item List Location [& 0056 >02 A-Track Status Bar 02
L
{7 Item List : C:\Users\User\Documents\a-Track Item Lists\AT-Tutorial-Demo-44.it Items : 27 Current : 1 NCE @ [3)COM @

Be aware that, whenever an Item List is loaded, and you are connected to an NCE
Power Pro or Power Cab / Smart Booster Version 1.65 (including DCC Twin) Command
Station, a fresh scan of the status of connected NCE Handheld Cabs is launched. At this
point, the lefthand panel of the status bar will turn red and will show the details of
each accessed Cab, as shown in the examples below, with the middle connection
status indicator first showing red, before intermittently turning yellow and green,

and finally being replaced (when the scan is complete) with an icon showing the type
of system connected —

,& »»» Reading Status of All Cabs (including AlUs) << Please Wait »» Cab 02 Data <<< WCE & | COM & ‘

|Readir|g Data from Cab 02|

[ﬂ? Itern List : C:%UsersiUsersDocumentsha-Track Item Listsh\AT-Tutorial-Demo-44.it Items : 27 Current: 1 NCE @ [B]COM @ l

|Input of Data from 05 Cabs Completel

Note that, as an alternative to first opening the A-Track program, and then opening
the Item List with which you want to work, you can simply locate the Item List file in
the folder where you saved it, and then double-click on the filename. This will
immediately open A-Track and load the Item List with a single action.
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If A-Track is already loaded, then the Item List which is double-clicked will replace
any ltem List which is currently open in A-Track. You will be prompted to save any
changes which might have been made to the currently-open Item list before it is
replaced.

Once an Item List is loaded, the pathname of the Item List file is displayed on the
Status Bar at the foot of the A-track window, as shown above. If, for any reason, the
Status Bar is not visible, then open the View menu (see below) and check that the
Status Bar entry is ticked — if not, then click on the entry to tick it and hence activate
and display the Status Bar.

A-Track records the folder location of the most-recently-opened Item List so that, the
next time you click Open on the File menu, A-Track will take you directly to this
folder.

By default, A-Track displays a Details view of the Item List where each row shows a
description and key parameters for each Item in the List. There are alternative views
available which show less detail, and may be useful when trying to find a particular
Item in a long Item List. Click on the View menu to access the available options -

) A-Track - PowerCab - COM 10

Eile Edit  Wiew ltem NCE PRoute Mimic Help

A & & v Toolbar

Descipton || StatusBr [[_Pudd] Exaddt] Conuoler ] Spsis | Speed [ FL] Furctis]
[BL3Famd 3

148, Colar Show Checked Only ool 1001 22 Fooo _

LI Green Larce | 005 1005 no 04 28 Fomo

[ D4RG argefeens mr o osm7 28 FOO0 _

18 Gand, Small lcons »018 0218 nel2 28 FOOD  _

[ DsRG List o1 »2011 NCO2 2% Fooo

D& Acces v Details »0260 1037 1234
18R, a2 = D64 >0454 2 Fomo

I8 aTes1 Arrange [tems » by Description 28 FOO0 _

8 oRGY Line Up lcons [ by Type 2 FO0 _
e Switct = Fooo

1 Uniion Consist Status - Cmnd 5tn / ltem List LNLTIE 28 Fooo  _
D‘Soyth Consist Status - Backup Eile / ltem List by Primary Address =8 e —
[ Union . by Extended Address 128 Fooo _
D‘D&HG AU Status - Turnout / Block Allocation . 2 Fooo

[ DtRG  Refresh ltem Allocation & Status o mRElEE % Foo
D‘Union Monitor AIU/Cab Scan I 034 >10394 28 Foooo _
D‘ Clear L a0e >0B0E 28 Foooo

When using the alternative views (Large Icons, Small Icons, and List, as shown
below), the Arrange Icons sub-menu is employed to select the sort order of the
displayed Items. Click on one of the sub-menu options (such as by Primary Address)
to sort the Item List using this Item parameter. Clicking the same sub-menu option
again will re-sort the Items in the opposite sense, ie. the List will change from
ascending order to descending order, or vice versa.

In the Details view you can sort the Items simply by clicking on the heading text at
the top of each column for the categories shown. Having clicked on a column header,
clicking again on the same header will reverse the Item sort order.

A-Track will arrange all subsequently loaded Item Lists using the View settings you
select until you pick a different view. You can change the width of each column in the
Details view to suit your own preferences — use the standard Windows technique of
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clicking on, and then dragging, the boundary between each column header to the left
or right as required.

Both the List and Small Icons views show only the Icon plus Description for each
Item, set out in one or more columns, the number of columns being dependent on the
number of Items in the Item List and the window height and width —

) A-Track - PowerCab - COM 10 - O 4
File Edit View Item NCE Route Mimic Help

WeFsdEdS s+ @M > &m0 HONS Swe |7
[ML *Farmers Union Coop EMD40 - NCE-Z14SR

D. Colorado Mining 0-6-0 SaddleT ank - Econami
1% Greenbrier & Elk River 3-Truck Shay - LokSnd-uv4
[ DERGW 2-6-0 Mogul - TCS-MCE List View
[ Gandy Dancer - DZ120

[ DERGW 2-Truck Shay - DN142
D%Accessmy Decoder - Wangrow SM-104

1 AT&SF GE44 Switcher - DN140

I8 ATESF GE44 Switcher - DN135D

(14 DRGW GE44 Switcher - DN135D

[l Switcher Consist #2

14 Uniion Pacific Challenger - QSI Titan Steam
1 Southem 4-6-0 Baldwin - SoundT raxx Tsunami
[ Union Pacific 2-6-2 Praiiie SON144PS

El. DE&RGW FMH10-44 - Quantum

[ DERGW 2-8-0 Consolidation - Lok$nd Select

7 A-Track - PowerCab - COM 10 - m] X
File Edit View [tem NCE Route Mimic Help

FFFSsHES L ¥ed@M > - &m0 f oy e Swe | 2

Farmers Union Coop EMD40 - NCE-Z14SR

[[]%@& Colorado Mining 0-6-0 SaddleT ank - Econami
]9 Greenbrier & Elk River 3-Truck Shay - LokSnd-uv/4
148, DARGW 2-6-0 Mogul - TCS-MCE Small lcons
[[]€8 Gandy Dancer - DZ120 :

(148 DERGW 2-Truck Shay - DN142 View
D&Accessow Decoder - Wangrow SM-104
148, ATSSF GE44 Switcher - DN140

(1€ ATESF GE44 Switcher - DN135D

[[]€@, DRGW GE44 Switcher - DN135D

[[]em Switcher Consist #2

[]%@, Union Pacific Challenger - QS| Titan Steam
(148 Southem 4-6-0 Baldwin - SoundTraxx Tsunami
[14 Union Pacific 2-6-2 Praiie SDN144PS

(148, DERGW FMH10-44 - Quantum

14, D&RGW 2-8-0 Consolidation - LokSnd Select

The Large Icons view, as its name implies, shows larger versions of each Item’s Icon,
with the Description below the Icon and checkbox —
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A & v | #BldF HenEYe TSV 7
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O X

FsHES i@

oA O

Accessory  Southem 4-6-0  Pine Creek
Decode... Baldwin-50.. Yard-N..

o %8 O S8

Farmers Union
Coop EMDA40 -
NCE-Z145R

N N NE N Ca

Forest Flat -
TamVall...

View
Colorado  AT&SF GE44 Union Pacific Fine Pine Fum  McGilligan
Mining 0-6-...  Switcher-... 2-6-2 Prairi... Sidings -NC... Lumber #1 -...
b 0@ 0@ o9 o
Greenbrier &  AT&SF GE44  D&RAGW  Heath Sawmil  McGiligan
Elk River 3-.. Switcher-... FMH10-4.. Siding #3-.. Lumber #2-...

Large Icons

You can use the Line Up Icons option from the View menu to increase the number of
columns to fill up the window width for both the Small Icons and Large Icons views —

7 A-Track - PowerCab - COM 10 - m] X
File Edit View Item NCE Route Mimic Help
6 & oo M 0 R

Bﬂﬁé d ¥ @

@!D*C]1 Sw®|?

o C

AT Accessory Southemn 4-6-0  Pine Creek Forest Flat - Colorado AT&SF GE44  Union Pacific  Fine Pine Fur
(G BEIE  Decode.. Baldwin-So.. Yard-N... TamVal.. Mining0-6-.. Switcher-... 2-6-2Prairi.. Sidings - NC.
NCE-Z145R
O%s 0% O b 098
Greenbrier & AT&SF GE44  D&RGW  Heath Sawmill McGiligan D&RGW 2-6-0 DRGW GE44 DE&RGW 2-8-0 High Peak
Elk River 3-.. Switcher-... FMH104.. Siding #3-... Lumber #2-.. Mogul-TCS... Switcher -
Large Icons
O<» O O 3& m O O & View
Swicher  UnionPaciic SiverPass- DSRGW  UnionPaciic Cearlske PieCree| - Lined Up
Consist #2  EMD Nw2... DCC-Conce.. 2-Truck Sha... Challenger... Lumber 2-Tr... ‘West-Le.:

o)

Note that the following icons are used to identify different types of Items —

Locomotive

Multiple — Lead Loco
(Loco assigned to a Consist)

Consist
(Group of Locos)

Multiple — Mid Loco

Accessory
(Turnouts or Signals)

w
8

Multiple — Rear Loco

Of those View menu options not covered so far, Toolbar simply enables or disables
display of the row of command icons located immediately below the Menu Bar (each
icon corresponds to a selected option from one of the A-Track menus). A tick mark
next to the option shows that it is enabled. In this state, clicking Toolbar will disable
display of the icons, removing the tick beside the option. Click again to re-enable
display of the Toolbar.
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Similarly, the Status Bar option enables or disables display of the information bar
along the bottom of the A-Track window.

Show Checked Items only displays those Items where the checkbox to the left of the
Item has been clicked to show a tick. It is useful when selecting a subset of Items from
a long List in order to check whether all required Items have been marked. Click the
option again to re-enable display of the complete Item List.

Consist Status — Cmnd Stn / Item List allows you to review all of the consists
currently defined in the Item List and in an NCE Command Station (Power Pro or Power
Cab V1.65), if connected. Full details are covered in Section 6.12.

Consist Status — Backup File /7 Item List is only relevant if you have backed up
Consist data from the Item List or an NCE Command Station to a file stored on your
computer. If so, you can then review all of the consists held in the file with those
currently in the Item List. Full details are covered in Sections 6.12 and 9.3.

AlU Status — Turnout / Block Allocation allows you to allocate and/or view which
turnouts or block occupancy detectors on your layout are connected to which inputs of
one or more Auxiliary Input Units (AlUs) connected to the Cab Bus of an NCE
Command Station (Power Pro or Power Cab V1.65). The defined turnout or block
allocations can be stored in, or retrieved from, a file on your computer. Full details are
covered in Sections 8.5 and 8.6.

In the standard A-Track installation, automatic status updates of the NCE Cabs
attached to the Command Station are disabled by default. However, you can update
the displayed Cab allocation and status at any time by clicking the Refresh () icon
on the A-Track toolbar or by clicking on View on the A-Track menu bar, followed by
Refresh Item Allocation & Status (See Sections 3.5, 9.4, and 12.3).

When you use the View menu option, you will be asked whether you wish the periodic
scan (approximately every 6 minutes) of attached NCE Cabs to resume —

Cab Status - Automatic Update

@™ Automatic update of NCE Cabs Status
L | [(every & minutes) is currently disabled

After this manual status update, do
you wish to enable automatic updates 7

Click Yes to enable future automatic scans of NCE Cab status, or No to leave the scans
disabled. Leaving scans disabled is preferred if you want to adjust the setup of the NCE
Power Pro Command Station or Cabs, or change Consist or Macro settings without
being interrupted periodically, since all editing functions are disabled during the scan).
Further details of the way in which the NCE System Status data is handled can be
found in Chapter 9.

A tick mark next to the Refresh Item Allocation & Status option on the View menu
will be displayed to indicate that periodic scans of attached NCE Cabs are enabled. In
this state, every 6 minutes, A-Track will automatically re-scan the status of the NCE
Cabs attached to the Command Station. The current Cab allocation and status will be
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cleared from the Item List, with the lefthand panel of the status bar turning red and
showing the details of each accessed Cab. The middle connection status indicator will
intermittently show yellow and green, finally being replaced (when the scan is
complete) with an icon showing the type of system connected.

Your choice of whether to enable or disable periodic scans of attached NCE Cabs is
saved by A-Track and will be applied each time the program is started.

Note that, regardless of the setting of the automatic status update option, the Cab
allocation and status will be updated each time a new Item List is loaded, or when
changes are made through A-Track to the allocation of Items to attached Cabs (See
Section 6.8).

Monitor AIU/Cab Scan, when activated, will display the addresses of those Handheld
Cabs and AlUs which A-Track is monitoring in turn at approximately 1-second intervals
(as described in Section 3.5) in the Status Bar panel which normally shows the
number of Items in the Item List. A tick mark next to the option shows that it is
enabled — click again to disable the option and remove the scan display from the
Status Bar.

Item List Load and Save Options

As introduced in the preceding section, all Item List Load and Save operations can be
performed using the functions available from the File menu, some of which have
alternative access via keyboard shortcuts and/or toolbar icons (see Section 12.1 for
full details). As an example, you can click the [ icon on the Toolbar to load (Open) an
Item List, or press Ctrl-O on the keyboard (hold down either Ctrl (Control) key and
then press the O key) to perform the same operation.

Once an Item List has been opened, its filename is added to the Most Recently Used
(MRU) list on the File menu as shown below. Up to eight filenames can be displayed in
the list — when you open the ninth distinct Item List then the oldest filename is
dropped from the list to make way for that of the latest Item List.

) A-Track - PowerCab - COM 10

File Edit View ltem NCE Route Mimic Help

New aeN J R @SS
Open Ctrl+0 ddll Controller I SpStsl S
Open Merge Ctrl+M :g? no02 ;g E
Close 005 % F
Auto Load Item List 817 28 F
218 nc 02 28 F
Save As... Ctrl+S fUH 28 F

Save Checked... 037
1464 28 F
Properties 63 28 F
28 F
Combo Data Restore Setup MOSt-RECEﬂtlY'USEd F
Auto Load AlU Allocation Item LiSt(S) 28 F
Auto Load Mimic Set 28 F
) 024 128 F
Print... Ctrl+P g122 28 F
C:\Users\Use ... -Track Item Lists\AT-Tutorial-Demo-44.itl ?93 ;: :
H:\A-Track\A ... -Tutorial-Demo-44-200222+ ThreeWayDS52.itl 1506 28 F

Exit jje

e s — e i i 21
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Once an Item List appears in the File menu MRU list, you can open this Item List at
any subsequent time simply by clicking on its filename in the MRU list, without having
to go through the standard File Open window.

Unless you have a very large roster of locomotives, it is likely that you will use a single
Item List for most A-Track operations. In this case you can set A-Track to load this List
automatically whenever you run A-Track. Simply load your Item List as described
above then click on File to open the File menu and then click on the Auto Load Item
List option (or the & icon on the Toolbar) —

D A-Track - PowerCab - COM 10
File Edit View [tern NCE Route Mimic Help

New cuen | R @b S
Open Ctrl+ 0O ddr | Controller | Sp5ts 5
Open Merge Ctrl+M ElE| e 02 a4

oo 28 F
Llose 005 % F
Auto Load ltem List I:} 317 28 F

218 no 02 28 F
Save As... Ctrl+5 011 7 F
Save Checked... 037

A prompt will be displayed, asking you to confirm your choice —

Item List - Automatic Load

% Automatic loading of the last-used Item List
is currently disabled when A-Track starts

Do you wish to commence automatic loading 7

Click Yes to confirm future automatic loading of the Item List, and to place a tick mark
next to the Auto Load Item List option in the File menu, or No to keep the option
disabled.

If you subsequently wish to cancel automatic loading, just click again on the Auto
Load Item List option (or the & icon on the Toolbar) then click Yes in the
confirmation window this time to disable the option.

As well as opening an existing Item List, you can use the File menu to generate a
completely new Item List by clicking on New (or the E| icon on the Toolbar, or by
pressing Ctrl-N on the keyboard), which creates an Item List containing a single Blank
Item. If an Item List is already loaded and has been changed in any way, then you are
asked whether you wish to save the current Item List before it is replaced with the new
Item List —

D A-Track - PowerCab - COM 10
File Edit View [tem NCE Route Mimic Help
AEE2dE S & roe @M AR R G S 2 7

Préddr
=000

Type Controller

MNore

Description
*XBlank |tem #1
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Having generated a single Blank Item, the next thing to do is to change it into a valid
DCC Item having an Item Type of Locomotive, Consist, or Accessory. You should also
give the Item a unique Description and Address. The sequence of operations to
perform these actions has already been introduced in Section 3.7, and is covered
later in more detail in Section 5.3.

When you have finished adding to the Item List, or editing individual Items (see
Chapter 5), you can save the finished Item List to disk by clicking Save As on the File
menu (or the [ icon on the Toolbar, or by pressing Ctrl-S on the keyboard) —

D A-Track - PowerCab - COM 10

File Edit View [tem MNCE Route
New
Qpen
Open Merge
Close
~  Aute Load Item List

Save As...
Save Checked...

Mimic  Help

B ey e

Ctrl+N (<)
Ctrl+0 ddr
Ctrl+ M

Ctrl+S

Controller | SpSts

— which opens the standard File Save window, as shown below —

5

a A-Track - 5ave ltem List

g Documents
Add-in Express
Arduino
Assessment Results
A-Track Item Lists
Contacts
Eagle
HelpMDoc v

1 » This PC » Documents » A-Track ltem Lists
Organise = New folder
[ This PC (o) Name
~J 3D Objects #& AT-Tutorial-Demo-4d4.itl
I Desktop

v O

-
Diate modified

13/02/2019 16:53

Search A-Track Item Lists pe

Type

A-Track tem List

= @9
Size

43 KB

File name: | Mew-ltemList-11-Mar-20.itl

Save as type: |ltem Lists (*.itl)

» Hide Folders

Save

Cancel

A-Track opens the folder from which the last Item List was opened (or your main
Documents or My Documents folder if no Item Lists have yet been opened), and
generates a default filename, which includes today’s date, as shown.

If you wish to save the Item List under a different filename, click in the File name
textbox to highlight its contents (if not already highlighted — as shown above), then
simply type the new filename to replace the displayed filename. Click Save to save the
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Item List under the given filename, which will have a file extension of .itl added to
identify to Windows that the file is an A-Track Item List.

Note, however, that if you have chosen to save the edited Item List under a filename
which is the same as that of a file already in the selected folder, then Windows will
display a warning —

AT-Tutorial-Demo-44.itl already exists,
Do you want to replace it?

- and it is your choice on how you wish to proceed — click Yes to replace (overwrite)
the file with a new version, or No to return to the Save Item List window where you
can either rename the file, or select a different folder in which to save it (or abandon
the whole Save As operation).

Rather than save a complete Item List to a file, A-Track also offers the capability to
save only selected Items from the List. To choose the Items to save to a file, click to
tick the checkbox located to the left of each Item which you wish to include, then click
on Save Checked on the File menu (or the §& icon on the Toolbar).

In the File Save window which then opens, type an appropriate filename for the
reduced Item list, and click Save. You could, of course, just use the existing filename
but by doing so you will overwrite the existing Item List and permanently lose all of
those Items which were NOT checked — so make very sure that you really want to
eliminate them.

If you maintain a number of separate small Item Lists stored on disk, then you can use
A-Track to amalgamate them into a single large Item List, perhaps for archiving or
back-up purposes. Do this by clicking on Open Merge on the File menu (or use the &
icon on the Toolbar, or press Ctrl-M on the keyboard) after you have opened the first
Item List in A-Track. This will display the standard File Open window, just as for Open
(see Section 4.1 and above), to allow you to select a second Item List. Opening this
Item List will add its Items to the end of the first Item List — but note that no check is
made for duplicate Items or duplicated Item Addresses.

You can continue to append Item Lists in this fashion up to the limit of 32704 Items,
and, since each Item occupies less than 2 kilobytes, Lists of even thousands of Items
are unlikely to fill more than a fraction of the available memory in a modern PC. If you
attempt to add a further Item List to the current Item List such that the total number
of Items would exceed the maximum allowed, then only part of the further Item List
will be loaded to bring the combined number of Items up to 32704.

The recommendation, of course, is that you do not create such very large Item Lists
since they will be very awkward to use and edit. Bear in mind also, that the NMRA DCC
Standards limit the maximum possible number of Item Extended Addresses that you
can use to 16383, together with 127 Primary or Consist Addresses, so that Item Lists
with more than 16510 Items must contain Items with the same (conflicting) address.
Most commercial DCC systems reduce the maximum number of Extended (4-Digit or
Long) Addresses which can be used to 9999, which suggests this value as an upper
practical limit on Item List length.
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While merged Item Lists have the same structure and format as any other Item List,
and can be stored with the same .itl file extension, you may like to treat them as a
master or reference List, or Item Archive. For convenience, A-Track provides the
facility to use a different file extension, .ita, for any large, or merged, Item List that
you wish to treat as an Item Archive.

After you have created a merged Item List or Archive you can add further Item Lists to
it at any time using Open Merge, or extract smaller Item Lists from it by using the
Save Checked option.

While there is nothing to stop you saving your merged file (under a different filename,
of course) in the same folder as your other Item Lists, it is a good idea to create a
separate folder to hold such merged Lists especially if they are to be regarded as
Archives. Start by opening the File menu, and clicking on Save As.

If using Windows XP then, in the Save Item List dialog window which opens, locate a
suitable parent folder (such as My Documents) using the drop-down Save in: listbox
at the top of the window —

A-Track - Save Item List ﬂﬂ

Save jn | (L) My Documents j & =k E3-

% My Recent Documents
Dezktop

iy Documents;

¢ My Computer

L 3% Floppy [
e MDOTI1ED-wWIirF [C:]
g MOTI1ED-WING D]
it DWD/CD-R'w Drive (F:]
L7z Safe Fun shared folder
(&3 Shared Documents
I Swe's Documents
) My Dacuments

\3 ty Metwork, Places

) S5aved E-Mail

@Letters

| ) SampleDocs

File narme: IMerged-ItemList-1 B-bdap-13 j Save

Save as lype: IItem Lists [.it]) ﬂ Cancel |
P

Double-click on the parent folder to open it, then use the Create New Folder button
on the File Save window toolbar, as shown below. Type in a suitable name for the new
folder, click Open to open it, then click again on the same button (now labelled Save)
to save the Item List using either the suggested filename based on today’s date,
Merged-ltemList-16-May-13 here, or one which is more meaningful to yourself,
together with the .ita extension, selected from the Save as type: drop-down listbox —
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20
Save in: ﬂ'_] My Documents ﬂ & 1B ﬁ-
| ) A-Track Item Lists gMy Pictures [Create New Folder]
. - Create New Folder
h | )My Item Lists |)eBooks
LGEEG O |2 My PSPS Files C .
Documents [l EEYNETRws [
"B ) New TtemLists
) A-Track Backup
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The format of the Save Item List dialog window in Windows Vista, 7, 8, 10 and 11 is
a little different, but the operations to create and rename a new folder are very similar,
as are those to choose a filename and file extension, as shown in the Windows 10

example below —
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4.3 Other File and Program Functions

If for any reason you wish to check on details of the file in which the displayed Item
List is held, click on Properties on the File menu —

[tem List Properties
$Q@  AT-TutoialDemo-4é.i

Details
Location:  CAUsers\UsertD.. A-Track Item Lists
Orig Size: 43697 bytes
Orig Items : 27
Curr ltems : 27

History
Created:  09/11/201911:47:24
Modified:  13/02/2020 16:53:44

Attributes

=1 =

i
i

,,‘r"l-’ Windows Format

The window shows details of the current Item List file, including the number of Items
now in the List compared to the number when loaded.

Having loaded an Item List, you can use the Print function on the File menu (or the &}
icon on the Toolbar) to print out all or part of the displayed Item List, or the details of
one or more individual Items selected from that Item List, either to paper or to a file
which can be transferred to another computer for printing at a later time. Clicking on
Print opens a new window in which the Print Setup option allows you to select a
printer to use, and other options let you select the printer parameters and required
output format. Details of the extensive Print facilities which are offered by A-Track are
described fully in Chapter 10 of this Reference Manual.

The final options on the File menu are Close, which simply terminates display of the
currently open Item List, leaving the A-Track window empty, and EXxit, which asks you
to confirm that you want to close down the whole application —

Cenfirm Program Exit

Clicking the No button cancels the closedown and leaves A-Track just as it was before.
Otherwise, a click on Yes initiates a complete closedown of all program functions,
closing any currently open Item List, removing it from display, and then terminating
the A-Track program and any connection to your NCE system. Note that, once
closedown is started, you may be prompted to save the Item List (or other changed
program files) —
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Item List Changed

l .\ ltem List has changed - Save [tem List 7

Selecting Yes allows you to save the changed Item List under your choice of filename,
while clicking No will immediately close the Item List and cause any changes to be
discarded (permanently lost). Be aware that, once the A-Track closedown has been
started, you cannot change your mind and abandon the Exit process — A-Track will
definitely close whether or not you choose to saved any modified files.

You can also terminate the program in the standard Windows fashion by clicking on the
A-Track window Close button ( or ¥ - top righthand corner of window).

Note : Because A-Track is in continual communication with the interface to the NCE
Command Station, you may notice that there is a short pause, of a few seconds
duration, before the program reacts to your closedown action, in order to allow this
data traffic to be stopped in an orderly way.

4.4 Editing - Undo, Redo, Find, and Selection

The Edit menu, shown below, allows you to alter the composition of the Item List by
removing or adding Items, or by copying or moving Items to, or from, another Item
List. During these manipulations the parameters of the Items themselves are not
changed in any way, with some exceptions relating to Consists and Multiples
(Locomotives assigned to Consists), as detailed in Section 4.5.
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Any alterations which you choose to make to the Item List are not irrevocable, since
A-Track incorporates an Undo facility which records the last 32 changes to the Item
List and allows you to reverse them at any time. Once any action, or sequence of
actions, has been ‘undone’, you then have the choice of performing some other
operation on the restored Item List, or of reinstating some or all of the original
sequence of changes by utilising the Redo facility. Toolbar icons are available for both
Undo (¥?) and Redo (T#) as an alternative to opening the Edit menu (see Section
12.2 for full details).

As well as restoring the structure of the whole Item List, you can also employ the
Undo function to reverse any changes that you have made to the parameters or
Configuration Variables of individual Items through the facilities described later in
Chapter 5. If, immediately after making alterations to an Item’s parameters and
evaluating its new characteristics on the track, you want to return the Item to its
original state, then simply click Undo on the Edit menu, or the Undo icon on the
toolbar. The edits made to the Item’s parameters will then be ‘undone’, assuming that
you have not made any other changes to the Item List in the meantime — if so, you will
have to undo these subsequent changes before the desired Item is restored (and then
make the subsequent changes to the Item List again, if necessary).

Note carefully, however, that restoring an Item’s CVs to their original value in the Item
List does not change the corresponding values in the real, physical DCC decoder in
your locomotive or accessory. To do that, you will have to program (or re-program)
the restored values into the actual decoder on the track, as explained in detail in
Section 6.7.

The next function on the Edit menu, Find (also available through the @&] icon on the
Toolbar) acts as an aid which allows you, particularly when dealing with large Item
Lists, to search the complete Item List for particular Items. Click to display the Find
Item window, then simply type any combination of letters or numbers that you believe
are in the Description or Address (Primary or Extended) of the required Item(s) - your
text will replace the prompt in the textbox —

Enter text/nurmber to find in [tem Descr'nAbddress | climad]

[v Search ltem Descriptions ¢ Search Up [v Search ltem Descriptions ¢ Search Up
[v Search ltem Addresses & Search Daown [v Search ltem Addresses & Search Daown
Fird Cancel Fird | Cloze |

Select whether to search Item Descriptions or Addresses, or both (but selecting none
will disable the Find operation), choose to search either Upwards (from the currently-
selected Item towards the beginning of the Item List) or Downwards (from the current
Item towards the end of the Item List), then click the Find button.

The first Item found whose Description or Address contains the entered search
characters will then be highlighted in the Item List. Note, however, that if the currently
highlighted Item matches the search criterion, then the Item highlight will not move —
and you may think, incorrectly, that the Find operation has failed.
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Click the Next button, as shown in the example below, to continue the search for the
next Item (if any) which contains your search characters, or Close or Finish to
terminate the Find operation, leaving the last found Item highlighted. If no further
matching Items are found, then only the Finish button will be enabled to quit the
operation (this will also be the case where no matching Items at all are located) —

|c:|irna:< |c:|irna:<
[v Search ltem Descriptions ¢ Search Up [v Search ltem Dezcriptions  Search Up
[v Search ltem Addresses (¢ Search Down [v Search ltem Addresses (o Search Down

Cloze

If you wish, you can move the Find Item window out of the way, so that it does not
obscure any of the Item List details, by clicking on its title bar, holding down the left
mouse button, and dragging the window to a convenient part of the screen. The Find
Item window will remain on the screen, in front of the main A-Track window, until you
click on the Close or Finish button, and does not interfere with any other A-Track or
Item operations. Hence, having found a matching Item, you can examine its
parameters in detail (see Section 5.1) to check if it is the Item you require, before
resuming the search of the Item List.

At any point in using the Find Item function you can change any of the search
parameters, or click on any Item in the Item List to define a new starting point for a
revised search. After any such changes, click Next to restart the Find operation. Note
that you can also do this by simply pressing the Enter/Return key — although be
aware that, when the Finish button becomes active at the end of a search, the
Enter/Return key will, instead, close the Find Item window.

The next group of options on the Edit menu, relating to Cut, Copy, and Paste
operations, together with Insert and Delete, are dealt with fully in the following
Section 4.5.

The remaining options provide some shortcuts when selecting Items for further
operations such as saving, copying, or deletion.

Check All places a tick in the checkboxes located to the left of the Descriptions of all
Items in the List, while Check Selected ticks the checkboxes of all Items which are
currently selected, ie. highlighted, as described in Section 4.5 below.

Invert Checked selects all checkboxes which were not already ticked and deselects all
those which were ticked. Hence, if you wish to clear all checkboxes, apply Check All
followed by Invert Checked. In another case, where you wish to check all Items except
a few, it is quicker to tick all those that you do not want, then click Invert Checked to
reverse the selection.

Select All simply highlights all of the Items in the displayed List, while the final option
Invert Selection highlights those Items which were not highlighted before, and
removes the highlight from all Items which were previously highlighted.

Hence to completely remove highlighting from all Items, apply Select All followed by
Invert Selection. Note, however, that you can also remove multiple Item selections
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simply by clicking on any Item — although that single Item will remain highlighted.
Where you want to select all Items except for a small number, it is quicker to select all
those that you do not want, by holding down either of the Ctrl (Control) keys while
clicking on those Items, then click Invert Selection to reverse the highlighting.

4.5 Editing - Cut, Copy, and Paste

To facilitate copying and moving Items between Item Lists, A-Track incorporates a
private storage area known as the Copy Buffer. Copies of selected Items are moved
into, and taken from, the Copy Buffer by using the Cut, Copy, and Paste operations
on the Edit menu.

To select an Item which is to be the target of one of these Edit operations, click on it —
the whole Item row is then highlighted. To select a group of Items, click on the first
Item in the group, hold down either Shift () key, and click on the last Item in the
group. Single Items can be added to a selected group (which may just be one other
selected Item) by clicking on the Item to be added while either Ctrl (Control) key is
held down. Conversely, clicking on a selected Item while holding down either Ctrl key
will deselect that Item and remove its highlighting.

Once one or more Items have been selected, you can use either Cut or Copy to place
copies of the selected Items in the Copy Buffer.

Note that, when any Edit CVs window is open, the whole Edit menu is disabled,
together with the Delete Item, Cut, Cut Append, and Copy Append entries on the Pop-
Up menu, and all of the relevant Toolbar icons. Hence, if you are unable to access the
Item List Edit features, check first that all Edit CVs windows have been closed.

Cut (the & icon on the Toolbar) removes the selected Items from the Item List, ie. it
moves the Items to the Buffer, where the moved Items replace any previous contents
of the Copy Buffer. Copy (Bz), on the other hand leaves the Items in the Item list, ie.
it simply copies the Items, although the copied Items still replace any previous
contents of the Copy Buffer.

If you wish to add selected Items, or copies of the selected Items, to the Items which
are already in the Copy Buffer, then use either Cut Append (#¥) or Copy Append
(). These operations work in essentially the same way as Cut and Copy, respectively,
but the Items moved or copied are added to any previous contents of the Copy Buffer,
instead of replacing or overwriting them. This allows you to select the Items you wish
to copy or transfer in several stages rather than attempting to perform the operation in
a single step.

When you have all of the required Items in the Copy Buffer, you then use Paste (&)
to place all of the copied Items back into an Item List. The copied Items are added to
the end of the current Item List file being displayed by A-Track unless you have
chosen to sort the Item list by one of the Item parameters, in which case they will be
inserted at an appropriate position in the List determined by the sort order. This can
cause you to lose track of some of the copied Items when pasting in a sizeable group
of Items, so that you are recommended to sort the Item List by File Order (either via
the View / Arrange Items menu, or the ﬂl icon on the Toolbar) before (or after)
executing the Paste operation. The pasted Items can then all be found together at the
end (bottom) of the List.

If you Paste the Items back into the same Item List as they were taken from, then you
will have a set of duplicated Items. While this is perfectly allowable (and A-Track treats
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such duplicates as different Items even though their parameters are identical) it can
lead to problems subsequently, when you are never going to be sure which duplicate
Item is the one to be edited or controlled. Hence, the recommendation is to change at
least the Address of each duplicate Item immediately — and preferably their
Descriptions also — to eliminate any confusion.

Creating duplicate Items is a useful shortcut when you are adding a new Item to your
roster which is very similar to one that you already have there, and can save a lot of
time in setting up all of the Configuration Variables (CVs) and other parameters for the
new ltem.

Important Note : When using Cut, Copy, and Paste operations on Items which are
either Consists or Multiples (Locomotives assigned to a Consist) you need to be
aware that the links within and between such Items require them to be handled in a
special way —

e When you Cut or Copy a Multiple, the Item placed in the Copy Buffer is changed
to a Locomotive with exactly the same parameters, but which is no longer
linked to the Consist, and it will be Pasted back into the Item List as a
Locomotive.

e When you Copy a Consist, the assignments of Locomotives (Multiples) to the
copied Item are cleared, so that, if you Paste the copy back into the Item List, it
will appear as a blank Consist with the same address as the original, but without
any assigned Locomotives.

e If you Cut a Consist then, as well as being placed in the Copy Buffer without
any assignments, all Multiples which were assigned to the Consist are also
deleted from the Item List, but immediately pasted back as Locomotives with
the same parameters as the original Multiples. Pasting the cut Consist back into
the Item List again results in a blank Consist without any of its original
assignments. Further details on the handling of Consists and Multiples can be
found in Sections 6.11 and 6.12.

If you do wish to transfer a complete Consist with its assigned Multiples to another
Item List, then you should check each of the group of Items (Consist plus Multiples)
by clicking in the checkbox at the beginning of each Item row, leaving a tick in each
checkbox. Then, from the File menu, select Save Checked to save the Consist and its
group of Multiples as a small, standalone Item List with an appropriate filename.

Next, close the current Item List (saving it if necessary), and Open the Item List into
which you wish to place the saved Consist. Once this Item List has loaded, click Open
Merge from the File menu, then locate and select the small Item List containing the
Consist. A final click on Open in the Merge Item List window will add the Consist to the
second Item List as desired.

If you make a mistake when using Cut, Copy, or Paste remember that you can easily
put the Item List back to the state it was in previously by using the Undo function
described in Section 4.4 — always bearing in mind that Undo only records the last 32
Edit actions performed on the Item List (although each Edit action can include any
number of Items).

With a selected set of Items in the Copy Buffer, you can transfer them to either
another existing Item List, or you can create a new Item List to hold them. Do this
either by clicking on File / Open to open an existing List, or on File / New to create a
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new Item List with one Blank Item, and in either case saving the current Item List if
necessary, when prompted.

The contents of the Copy Buffer are then added to the newly-displayed Item List by
clicking Paste. A typical sequence of actions is shown below for the case of a

completely new Item List.

First, select and Copy (or Cut) a set of Items —

2 A-Track - PowerCab - COM 10
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1% Famers Union Coop EMD40 - NCE-Z14 Copy Selected ltem(s) 009 0903 WCO2 28 F 000
oco 28 F 000
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F

2 b

I F ooo
coexsy P >0260 1037 1234

Next, close the Item List (using File/Close), dealing appropriately with any prompt to
save the List if it has been changed, then open a new List with one Blank Item (using

File/New), and click Paste -

D A-Track - PowerCab - COM 10

File Edit Wiew [tem MNCE PRoute Mimic Help

AEESHES s M - #0002 Herwgde avel?

D ezcription 12 [ Flan Présddr Extddr | Cortroller | SpSts Speed | FL|  Funct1-8
O Paste ltem(s) from Buffer

- to add the copied (or cut) Items from the Copy Buffer to the new Item List -

D A-Track - PowerCab - COM 10
Eile Edit View [tem NCE Route Mimic Help

@Dﬁvwﬂﬁélc}é#hﬂ'ﬂﬁlﬂﬁl @@ﬂ@@r@i

ﬁiil‘?

F'r.-’-‘n.ddr Cantraller
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48 DaRGW 2-6-0 Magul - TCS-MCE Loco _ mv 297 28 Fooo  _
D‘ Gandy Dancer - 02120 Loco P 018 0218 nc02 28 Fooo
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The Blank Item can either be converted into a valid Item in its own right (see Section
5.3), or simply removed by using either Delete from the Edit menu, or the #& icon on
the Toolbar, or just by pressing the Delete key on the keyboard, with the Blank Item

highlighted (as above).

Important : using the Delete operation does not copy any deleted Items to the Copy
Buffer, although you can restore such Items using Undo if they were deleted in error.

Note, however, that if you Delete a Consist, then any assigned Multiples are also
deleted, but immediately converted to Locomaotives, as explained previously, and then

pasted back into the Item List.
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Copied Items remain in the Copy Buffer until replaced by another Cut or Copy
operation or removed by the remaining operation involved in handling the Copy Buffer,
namely, Empty Buffer (). This Edit operation, as is fairly obvious, completely clears
all copied Items from the Buffer.

Note carefully that the Empty Buffer action can neither be reversed nor undone - so
that any Items which were Cut or Copied to the Buffer will be completely lost (the
original Copied Items will still be in the Item List, of course, provided you have not
Deleted them in the meantime). A warning to this effect is displayed, asking you to
confirm the deletion —

Do you wish to remove all Copied ltems
Fi l % permanently from the Copy Buffer 7

After clearing the Copy Buffer, you may still be able to perform a set of Undo
operations to regain any Cut Items, provided the Cut operation(s) occurred within the
last 32 Edit actions (and, of course, you should have a back-up copy of the original
Item List stored safely on your hard disk or removable media). However, in any case,
to restore the Copy Buffer contents, you will have to copy the relevant Items again.

To add a new Item to the displayed Item List, use Insert Blank Item on the Edit
menu, or the E'+; icon on the Toolbar —

a A-Track - PowerCab - COM 10

Eile Edit View [tem NCE Route Mimic Help

et dES £ ¥ @k #BA0RF HOwEL 2

addleT ank - Econami Leco
Either action adds a Blank Item to the end of the Item List, although the position at
which it is displayed on the screen will depend on how the Item List is currently sorted
(see Section 4.1). Each Blank Item which is added has a unique identifying number
added to its Description field (#28 in the example below) to help you when accessing
and editing a specific Item’s parameters after adding several Blank Items to the List —

I:Iﬁ MeGiligan Luriber #2 - MCE Switch-t Mk2 Acceszy P 00=e >0221 nz

(M= Blarik |tem #25 Hone _P =000 0aaa _
A7 Item List : C:\Users'User\Documentsha-Track Item Lists'AT-Tutorial-Demo-44.itl @ Iterns . 28 Currert: 28 |NCE @ [1COM @

Note that adding further Blank Items by copying the first Blank Item, and then pasting
it into the Item List, results in all new Blank Items displaying the same identification
number — although A-Track will still handle them all as unique Items using an assigned
internal key.

After inserting a Blank Item you need to set up its parameters to change it into an
Item which corresponds to one of the real locomotives, consists, or accessories to be
operated on your track layout. How to do this for all types of Items and their range of
possible functions is explained fully in Chapter 5.
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The characteristics of each Item in the Item List are set primarily by the values of the
Configuration Variables (CVs) which are programmed into the real DCC decoder fitted
within the locomotive or accessory corresponding to the Item.

You can obtain access, to set and modify the Item’s CVs, together with the various
other parameters which provide a full Item definition, through either the Item or Pop-
Up menus (refer to Chapter 12 for descriptions of all menu operations).

) A-Track - PowerCab - COM 10

Dperate
Colorado kinir

D" Greenbrier & Elk River 3-Truck Shay - LokSn.. Loco
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A& & s W S AT T F ?
Description Allocate NCE Cab | Flags | F‘r»’-‘-.ddr| E:-:.-’-‘-.ddr| Cantraller | SpStsl Speedl FL| Func:t'l-El
D" Farmers Union A =009 0309 MCo2 28 F 000

24

F 000
F 000

The Pop-Up menu appears whenever an Item is right-clicked. The Pop-Up menu also
contains selected options from the Edit menu for convenience (but note that, here, the
functions apply only to the single Item which was right-clicked) -

7D A-Track - PowerCab - COM 10
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Clicking the Edit CVs entry on the Item or Pop-Up menus will open a new window
which allows all of the Item’s Configuration Variables and other parameters to be
viewed, edited, and programmed into the real Item’s DCC decoder.

While the CVs of any Item are being edited, you cannot change or edit the Item
List. All relevant File menu options, such as New, Open, and Close, and the all Edit
menu options which would allow the structure of the Item List to be altered, together
will all associated Toolbar icons, are disabled until you close all editing windows.

Note, however, that, while Item editing is in progress, you can still add new blank
Items to the Item List, either to generate a new Item from scratch, or to copy CVs
from an existing similar Item. This can be done using the Edit / Insert Blank Item
option (keyboard shortcut Shift-Insert), or by clicking the E,’IE Toolbar icon.
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5.1 Edit Configuration Variables Window

Click on Edit CVs in either menu, or on the B icon on the toolbar (see above), or
simply double-click on the Item itself in the Item List to open the Edit Configuration
Variables window for the selected Item —

[tem #6 - Addr 2011 - Configuration Variables

, Item Description |DSRGW 2-Truck Shay - DN142 | Item
Description

Hasdiiesyles Item Type Primary Address
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ifi 000
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Tabs

Manufacturel
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EEs | \
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011 | 000 00D 00O 00O 00O 0OD 078 188 244 000 000 00O
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000 000 | OO0 00O 00O 048 000 142 222 000 00O 00O 032 \
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wle|~o|un|mfw|n]=]alQ

000 000 054 000 000 000 048 172 236 000 000 oo [N

Note that you can open Edit CVs windows for as many Items as you wish at the same
time, and work with any selected window, including the main A-Track window, while all
Edit CVs windows remain on the screen. The windows can be minimised to the Task
Bar, to reduce screen clutter, if required. If you have several Edit CVs windows open
then, in order to see them all on the screen at the same time, make sure that the main
A-Track window is not maximised — otherwise you will only see one Edit CVs window
displayed on the screen (in front of the maximised A-Track window) at a time.

An Edit CVs window has four distinct areas, each containing some information or
parameters relating to the corresponding Item -

Item Description - a piece of descriptive text about the Item - this can be
anything you wish, up to a maximum length of 64 characters

Parameter Tabs - a collection of tabs or pages each dealing with a set of
related Item CVs or other parameters

Action Buttons - to invoke functions related to editing CVs, transferring
them between Items and DCC decoders, and saving the results back to the
Item List

CV Values - a grid showing the value held in the Item for each Configuration
Variable. A CV value can lie between 000 and 255, although valid values for
specific CVs can be restricted to a smaller range by the NMRA standards or

by the decoder manufacturer. When opened initially, as above, the grid shows
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CV01 to CV128, but other ranges of CV values can be displayed when
required (see Section 6.3).

When you pause the mouse cursor over any CV value in the grid, a pop-up
label describing the function (if any) allocated to that CV will be displayed, as
shown in the example below, where the cursor is over CVO1 which holds the
Item’s Primary Address —

‘ @ Active - NCab [z %) Edited €3 Mot Progd

Cloze |

1% | 2% | 3x [ 4x | 5x [ 6x | 7x | 8x | 9% [10x]11x]| 122
000 | 000 | 000 OO0 000 OO0 DG4 | 180 240 | 000 000 | 000
000 000 | 000 OO0 000 00O 078 | 188 244 | 000 000 00O
o0okeD01 | 000 000 | D00 OO0 | 000 092 196 | 248 000 | 000 | 00D
oonoon ool ong | gog | goo | 000 106 204 | 252 | 000 | 000 000
—[CV-001 Primary Address) 000 | 000 | 128 118 | 210 255 | 000 000 | 00O

0
1
2

The Edit CVs window opens showing the Item Description and the contents of the
Identity Parameter Tab, as shown on the previous page. This Tab displays the Type of
Item (Locomotive, in this case, but could also be a Consist or an Accessory), and
allows you to set or change the Item’s Primary and Extended Addresses for a
Locomotive, the Primary Address for an Accessory, or Consist Address if the Item is a
Consist or Multiple, and to enter your own values for the User Identifiers if required.

Setting Key Item Parameters

The Item Type and Primary (or Consist) Address, at least, must be defined under
the Identity Parameter Tab before the Item becomes usable (and it is always advisable
to enter a sensible Item Description, possibly with details of the fitted decoder and, in
a club roster, the owner’s name or initials, before proceeding).

The Identity Tab also shows the current allocation of a Loco or Consist Item to either
an NCE Cab (only if you are using an NCE Power Pro or Power Cab / Smart Booster
V1.65 system) or to a Console (under direct control from the PC screen). When
allocated to an NCE Cab as the current Item under control, the relevant Cab Address is
shown (02 here), together with a green/white tick icon (&) -

— 2 Manutacturer [D 129
g @ fctive-N'Cab [02 %) Edited €3 MNotProgd

Cloze |

Cv | ox | 1x]| 2e| 3x | 4x | 5x | 6x | 7x | 8x | 9% [10x|11x][12x
0 000 | 000 | 000 000 000 000 064 | 180 | 240 000 000 000

Alternatively, if a Loco or Consist Item is held in the NCE Cab Recall List (not under
active control), the alternative yellow/green tick icon () is used —

—_— S Manutacturer |D 1249
g ) Active - N'Cab [02 3¢ Edited €3 Mot Prog'd

Cloze |

Cv | ox | 1x]| 2e| 3x | 4x | 5x | 6x | 7x | 8x | 9% [10x|11x][12x
0 000 | 000 | 000 000 000 000 064 | 180 | 240 000 000 000

Note that Accessory Items cannot be allocated to an NCE Cab although, like Loco and
Consist Items, they can be allocated to direct control through the PC screen and
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mouse, ie. to a Console. In early releases of A-Track this would be indicated with a
green/white tick icon (&) on the Identity Tab, together with display of the
corresponding Console address — ‘01’ in the example shown below — but, since editing
of the Item is now not allowed when under Console control, this view is not available.

| Updaelen_|

| ¥ Active - Consl [0 %) Edited €4 Mot Progd

M anufacturer 1D |129

Cloze

CV | 0x | 1x | 2x | 3x | 4x | 5% | 6x | 7x | 8¢ | 9% [10x]11x]12x
0 000 | 000 | 000 000 000 000 04 180 | 240 000 OO0 | 000

Besides an identifying Address, the other key parameter for Locomotive (or Multiple)
Items which must be defined before using the Item with a real decoder is the Decoder
Configuration, held in Configuration Variable CV29, whose current settings can be
found under the Config Parameter Tab. Click on Config to reveal the tab’s contents,
as shown below for a Loco Item —

[tem #6 - Addr 2011 - Configuration Variables

Item Deszcription |D&HGW 2-Truck Shay - DN142

Proaran Cv's | IdentilyT Config T Speed TFunct'nT PagesT Susl

ReadMerify e Parameters  »»> Baszic Operation
(* Basic Operation Extended Address
Copy all TV
M (" Automatic Stop Jze Speed T able
i Bi-Directional Conmms
g " Alemate Power Source Mon-DCC Prar Corwert
EMF FBk Cutout {000

28 Speed Steps
Packet Time-Out (000

Rewerze Direction
| Pradhd Period 13 Lzec

IRE TR A

Cloze

Ox | 1x | 22 [ 3x | 4x [ 5x [ 6x | 7x | 8x | 9x [10x][11x]12x

000 | 000 | 000 000 000 000 064 | 180 | 240 000 000 000
011 | 000 | 000 000 000 000 OO0 | 072 | 188 244 | 000 000 00O
000 | 001 | 000 000 000 000 OO0 | 092 | 196 248 | 000 000 000
000 | 000 | 000 000 000 000 OO0 | 106 | 204 | 252 | 000 000 000
000 | 000 | 000 000 000 000 128 | 118 | 210 255 000 000 000
000 | 000 | 000 000 000 128 001 | 130 216 | 000 000 000 OS54
000 | 000 | 000 000 000 048 OO0 | 142 | 222 | 000 000 000 032
250|199 | 000 000 000 000 O16 | 152 | 228 | 000 000 000 000
129| 219 000 000 000 000 032 | 162 | 232 | 000 000 000 000
000 oo0 054 000 o000 oo o48 172 236 000 ooo ooo [

wmﬂmmhwm—ﬁcg

You can enter the basic settings required for CV29 simply by clicking on the group of
checkboxes shown under Basic Operation, which will select (tick) the required set of
options for this Item. With the options set as above, the Locomotive will respond to its
Extended Address (4-digit value) and will use the Speed Table defined by the 28
values in CV67 to CV94 (see Section 6.1 for guidance in defining and using Speed
Tables).

When any of the checkboxes are ticked, A-Track will automatically translate the
selection into the appropriate value held in the relevant Configuration Variable (CV).

If the Locomoative is to be used on a non-DCC system then the Non-DCC Pwr Convert
option is ticked as shown. You can then click on the Alternate Power Source option
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button in the Parameters section to view a set of six alternative systems which can

be selected —

ltem #6 - Addr 2011 - Configuration Variables

Program O |

Item Description |D&F|GW 2-Truck Shay - DN142

Identit}lT Config T Speed TFunct'nT PagesT Susl

Read ey Cv's
Copy All Cv'e
Faste Main Cy's
Paste Exten'd CV's
[ReseTcerdcs |

Parameters 33> Power Source

(" Basic Operation (* Analog
(" Automatic Stop " Radio
T Zero-1
™ TRIX

{~ CTC1E / Railcommand
EMF F'Bk Cutout {000 " FMZ [Fleizchmann)

—

Operation on DC (Analog) — as opposed to DCC — is selected automatically as the
default option, and results in the value of CV12 being set to 001 (as shown above).

More complex configuration parameters can be accessed by selecting one of the other
sets listed under Parameters. If the decoder being used supports the facility (consult
the manufacturer’s user documentation for details), Automatic Stop provides a

means of bringing the Locomotive to a halt when it encounters a specific condition on
the track, as selected from the available options —

Item #6 - Addr 2011 - Configuration Variables

Program Cv's |

Item Description |D&FH3W 2-Truck Shay - DWN142

IdenlityT Config T Speed TFunct'nT PagesT Susl

Readerify Cie
Copy &ll Cv's
Paste Main CWs
Faste Exten'd Cv's
Paste nderd s |

Parameters  >»> Automatic Stop

B
b
e
" Alemate Power Source

EMF FBk Cutout {000

[~ Fomward DC

[~ Rewverse DC

[~ Signal Controlled

[~ Asgprm DCC + Left
[~ Asprm DCC + Right

If the Bi-Directional Comms option is ticked under Basic Operation, and the
decoder being used supports this type of facility (consult the manufacturer’s user
documentation for details), clicking the Bi-Directional Comms option button in
Parameters will then display three possible types of communication from the decoder

back to the Command Station —

ltem #6 - Addr 2011 - Configuration Variables

Item Description |D&F|GW 2-Truck Shay - DN142

Program O |

Identit}lT Config T Speed TFunct'nT PagesT Susl

Read ey Cv's
Copy All Cv'e
Faste Main Cy's
Paste Exten'd CV's
[ReseTcerdcs |

Bi-Directional Comms

r Initiated Broadeast
Signal Controlled
Initiated Broadeast
Agpmmetnic DCC

Decoder Initiated
Unzolicited

Parameters 33>
(" Basic Operation
~ -

" Alternate Power Source

EMF F'BE Cutout |000

—
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Note that, although several decoder manufacturers have implemented their own
proprietary bi-directional communications systems, it would appear that no one has
yet offered a system which complies with the NMRA specification.

In addition to these esoteric options, under the Config Tab you can also set more
normally-encountered parameters such as the EMF Feedback Cutout, Packet Time-Out,
and PWM Period, although it is probably best to leave these alone unless you have
some guidance on recommended values from the decoder or locomotive manufacturer.
Note that the PWM Period value is defined (in the NMRA Standards and Recommended
Practices) by a rather complex formula which, while allowing a wide range of values,
restricts these values to specific numbers. Hence, if you type a new value into the PWM
Period textbox, your entry will be converted to the nearest allowed value less than
your entered figure. Allowed values range from 131 to 32640 microseconds (usec).

For an Accessory Item, the format of the Config Tab has fewer options, as shown in
the example below. The basic Parameters, as defined in the NMRA DCC Standards,
are simpler, where the only other configuration options allow you to select which of the
four pairs of Auxiliary inputs will operate the corresponding pair of Accessory outputs,
and the time for which each pair of outputs will stay in the ‘On’ state following receipt
of an activating command to the relevant Output Address (shown highlighted with a
light yellow background) —

[tem #7 - Addr 0260 - Configuration Variables

% Item Description |Accessory Decoder - Wangrow Shd-104

Frogram Ci's | Identity | Config
Readernfy Cvs Parameters Programming
[ Extended Decoder Type — Frogram on Mjﬂin
Copy All CY:
M [ Output Addreszing [ Manuf Specific)
[ Bi-Directional Comms [~ [~
(| o
Auxiliary Input Activation
1w 2 30 40 & & 7w &8v
Outputz 1 - 4 Address + Time On
[1037][oo0 [1038][ooo [1035][oo0 [1040][od0

Cloze |

Ox | 1% | 20 [ 3| 4x [ 5x | Bx | 7x | 82 | 9x [10x]|11x]12x

255 2R 255 000 | OO0 000 000 000 | 000 000 000 | 000
004 265 255 | 255 | OO0 OO0 000 000 | 000 000 000 000 | 000
195 265 255 255 | OO0 OO0 000 000 | 000 000 000 000 | 000
000 | 255 | 255 | 000 | 000 000 000 000 | 000 000 000 000 | 000
000 | 255 | 255 | 000 | 000 000 000 000 | 000 000 000 000 | 000
000 | 000 | 255 | 000 | 000 000 000 | 000 | 000 000 000 000 | 000
000 | 000 | 255 | 000 | 000 000 000 | 000 | 000 000 000 000 | 000
012 265 255 | 000 OO0 000 000 000 | 000 000 000 000 | 000
012 265 255 | 000 OO0 000 000 000 | 000 000 000 000 | 000
004 | 255 128 000 000 o000 ooo ooo ooo o000 ooo ooo [

wmﬂmm-ﬂ-wm-lcg

Although the NMRA DCC Standards generally assume that Accessory decoders (like
those for Locomotives or Consists) will have their address, at least, programmed on a
separate Program Track, most manufacturers now produce Accessory decoders which
are designed to have their addresses, and any other parameters, programmed directly
from the Mainline Track in conjunction with switch or special wiring settings on the
decoder itself, and it is rare nowadays for an Accessory decoder manufacturer to use
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any CVs to control the decoder’s operation. Refer to the decoder manufacturer’s user
documentation for details of their specific control scheme.

When you set up an Item to represent one of these modern Accessories, you should
click to tick the checkbox in the Programming area (see above) labelled Program on
Main Track (Manuf Specific). If this is an Accessory decoder manufactured by NCE,
then tick the NCE checkbox as well — and the Mark 2 checkbox if it is one of NCE'’s
more recent products.

After ticking the NCE checkbox you also have the option to tick the Light-I1t checkbox
if the Accessory decoder is an NCE Light-1t or NCE llluminator (essentially the same
device, except that the Illuminator has an additional set of sockets).

The final checkbox in the Programming area, that labelled QSDD, should be ticked if
the Accessory Item is intended to represent a Quad Servo DCC Decoder. This device,
based around an Arduino Nano microcontroller, was designed by myself as a do-it-
yourself project and was featured in Model Railroad Hobbyist Magazine in two parts, in
the February and March 2020 issues, with an accompanying set-up video available on
YouTube. You can also download a copy of the full constructional details for the Quad
Servo DCC Decoder from the Download page of the A-Train Systems website.

After ticking any of the checkboxes in the Programming area, two further Parameter
Tabs labelled Addrs and Names will then be displayed, and will allow you to allocate
up to eight Output Addresses to the Accessory, together with several other options,
and then to give each Output Address a descriptive Name which is representative,
perhaps, of the layout location of a turnout to be controlled via that address. An
example is shown below for an NCE Switch-It —

[tem #26 - Addr 0212 - Cenfiguration Variables

% Item Description |McGiIIigan Lurmber #1 - MCE Switch-|t

Identit_l,lT Conlig T Addrs T Names}

Read ety Cv's Mumber of Outputs m Output Address - Sel
Copy &Il Cy's P Ao Output 1 |0211 ™
gog'am ELeY Qutput 2 [0212
[ Sequential Addreszes Output 3 |====
g MCE Options Output 4 |====
[~ Enable 0/F Togagle Output & |====
g [v Molegacy Ops Prog Output 6 ===
[ Dizable P-Button [/Ps .
g v Enable 0/F Exercize R & | e

| m Output 8 |====

D

B L N N B B

Cloze

Ox | 1% | 20 [ 3| 4x [ 5x | Bx | 7x | 82 | 9x [10x]|11x]12x

000 000 | 000 | 000 | 000 000 | 000 | 000 | 000 000 000 | 000
053 000 000 000 | 000 000 000 | 000 | 000 000 000 000 | 000
000 | 000 | 000 | 000 | 001 | 000 000 | 000 | 000 000 000 | 000 | 000
000 | 000 | 000 | 000 | 000 000 000 | 000 | 000 000 000 | 000 | 000
000 | 000 | 000 | 000 | 000 000 000 | 000 | 000 000 000 | 000 | 000
000 | 000 | 000 | 001 | 000 000 000 | 000 | 000 000 000 | 000 | 000
000 | 000 | 000 | 000 | 000 000 000 | 000 | 000 000 000 | 000 | 000
000 | 000 | 000 | 000 | 000 000 000 | 000 | 000 000 000 | 000 | 000
000 | 000 | 000 | 000 | 000 000 000 | 000 | 000 000 000 | 000 | 000
oo0 | 000 152 000 o000 o000 000 ooo ooo ooo ooo ooo [

wmﬂmm-ﬂ-wm-lcg
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Item #26 - Addr 0212 - Configuration Variables

& Item Description |McGi|Iigan Lumber #1 - HCE Switch-t

Identity| Config | Addrs | Names

ReadAerify Cvs | Addr-Link+Dir+Name | — Output [Turnout] Name

1 foz11 [oooo [u I || 1 [McGiligan #1 East
m 2 [oz1z [oooo [u I || 2 [McGiligan #1 west

a = ||z

4 |l a[

5 [ T

E [ 3

7 == [

flommm [e=== [T || 8 [

Cloze |

[ev ok [ 1] 2 [ 3x [ ax | 5 [ 6x | 7x [ 82 [ 9% [10x[11x[12x]

Further details of how to set up addresses, names, and parameters for Accessory
Items, and then program the relevant values into the actual decoder, can be found in
Sections 7.1, 7.3, and 7.5.

The Edit CVs window for a Consist Item does not use any Parameter Tabs other than
Identity and Config, since the detailed parameters for the Consist’'s constituent
Locomotives (referred to as Multiples) are stored in the Multiple Items themselves.

The Consist Config Tab shows you, in a drop-down list, which Locomotives are
currently assigned to this Consist, together with controls to alter the Locomotive
assignments to suit your requirements. Note, however, that a Consist Item does not
possess any real Configuration Variables of its own, and that you cannot directly edit
any of the values shown in the CV Value Grid (some of which are used by A-Track to
save details of the Consist) —

[tem #27 - Addr 120 - Configuration Variables

L Item Description [Switcher Consist #2

Frogram Ci's | Identity | Config

Rlead/Verity Cv's Locomotive As#ignment _

 Lead  KMid1  KMid2 Clear Consist
g ™ Mid3 " Midd 7 Rear
Aszsign Address |0464 (v M
Auto dszign v o Edit Loco

Description
|ﬁ3«T&SF GE 44 Switcher - DM140
Aszsigned Loco List [ Lead / Mid 1-4 / Rear |

|0464 F ATESF GE44 Switcher - DN140 -]

(146 i) E] er - [ E

0000 F Mo Locomotive Agzigned h
On | Tx | 20 || oty oF GEdd Swicher . DN13ED =
000 | 0004000 F Mo Locomotive Azzigned o
000 | 000 | 000 | {0000 F Mo Lecomotive Assighed a0
oo0 000 oo (D436 R DRGW GE44 Switcher - DM1350 oo

000 | 000 | 000 | 000 000 000 | 000 000 000 | 000 000 000 ooo
000 | 000 | 000 | 000 000 133 | 000 000 000 | 000 000 000 ooo
000 | 000 | 000 | 000 000 207 | 000 000 000 | 000 000 000 ooo
000 | 000 | 000 | 000 000 000 | 000 000 000 | 000 000 000 ooo
000 | 000 | 000 | 000 000 000 | 000 000 000 | 000 000 000 ooo
000 | 000 | 000 | 000 000 000 | 000 000 000 | 000 000 0o ooo
000 120 | 000 | 000 000 000 | 000 000 000 000 000 000 !

wmﬂmm-ﬂ-wm-lcg
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By selecting any of the assigned Locomotives listed under the Config Tab, and then
clicking the Edit Loco button, you can open a new Edit CVs window displaying the

parameters of the selected locomotive. If you open Edit CVs windows for all of the

assigned locomotives then you can check that all of their individual parameters are
consistent with each other.

In particular, ensure, under the Speed Parameter Tab, that each Locomotive uses the
same Speed Step Precision (14, 28, or 128) and that their speed characteristics are
matched. Matching speed characteristics, so that each locomotive runs at the same
track speed for any given speed controller setting may require implementation and
tailoring of one of the Speed Tables for each locomotive individually (even if they are
nominally the same model from the same manufacturer). See Section 6.1 for details
of Speed Table settings, and Sections 6.11 to 6.13 for full details of how Consists are
constructed and handled.

Feel free to explore all of the options available in the Edit CVs window and experiment
with changing the various CV options. You cannot do any damage to the Item’s actual
stored values because, in the Edit CVs window, you are only working with a temporary
copy of each Item’s parameters.

As soon as you make any change to the Item’s parameters or CV values, the Update
Item Action Button will be enabled.

When the Update Item button is clicked, all edits will be transferred immediately to
the Item in the Item List, replacing all previous parameter values. Even then, after
updating an Item’s parameters, the Item List Undo option is still available to return
the Item to its former state and, if all else fails, you can choose not to save the altered
Item List when you close the A-Track program, leaving you (hopefully) with a safely-
stored copy of the original Item List.

Alternatively, when you click on the Close Action Button, after making any changes to
the Item’s parameters, you will be presented with a set of options either to transfer
the changed values to the Item proper in the Item List (Yes), or to ignore all changes
(NOo), leaving the Item in its original state, or to return to the Edit CVs window in its
current state (Cancel), allowing you to continue with editing —

Confirm Action - kem #7 *

CV Values or ltem Parameters
! b have been changed

Update [tem before Closing CW Edit 7

No Cancel |

If no changes have been made to the Item’s parameters, clicking Close simply closes
the Edit CVs window.
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Initialising a Blank Item

Before looking at the other Parameter Tabs, it is worth going through the initial actions
you need to perform under the Identity and Config Tabs when adding a new Item to
the Item List, ie. starting with a Blank Item inserted using the Edit action described at
the end of Section 4.5. Part of this process was previously covered in Section 3.7 as
a quick, practical introduction to the usage of A-Track.

A double-click on the Blank Item opens an Edit CVs window as usual, but showing all
Item parameters with zero values.

Your first action must be to select the Item Type - the available choices are
Accessory, Consist, and Locomotive, as shown below. You cannot proceed to define
any other parameters while the Item Type remains at None. Your selection will change
the Item Description appropriately, and highlight it in pink, indicating that it has
been changed since the Edit CVs window was opened. Note that once you have
selected an Item Type you cannot change it to another Type — if you select the wrong
Type by mistake, simply click Close, select No when prompted to update the Item,
then double-click on the original Blank Item to re-open it in a fresh Edit CVs window.

[temn #28 - Addr 000 - Configuration Variables

“ Item Description [Blank tem 28

Proaran C's Identit_pT Config T Speed TFunct'nT PagesT Susl

Item Type Primary Address &% o0
(™ Accessary Extended Addreszs nooo
[ | Consist &ddress oo - 127
= User Identifier #1 000
; Locomotive. | 1 Identiier 82 000
tanufac Version Mo, 000
f+ None M anufacturer D o0

& MNotfllocated 00 3¢ Edited €3 MatProgd

Ox | 1x | 22 [ 3x | 4x [ 5x [ 6x | 7x | 8x | 9x [10x][11x]12x

000 | 000 | 000 000 000 000 000 | 000 | 000 000 000 000
000 | 000 | 000 000 000 000 000 | 000 | 000 | 000 000 000 000
000 | 000 | 000 000 000 000 000 | 000 | 000 | 000 000 000 000
000 | 000 | 000 000 000 000 OO0 | 000 | 000 000 000 000 000
000 | 000 | 000 000 000 000 OO0 | 000 | 000 000 000 000 000
000 | 000 | 000 000 000 000 OO0 | 000 | 000 000 000 000 000
000 | 000 | 000 000 000 000 OO0 | 000 | 000 000 000 000 000
000 | 000 | 000 000 000 000 OO0 | 000 | 000 000 000 000 000
000 | 000 | 000 000 000 000 OO0 | 000 | 000 000 000 000 000
oo0 | 000 000 000 o000 o000 000 ooo ooo o000 ooo ooo [

wmﬂmmhwm—ﬁcg

Assume that we select Locomotive, so that the Description becomes “Blank
Locomotive #28”, together with an icon appropriate to a Locomotive (&% - see Section
4.1), as shown below —
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Item #28 - Addr 000 - Configuration Variables

Item Description |Blank Locomotive #28

Program C¥'s ( IdentilyT Conﬁg\[ Speed ] Funcl'n]' Pages] Susi
—IReadNeniy G Item Type Pimaty Address @ (003
Copy All C¥s { Extended Address 0003

i Consist Address 000

User Identifier #1 000
ntifier #2 000

& NotAlocated W 0 Edited Q Not Prog'd

Manufacturer ID

Update Item

Close |

Ox 1x|2x

cv 3x | 4x | 5x | 6x | 7x | 8x | 9x [10x[11x[12x Select
0 000 000 000 00D 000 000 000 000 000 000 000 000 Item Type
1 | 003 000 000 000 OO0 000 000 000 000 000 000 000 OO0
2 | 000 000 0O0 0OD 0OO 0OO 0OO OO0 0OO 0OO OO0 00O 000
3 | 000 000 000 0OD 0OO 0OD OO0 OO0 OO0 OO0 OO0 000 000
4
5
6
7
8
9

000 000 000 OO0 O0OD OO0 O0OO O0OO OOD OO0 OO0 OO0 OO0
000 000 000 00O QOO 000 OO0 O0O0O OO0 OO0 OO0 OO0 OO0
000 000 000 00O OO0 O0OO O0OD OO0 OO0 OO0 OO0 OO0 000
000 192 000 00O O0OD OO0 O0OD OO0 OOD OO0 OO0 OO0 00O
000 003 000 000 0OD O0OO O0OO 00O OO0 OO0 OO0 000 000
000 000 002 000 OO0 O0OO O0OD OO0 OO0 OO0 OO0 OO0 !

Note that CVO1, CV17, CV18, and CV29 in the CV Value Grid are also highlighted in
pink, and that the value of CV0O1 has been changed to 03 which is the default Primary
Address for Locomotive decoders. The entries for CV17 and CV18, which together
hold the Extended Address for a Locomotive decoder, also represent a value of 0003
since, as required by the NMRA DCC standards, CV17 always has a hexadecimal value
of CO (192 decimal) added to it.

The updated Configuration value in CV29 (02), indicates that 28 Speed Steps
operation has been selected.

In passing, note that the background of the Program CVs button has also been
changed to pink as a reminder that some CV values have been altered. This feature is
not particularly significant when dealing with a single block of CVs, as here, but can be
useful when handling complex decoders with multiple blocks of CVs, as described later
in Sections 6.6 and 6.7.

If the new Item’s Type is selected as Accessory, then the default Accessory Address
value of 01 will be stored in two parts in CV01 (01) and CV09 (00), and the
Configuration value in CV29 will be set to 80 hexadecimal (128 decimal) to indicate an
Accessory Decoder. Further details on setting up a new Accessory can be found in
Sections 7.1 and 7.3.

Conversely, if Consist is selected for the Item Type, then the Consist Address held in
CV19 will be set to the first available consist address. Consist addresses can range
from 01 up to 127 and, to be consistent with the policy applied by NCE Power Pro and
Power Cab Systems, address allocation starts at 127 and works downwards until an
address unused by any other Consist in the current Item List, or held within the NCE
Command Station (if it has been connected), is found. If all possible addresses have
already been allocated, then a warning is displayed and the creation of a new Consist
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is terminated. Further details on setting up a new Consist are covered in Section
6.11.

Continuing with the initialisation of our example Locomotive, the next step is to click in
the Item Description textbox (to the right of “Blank Locomotive #28”) ready to enter
a suitable title for the Item. With “Blank Locomotive #28” highlighted, simply type a
new descriptive title for the Item, of up to 64 characters, then press the
Enter/Return or Tab ("—_H) key. The new Item Description remains highlighted in pink
to show that it has been changed.

Now, click on the Pages Parameter Tab where, in the Decoder Manufacturer
section, you should click the Specific Manufacturer option button followed by a click
on the down-arrow () at the righthand end of the listbox below the option button.
Full details of the Pages Tab options are described later in Section 6.3.

If the make of decoder fitted in the locomotive corresponding to this new Item appears
in the drop-down list, then click on that maker’'s name. Otherwise (or if you do not
know the make of decoder) click the Basic / Other (NMRA CV Definition) option (or
the Basic / Other (NMRA) option button itself) —

Item #28 - Addr 000 - Configuration Variables

Item Description [Colorado Southem 2-6:0 Mogul - 2145A Basic | Config |

: - ‘ ) % Acceleration Adjustment
Program CV's l Identity] Conlig] Speed] Funct'n] Pages' S

Acceleration Rate
e

Read/Verify CV's | Decoder Manufacturer l:N)EW IFen:l
CopyAﬂ C\s I Basic / Other [NMHA] & [_ escrlptIOn
entered

Specific Manufacturer & Select from list below -
—J INCE Corporation L]
: : I Basic / Other (NMRA CV Definitions) Deceleration
: : Broadway Limited - Paragon 2/3 Decelersion | Decoder
e | Digitrax Inc Decodg Manufacturer

ESU LokSound
Update Item | Lenz Elektronik ~ ,_mﬁa selected
I Model Rectifier Corporation (MRC) EMF Feedba

MTH Electiic Trains - Proto-Sound 3 Extended Address LS 8 Bits
N oiporatio Extended Ad
| 0x | 1x | 2 | {SI Solutions - Quantum 2% IFu_l‘wachI Tim | Default

000 000 (SoundTraxx B e ry

Y
0
1 | 003~ 000 LO0 | y 4 T T oo :

. - Kick Start
2 | 000 ooo ooo Zimo Elektronik 00 Uﬁtputgonlr Address
3 | 000 00D OO0 00D 000 000 000 000 000 000 000 000 000 ||OutputControlfor Function FOZ
4 | 000 000 DOD OO0 OOD OO0 OO0 OO0 ODD 000 000 000 000 || |Output Controf—= caa
5
6
7
8
9

Close

000 000 000 00D 000 000 000 OOD 00D 00O OO0 000 OO0 8““’“‘ Contd  Default
000 000 000 000 000 000 000 000 000 O Extended
000 192_000..00 oT—ooT—ooU T Uo0 T OO0 T TOWpd Contid] - Address
000 003 000 000 OO0 000 000 OO0 OO0 000 00O 000 000 |||OutputControl
Output ControlTor Function FUS

000 000 002 000 00O OO0 00O 00O 00O 000 000 000

At this point, before adding any more details to your new Loco Item, the sensible step
is to click the Update Item button to save the Item with its initial identity back to the
Item List. To be doubly safe, you could also save a copy of the amended Item List back
to the PC’s hard disk (or other permanent storage).

Before re-opening the Item’s Edit CVs window to continue (by a double-click on the
saved updated Item) ensure that your NCE Command Station (Power Cab or Power
Pro) is connected to the PC, powered on, and communicating correctly, ie. with the
status indicators at the righthand end of the status bar showing green.
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The next stage is to copy the current contents of the decoder fitted in the locomotive,
which the Item will represent, into A-Track. This step ensures that you capture all of

the CV settings preset in the decoder by the manufacturer, as a starting point before

you start to enter any of your own preferred customisations.

To do this, open the Edit CVs window by double-clicking on the Item in the Item List,
then place the locomotive on your programming track (or, if you are using a Power
Cab and do not have a separate, switched programming track as shown in the
connection diagram in Section 1.1, ensure that it is the ONLY locomotive on the main
track).

Note that, if your locomotive has a sound decoder, and you are using an NCE Power
Pro system, then you will generally need to connect a programming booster unit
(such as the SoundTraxx PTB-100) between the Power Pro and the programming track
— a booster is not required with an NCE Power Cab system.

Click the Read/Verify CVs button in the Edit CVs window to display the Read/
Verify Configuration Variables panel where, for a first attempt at reading your
locomotive decoder’s CV values, you should set the CV Range and Scope options to
Current View and All CVs, and the Mode to Paged (See Section 6.6 for further
details of Read/Verify operations). While Direct Mode will read CV values more quickly,
it is not always supported. Paged Mode is generally guaranteed to work but, the higher
the CV’s programmed value, the longer it takes to determine the actual value of the CV
from the decoder —

Item #28 - Addr 0547 - Configuration Variables
= Click ‘Read/Verify

CVs’ to open

Options Panel

Item Description !Colorado Southern 2-6-0 Mogul - Z145R

Program CV's >
ReadAerify I'_Vsj ~Read/Verify Configuration Variables
CV¥ Range CV Scope Mode
& Curent View @+ AllCYs *+ Paged
f " AlCY Blocks " Selected " Direct

" Reqgister

: " Address
22 B
Confirm I f}

’cv Ox [ 1x [ 2x [ 3x | 4x [ 5x [ 6x | 7x | 8x | 9x [10x[11x[12x]
0

000 000 OO0 O16 0OD 000 00D OO0 ODOO OO0 00D 001 |

When you have set the options, click Confirm to start the Read/Verify operation.

During the Read/Verify operation, the CV currently being accessed will be highlighted
in red in the grid in the lower half of the Edit CVs window. Once the CV value held in
the decoder has been determined, it will be displayed in the grid and highlighted in
light green if the value read is the same as that held in the Item, or highlighted in
pink if it differs from the Item’s stored value.
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[tem #28 - Addr 003 - Configuration Variables

Item Description |COInrado Southern 2-6-0 Mogul - Z145R

Frogram Ci's IdentilyT Config T SpeedT Funct'nT Pages T SUsl

Read/¥erify Configuration ¥ariables

* Current Yiew * AllCvs i+ Paged

" AllCY Blocks " Selected " Direct
"~ Reaqister

[Readveincye |
L Comaicis |
[reszancys |
g " Address
[FeseTherd s |
|

| B

Ox | 1x | 22 [ 3x | 4x [ 5x [ 6x | 7x | 8x | 9x [10x][11x]12x

000 | 000 000 016 000 000 000 | 000 | 000 000 000 000
003 000 255 000 000 000 OO0 | 000 | 000 000 000 000 000
000 000 255 000 000 000 OO0 | 000 | 000 000 000 000 000
000 000 000 001 000 000 OO0 | 000 | 000 000 000 000 000
000 000 000 002 000 000 OO0 | 000 | 000 000 000 000 000
000 000 000 004 000 000 OO0 | 000 | 000 000 000 000 000
000 000 000 008 000 000 OO0 | 000 | 000 000 000 000 000
035 192 000 016 oo ) 000 | 000 | 000 000 000 000 000
011 000 000 004 000 000 OO0 | 000 | 000 000 000 000 000
o0 oo0 o6 oo 000 o000 ooo ooo ooo ooo ooo ooo [

wmﬂmm-ﬂ-wm-lng

Wait patiently while the first 128 CV values are read from the decoder and displayed in
the grid. If required, the whole operation can be stopped at any time by clicking the
Cancel button, although you will have to wait for the current CV Paged Read operation
to complete (up to 20 seconds).

When the Read/Verify operation is complete click the Finish button in the Edit CVs
window. If an error occurred because of a connection problem, correct it and restart
the Read/Verify operation (See Section 6.6 for detailed instructions).

g 0 Read/Yerify Completed Successzfully

Ox | 1% | 20 [ 3| 4x [ 5x | Bx | 7x | 82 [ 9% [10x]|11x]12x

000 000 000 016 OO0 000 000 000 000 000 000 001
003 000 255 000 OO0 000 000 000 000 000 000 000 002
000 000 255 000 OO0 000 000 000 000 000 000 000 000
000 000 000 001 000 000 000 000 000 000 000 000 000
000 000 000 002 OO0 000 000 000 000 000 000 000 000
000 000 000 004 000 000 000 000 000 000 000 000 000
000 000 000 00 OO0 000 000 000 000 000 000 000 000
035 192 000 016 OO0 000 000 000 OO0 000 000 000 000
011 000 000 004 OO0 000 000 000 000 000 000 020 000
o0 oo0 o6 oo oo0 o000 ooo ooo ooo ooo ooo ooo [

L

=

wmﬂmm-ﬂ-wm-lcg

If all went well, you may now wish to read all of the decoder’s CVs by changing the CV
Range option to All CV Blocks, and perhaps the Mode to Direct.

Click the Update Item button at any point when it is enabled to save the Item’s CV
data back into the Item List and close the Edit CVs window. Repeat the operations as
often as required to obtain the full set of CV values currently programmed into this
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locomotive’s decoder, then save the updated Item List as your reference before
making any of your own changes to the locomotive decoder’s CV settings.

Back in the Edit CVs window, the first adjustment you are likely to make is to give the
Item a unique address (or pair of addresses). Click in the Primary Address textbox
and enter the desired Primary Address for the new Item (any value from 001 up to
127) to replace the currently-shown default value of 003, and press Enter/Return, or
the Tab ("—TI) key (or click in any other textbox). A value of 000 can also be entered,
but the Locomotive will then be configured for DC, rather than DCC, operation — and
cannot be operated via an NCE Handheld Controller. The value of CVO1 in the CV Value
Grid is updated again, to show the new Address, and regains its pink highlight.

If you intend to operate the new Locomotive using its 4-digit Extended Address, then
you should enter a suitable value for the Item by typing the required value into the
Extended Address textbox (any value from 0000 up to 9999 is acceptable). To comply
with NMRA DCC standards, the Extended Address value is converted to a hexadecimal
number, the lower byte of which is stored in CV18, and the upper byte, with the value
192 (hexadecimal CO) added to it, stored in CV17. A-Track takes care of all of the
calculations for you behind the scenes, and displays the result as two decimal numbers
(with a pink highlight) as shown below —

[tem #28 - Addr 003 - Configuration Variables

Item Description |Colotado Southemn 2-6-0 Mogul - Z145R

Program CV's I'Idenlily] Config] Speed] Funcl'n] Pages} Susl !
Read/erif —
MI Item Type P[imary Address o
Copy &ll CVs { Extended Address
L I” | Consist Address
‘ £ User Identifier #1
& i ser [dentifier
—'J (: ll..locomo € | User Identiier 12
Y Manufac Version B
C N
Update Item
e

Close |
s
Ox | 1x | 2x Ax | 5x | 6x | 7x | 8x | 9x [10x]11x]12x
00 000 016 000 OO0 000 OO0 000 000 000 001
047-T000 255 000 000 OO0 00O 00O OO0 00O OO0 000 002
000 000 255 000 000 OO0 000 000 000 000 000 000 OO0 Set
000 000 000 OO1 000 000 000 000 OO0 000 000 000 OO Extended

000 000 000 002 000 00D 00D 00D 000 000
000 | 000 000 004 000 000 000 |Addm55
000 000 000 000

000 | 000 00O 008

035 194 000 000 000 000 00O
011 035 000 004 00O OOO OOO OOO OO0 0OO 0OO 020 000
000 | 000 | 006 008 00O 00O 00O 00O 00O 0OO 0OD OO0 !

Set Primary
Address

) NotAllocated €3 Edted €3 NotProg'd

we|~o|o|mfw|nf=]a|Q

Note that the two Item Flags, ‘Edited’ and ‘Not Programmed’ are both now shown as
set, by the red/white cross (@) icons. The Edited Flag (shown as ‘E’ in the Item List
Flags field in Details view) is set whenever any change is made to an Item. The Not
Programmed Flag (shown as ‘P’ in the Item List Flags field) is set whenever a CV
value is altered, and the new value has not yet been transferred to the Item’s real DCC
decoder, or where the parameters of a Consist have been changed, but the Consist has
not yet been activated, ie. transferred to the NCE Command Station and / or
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programmed directly into the DCC decoders of the constituent Locomotives (see
Sections 6.8 t0 6.12).

Both flags remain set when an edited Item is updated, and show in the Item List Flags
field. The Not Programmed Flag (P) will be cleared when an Item’s CV values are
programmed into a decoder, as described later in Section 6.7, or when a Consist is
activated. The Edited Flag (E) is cleared when the Item List is saved to permanent
storage and A-Track is closed.

Hence, when an Item List is loaded, no Item will normally have its Edited Flag (E) set
(unless from an old Item List saved before this version of A-Track has been installed)
but may show the Not Programmed Flag (P) as set, if the Item List was saved without
that Item’s CV values being programmed into a decoder or, in the case of a Consist,
without the Item having been activated.

As an option on the Identity Parameter Tab page, you can enter two numbers, each in
the range O to 255, in the User lIdentifier textboxes. These numbers are purely for
your own use to add some extra personal information to the Item, and can be
programmed into the corresponding decoder (as CV105 and CV106) if you so desire.
The User ldentifiers are not used for any control purposes.

The second adjustment to the set-up of a new Item is to define the Configuration
selections for CV29 by clicking on the Config Parameter Tab, and then clicking in the
appropriate checkboxes to tick the required operational parameters —

Item #28 - Addr 003 - Configuration Variables

Item Description |Colorado Southern 2-6-0 Mogul - Z145R

Program C¥'s | "Idenlily]‘ [:onfig] Speed ] Funcl'n] Page:] SuUsl

ReadMerify C¥/s I Parameters  >>> Basic Operation
(¢ Basic Operation
Copy All CV!
LI " Automatic Stop
i I &
I (" Altemate Power Source
. I EMF F'Bk Cutout |000

Nidate fiem I Packet Time-Out [DDIJ
| PwM Period 131 usec

omms
Non-DCC Pwr Convert

28 Speed Steps
Reverse Direction \\

VU KR

Close

Ox | 1x | 2x [ 3x | 4x [ 5x | 6x | 7x | 8x [ 9% [10x[11x]12x ; i
000 000 000 016 000 OO0 OO0 000 OO0 000 000 001 Basic Settings
for CV29 (Item

v
0

1 | 047 000 255 000 00O 00O OO0 OOO OO0 OO0 000 000
2 |000 001 255 000 OO0 00O OO0 000 ODD 000 OOD Configuration)
3 | 000 000 00O 001 000 00O OO0 00O 000
4

5

6

7

8

9

- \

000
000 000
000 000 000 00O
000 000 000 000 00O
G00 000 000 000 000 000 000
000 00O | 00O 00O 00O 00O 020 000
000 000 000 o0oo ooo ooo ooo [N

000 000 000 002 000 000 000 OO0 OO
000 000 000 004 000 0OO 000
000 000 000 003 000 000
000

035 194 000
011 035 000
000 000 054

016

In the example above, the Basic Operation Configuration has been changed to use
the Locomotive’s Extended Address with the existing control precision of 28 Speed
Steps (the latter is selected automatically), to enable conversion to Non-DCC Power
(automatic operation on DC selected by default), and to enable use of the 28-Step
Speed Table, which will be described later in Section 6.1 —
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A-Track automatically translates these selected settings to a value of 54 which is
entered in CV29 (Configuration Data), together with a value of 1 in CV12 (Power
Source Conversion), as shown above.

Click Update Item to copy the new Item’s edited parameters to the Item List —

New Item Primary and
New Item Extended Addresses New Item Current Speed

Description (Extended Active - >’) and Function States
O > -PIC BeCE TUST 0201 L0751 E—
D& McGilligan Lumi 1 - NCE Switch-It Accessy _F- 053 >0212 00
D& McGilligan Lumberwy - NCE Switch-It Mk2 Access'y _P_ »>0221 02,
14 Colorado Southemn 2-6-0 Mogul - Z145R Loco _EP_ 047 >0547 28 Fooo _
4% Item List : C:\Users\User\Documents\a-T memo'dhtolﬁutm«logullitld@ Items : 28 Curre:‘hS NCE @ [B)cOM @
New Item Item List Changed New ltem
Type & Flags Indicator - ‘@’ Speed Steps

The format of the Details View shown above is fairly self-explanatory. Note that either
the Primary or Extended Address is displayed with a ‘=’ symbol in front of whichever
Address has been selected as active, ie. the one which will be used to control the Item.

When this Locomotive Item is under control from the PC screen, as will be shown in
Section 6.9, its current speed, direction, and function settings will be displayed in the
righthand columns of the Details View. These details will also be shown when an Item
is allocated to an NCE Cab through an NCE Command Station, when the current Cab
allocation and status will be automatically updated (See Section 6.8).

As mentioned before, while A-Track will run quite happily as a background monitor of
system operation when connected to your NCE Power Pro System, there is no
requirement to run it continuously, leaving you free to start A-Track only at those
times you wish to make use of its facilities.

Note also the ‘@’ symbol now shown after the Item List filename on the status bar, to
indicate that the Item List has been changed. This is a prompt to remind you that,
after checking that you now have a new Locomotive Item in the Item List, you should
save the changed Item List to the PC’s hard disk to preserve your work.

To complete the set-up of your new Locomotive Item, you can again double-click on its
entry in the Item List to re-open the Edit CVs window. Here you will be able to check
the settings of all relevant CV values against the manufacturer’'s recommendations in
the first instance, before progressively ‘tuning’ the parameters to give the desired
performance.

As always, after making changes to the parameters of any Item, you should save the
changed Item List to the PC’s hard disk to preserve your work, as described previously
in Section 1.1. Ensure, of course, that you do not overwrite and destroy the copy of
the original values that you read from the locomotive decoder, and saved, when
creating the Item — that is your ‘safety net’ if your ‘tuning’ and ‘adjustments’ go badly
awry, allowing you to start over.
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5.4 Editing CV Values Directly

All of the CVs specified as having unique functions in the NMRA DCC Standards and
Recommended Practices can be accessed, and their values edited, using the fields
incorporated in the set of Parameter Tabs. However, many of the remaining CVs, which
have not been allocated specific functions by the NMRA, are used by each individual
decoder manufacturer to define their own proprietary parameters and functions.

You can edit any of the CVs in the CV Value Grid, including these NMRA- and
manufacturer-specific CVs, by right-clicking on the relevant cell in the CV Value Grid
to bring up the Configuration Variable Value page in the Parameter Tabs area of the
window as shown in the example below.

This page shows the number of the selected CV with its Description (as also shown on
the pop-up label next to the CV location), and its current value listed in decimal,
hexadecimal and binary (bits). To change the value of the CV simply click in either of
the Dec or Hex textboxes and type in a new value. The value shown in the other
(unclicked) textbox is updated automatically to match the entered number —

ltem #6 - Addr 2011 - Configuration Variables

Item Description |D&F|GW 2-Truck Shay - DN142

IdenlityT Config T SpeedT Funct'nT Pages T SUSI

Read/Very Cvs Configuration ¥Yariable ¥alue
Copy All Cv'e E‘J[!ZB .
Configuration D'ata

Dec 054 Hex |36
Value 76543210

Bits T WM Wiw

ak. Cahicel

Ox | 1x | 2% [ 3x | 4x [ 5x [ 6x | 7x | 8x | 9x [10x]|11x]12x

000 | 000 000 000 000 000 04 | 180 | 240 000 000 000
011 000 000 000 000 000 OO0 | 072 | 188 244 | 000 000 00O
000 001 000 000 000 000 OO0 | 092 | 196 248 | 000 000 000
000 000 000 000 000 000 OO0 | 106 | 204 | 262 | 000 000 00O
000 000 000 000 000 000 128 | 112|210 255 000 000 000
000 000 000 000 000 128 OC1 | 130 216 | 000 000 000 OS54
000 000 000 000 000 048 000 | 142 | 222 | 000 000 000 032
250 139 000 000 000 000 O | 152 | 228 000 000 000 000
129 219 000 000 000 000 032 | 162 | 232 000 000 000 00O
000 000 054 000 000 oo | 048 172 236 000 ooo | ooo [

|

bg”
|C‘u’-029 Configuration Datal

Cloze |

w oo |~ |m|o | ||| =]

Decimal numbers are entered using the normal digits O to 9, while hexadecimal
numbers use the letters A to F in addition to digits O to 9 — you can type the letters in
either lower- or upper-case (small letters or capitals).

Alternatively, you can click on one or more of the Bits checkboxes to set or clear each
individual bit of the byte representing the value of the CV. A tick in a checkbox
represents a set bit (value 1), and an unticked checkbox represents a cleared bit
(value 0). Again, the values in the Dec and Hex textboxes will be automatically
updated to reflect the new value of the CV as each bit is changed.

Chapter 5 Page 88 of 538 Version 4.4.34



A-Track Reference Manual

Once the required CV value has been set, click OK to transfer the new value to the
selected location in the CV Value Grid — or click Cancel to discard the entered value
and leave the existing CV value unchanged.

Important Note : A-Track does not perform any checks that the value entered
into the selected CV is valid, or an allowed value, for the parameter to which that
CV is allocated. You must ensure that the value entered is within the limits defined
by either the NMRA DCC Standards and Recommended Practices or the decoder
manufacturer for the selected Configuration Variable.

You can use this facility as a simple converter to view any decimal, hexadecimal, or
binary number in both of its other forms, although the range of numbers it can handle
is restricted to O to 255 decimal (00 to FF hexadecimal, or 00000000 to 11111111
binary).
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A-Track Reference Manual

For Locomotive Items, click on the Speed Parameter Tab to access the set of Item
parameters associated with the locomotive’s Speed characteristics. This Tab is not
enabled for Consists or Accessories.

[tem #6 - Addr 2011 - Configuration Variables

y  Item Description |D&HGW 2-Truck Shay - DN142

Proaran Cv's |

ReadMerify e

IdentilyT Config T Speed TFunct'nT PagesT Susl

Step Precision Adjustment Parameters

" 14 Steps Acceleration R ate ]

Copy All Cy's e
y (* 28 5teps Deceleration R ate ]
Paste Main Cvs (™ 128 Steps Acceleration Adjust non

Deceleration ddjust ]
Select Table / Mid Step (000

Define Tables

Paste Exten'd C¥s

g Simple 3-5tep Kick Start 0o
g Famsard Trim oo
Full 28-5tep Feverse Trim 000

Cloze |

Ox | 1x | 22 [ 3x | 4x [ 5x [ 6x | 7x | 8x | 9x [10x][11x]12x

000 | 000 | 000 000 000 000 064 | 180 | 240 000 000 000
011 | 000 | 000 000 000 000 OO0 | 072 | 188 244 | 000 000 00O
000 | 001 | 000 000 000 000 OO0 | 092 | 196 248 | 000 000 000
000 | 000 | 000 000 000 000 OO0 | 106 | 204 | 252 | 000 000 000
000 | 000 | 000 000 000 000 128 | 118 | 210 255 000 000 000
000 | 000 | 000 000 000 128 001 | 130 216 | 000 000 000 OS54
000 | 000 | 000 000 000 048 OO0 | 142 | 222 | 000 000 000 032
250|199 | 000 000 000 000 O16 | 152 | 228 | 000 000 000 000
129| 219 000 000 000 000 032 | 162 | 232 | 000 000 000 000
000 oo0 054 000 o000 oo o48 172 236 000 ooo ooo [

wmﬂmmhwm—ﬁcg

Set the Step Precision you wish to use to control the locomotive — 14, 28, or 128
speed steps — but check the manufacturer’s documentation to ensure that your
selection is supported by the fitted decoder. The 14-Step option is really provided only
for compatibility with very old decoders, and all modern decoders will normally operate
under 28- or 128-Step control.

Note that the choice of 14 or 28 speed steps is reflected in the Configuration Basic
Operation setting held in CV29 (Bitl). Choosing 128 speed steps does not affect any
CV values directly — it only determines the type of speed command which will be
generated by A-Track when using the Item Operate option, and sent to the locomotive.
Selection between 28- or 128-Step commands when using an NCE Handheld Cab for
Item control is made by pressing the 28/128 button on the Cab.

The Adjustment Parameters deal with the locomotive’s momentum, ie. how it
behaves when starting and stopping. If you are unsure of the most appropriate values
to use, then you should refer to the manufacturer’s recommendations. Simply click in
the textbox relating to a selected Adjustment Parameter, type in the recommended
value, and press the Enter/Return or Tab () key. The value will be transferred to
the corresponding CV, where it will be displayed, and highlighted (in pink), in the CV
Value Grid.
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A-Track allows you to set up the two Speed Tables defined in the NMRA DCC
standards, a simple 3-Step Table and a more comprehensive 28-Step Table. These
tables are used to set the response of the locomotive to the speed commands from the
Controller (Cab), in order to give an appropriate locomotive top speed, together with
accurate control at low and/or high speed.

The Full 28-Step Speed Table is only effective when the ‘Use Speed Table’ option is
selected (ticked) in the Basic Operation section on the Config Tab page. The 3-Step
Speed Table is used in all other circumstances.

Clicking on the Simple 3-Step button shows you, graphically, the current table
values, referred to as VStart, VMid, and VHigh, together with some control buttons on
the left, as shown below. The vertical axis represents the relative speed corresponding
to each step — 000 is stationary and 255 represents maximum (100%) speed (full
track voltage applied to the locomotive motor) —

[tem #6 - Addr 2011 - Configuration Variables

Item Deszcription |D&HGW 2-Truck Shay - DN142

Kick Start )|
Forward Trim o0
Full 28-Step Rewerse Trim oo

Cloze |

Speed Table - Simple 3-5tep

Proaran Cv's | IdentilyT Config T Speed TFunct'nT PagesT Susl
ReadMerify e Step Precision Adjustment Parameters
" 14 Steps Acceleration R ate ]
Copy &l Cis .

Ry (* 28 5teps Deceleration Rate nnn
Paste Main Cvs ™ 128 Steps Acceleration Adjust non
Paste Exten'd Cvs Define Tables Deceleration Adjust ono
| Select Table / Mid Step (000

255
Copy / Paste Walues -

¥ |#
Eli|

20 ||| S Set Default ¥alues for - ' ' '

1 VStat WMid, and VHigh 127 ----m-ooomtooooooaeo-
0qg # - ' ' '
Save Table Transfer Set Values to Cis

00 —6——6—¢—
=== V5tart ¥Mid “High

0

Cancel Guit - Ma Change to Cvs

Although you can use the Linear, Log, and Exp buttons on the left to set values for
the 3-Step Table, they are more commonly used to assist in setting up the 28-Step
Table, and their actions will be described in detail later in this section.

Clicking the Zero button, as is fairly obvious, will set all of the VStart, VMid, and VHigh
values to their default state of zero (000), as shown above, where they will have no
effect on the speed characteristics of the decoder (and the Locomotive).

The normal way of setting the 3-Step Table, is simply to click within one of the three
white columns on the graph, near to the desired value for VStart, VMid, or VHigh.
When you press down on the left mouse button, the relevant red marker will change
colour to green then, when you release the mouse button, the marker will move to the
position of the mouse cursor.
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The markers are constrained to move only vertically, and to stay within the limits of
the vertical scale, so you can click anywhere within the relevant white column. When
the mouse button is released, the current value of the associated table entry will be

shown in the yellow textbox located next to the bottom left corner of the graphical
area —

Item #6 - Addr 2011 - Configuration Variables

Item Description |D&RGW 2-Truck Shay - DN142

Program C's | ;Idenlily]’ Config] Speed ] Funcl'nT Page:] SuUsl

ReadMerify C¥/s I Step Precision Adjustment Parameters

" 14 Steps Acceleration Rate 000
Copy All CV! L. .
LI & 28Steps Deceleration Rate 000
Paste Main CVs I " 128 Steps Acceleration Adjust 000
000

Paste Exter'd CVs I Define Tables Deceleration &djust

Select Table / Mid Step

4\, Simple 3-Step Kick Start
| Updateltem | Full 28-Step

Close |
Speed Table - Simple 3-Step

255
(e Copy / Paste Values o

Zoto || | Linexr Set Default Values for & ' ! ' Selected table
L VStart, VMid, andVHigh 127 === =------ fim g entry set to
og Exp . : H :

required value
Save Table Transfer Set Values to CV's - . !
— A 000 : ;
ancel Quit - No Change to CVs 206 “Vstat  VMid  VHigh

|D
D|
=]

[=]
=1
=

|

Forward Trim
Reverse Trim

[=]
(=]
(=]

i

[=]
(=]
(=]

Once you have clicked in the graph area to set any Speed Table marker to an
approximate value (so the marker is green), the Speed Table value can then be
incremented or decremented by 1 unit at a time by rolling the mousewheel or using
the Up and Down Arrow keys.

The Page Up and Page Down keys will respectively increment or decrement a
selected Speed Table value by 16 units at a time, as will the mousewheel if either
Shift (©) key is held down at the same time.

If you set the value of any Speed Table value incorrectly, then a press of the Esc
(Escape) key, while the marker is green, will return it to the value currently held in
the relevant CV (ie. return it to the value shown when you first displayed the Speed
Table).

Once you are happy with all three values, click Save Table to transfer the values to
the corresponding CVs — or click Cancel to discard any changes, and quit this
particular operation. If you elect to Save the values, then any changes made are
reflected in the appropriate CV values in the grid, and highlighted in pink.

As you can see in the example below, the value of VStart (13) is stored in CV02, VMid
(82) in CVO06, and lastly VHigh (206) in CVO5 —
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Item Description |D&RGW 2-Truck Shay - DN142

Program CVs |

Read/Verify CVs
Copy All CVs
Update Item

Close |

- Step Precision
" 14 Steps
(¢ 28 Steps
" 128 Steps

Define Tables

Simple 3-Step

Full 28-Step |

IdentitpT CunﬁgT Speed] Funct'nT Page:T Susi

Adjustment Parameters

Acceleration Rate 000
Deceleration Rate 000
Acceleration Adjust 000
Deceleration Adjust 000
Select Table / Mid Step |DDD
Kick Start 00
Forward Trim 000
Reverse Trim 000

Ox | 1x | 2x | 3x | 4x | 5x | 6x | 7x | 8x | 9x [10x]11x] 12x]

00O 00O OO0 00O 0OO OOD D064 180 2
011 000 0OD 00O

A-Track Reference Manual

Set Table points
transferred to

000

©|o|~|o|n|afw|n]=o|Q
Q
L=
Q

013 00T Uo0 000 000 000 000
000 00D 000 000 000
000

128
00D 000 128 OO1

082 000 00O 00O 000 048 000
250 199 000 00O 00D 000 016
123 213 000 000 000 000 032
000 000 054 000 0OD 00O D043

09 000
262 000 000 | oo
118 210 255 000 000 000
130 216 000 000 00O 022
142 222 000 000 00O 032
152 228 000 000 000 000
162 232 000 000 00O 000

CV Values grid

172 236 000 ooo ooo [

Alternatively, clicking on the Full 28-Step button will reveal a similar graphical area
showing the currently-held, user-defined Speed Table values (if any) as a speed
curve, such as that shown below —

[tem #6 - Addr 2011 - Configuration Variables

Item Description |D&F|G\A-" 2-Truck Shay - DW142

Program Ch's | Identit_l,lT CunﬁgT SpeedTFunct'nT PagesT Susl
Read/verify CVs | —Step Precision — ~ Adjustment Parameters ——
14 Steps Acceleration Fate 000
Copy All CV: e
LI e 28 Steps Deceleration Rate 000
Paste Main Oz | 128 Steps Acceleration Adjust i}
Paste Exter'd Cs | “Define Tables — Deceleration Adjust 0aa
Select Table / Mid Step II:II:II:I
Faszte Index'd C'= | Simple 3-Step | Kick Start W
Update Item | Farward Trirm 0aa
Rewerze Trim 0aa
Cloze |
— Speed Table - Full 28-S5tep
W PPy S
E Coro L Al
El A A Y 1% "’ P
35t Lineafl A N O T R R
VRS N O O SO0 % N N
Log | Exp SO 4 (T S S A A
: ¢. [
Save Table | . *’ T
@ 0 aaa
E | DDD 1 1 1 1 1 1 1 1 1 1 1 1 1 1
4|a”°e === 02 04 06 03 10 12 14 16 18 20 22 24 26 28
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The horizontal axis represents Speed Steps (the commanded speed from the
controller) and the vertical axis represents the relative speed corresponding to each
Step — 000 is stationary and 255 is maximum (100%) speed.

Rather than set up a Speed Table from scratch in a new Locomotive Item, if you have
one already defined for a similar locomotive, then you can first display that
locomotive’s Speed Table as above, in its own Edit CVs window, and click on the small
Copy button (Bz) to the left of the graphical area. Next, open up the Edit CVs window
for the new Locomotive Item, click on the Speed Tab and select Full 28-Step to reveal
a blank Speed Table (or at least one you are about to replace). Click on the small
Paste button (E2) to insert the copied Speed Table into the new Item, where you can
make any adjustments as described later in this Section.

If you do not have an existing 28-Step Speed Table to copy, but have already set up
the simple 3-Step Speed Table, then you can use the entered 3-Step values to
generate a basic 28-Step version by clicking the small 3-St button —

[tem #6 - Addr 2011 - Configuration Variables

Item Description |D&F|GW' 2-Truck Shay - DW142

Program Ch's | Identit_l,lT Config T Speed TFunct'nT PagesT Susl

Read/verify CVs Step Precision Adjustment Parameters

™ 14 Steps Acceleration R ate ]

Copy &l Cis —
Ry (* 28 5teps Deceleration Rate nnn
Paste Main Cv's " 128 Steps Acceleration Adjust oo
Paste Exter'd Cs Define Tables Deceleration Adjust non
Select Table / Mid Step {000
Simple 3-5tep Kick Start oo
Update Item Farward Trirm Ui}

Full 28-Step Fieverse Trim 000

Cloze |
Speed Table - Full 28-Step

i 255 —————
=] -
Juw] 110 T
IPT IR U SO NN SRR S P . G SO
Log | Exp e
Save Table i ‘,." . :
“oe®®TT 0 o 0
o pop———— -+
anee === (7 04 0 08 10 12 14 16 18 20 22 24 26 28

A-Track simply copies the values of VStart, VMid, and VHigh to Speed Steps 1, 14, and
28, and adjusts the values of the intervening speed steps to lie on straight lines
between them.

An even simpler Speed Table is generated by clicking Linear, which produces a
straight-line speed ‘curve’ between the current values of Speed Steps 1 and 28, either
taken from the 3-Step Table as above, or by clicking in the relevant column for Speed
Steps 1 and 28, and setting them to the values you require using the mousewheel
with Shift (f+), or the Page Up, Page Down keys, and the Up and Down Arrow
keys, or the mousewheel on its own, for fine adjustment — the marker you have
selected will change colour to green, and its actual Speed Step value will be shown in
the yellow textbox at the bottom lefthand corner of the graph —
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Item Description |D&F|GW' 2-Truck Shay - DW142

Frogram Ci's

Identit_l,lT Conlig T Speed TFunct'nT PagesT Susl

ReadMernfy Cvs
Coopy Al Cyg
Paste Main Cv's
Paste Exten'd CVs

Update [term

Cloze

HLALE

Step Precision Adjustment Parameters

™ 14 Steps Acceleration R ate ]
(* 28 5teps Deceleration R ate ]
(™ 128 Steps Acceleration Adjust i}
Define Tables Deceleration ddjust ]

Select Table / Mid Step (000

Simple 35t8p | | | ek Start 001

Forward Trim non
Full 28-Step Rewerse Trim non

Speed Table - Full 28-Step

PE——— L L
S EEEEREERERT L o
127 bbb L ge @RI
~ B :.¢o¢': oo
oo a@®®T 0
- lee®®T L Lo
o® I

oog —
810 12 14 16 18 20 22 24 25 28
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Two other options are offered to generate speed curves between the current values of
Speed Steps 1 and 28. Firstly, clicking Log generates a logarithmic curve as shown
below -

[tem #6 - Addr 2011 - Configuration Variables

Item Description |D&F|GW' 2-Truck Shay - DW142

Frogram Ci's

Identit_l,lT Conlig T Speed TFunct'nT PagesT Susl

Paszte Main Cvs
Paste Exten'd C¥s

Update [term

Cloze

il

ReadMernfy Cvs
Coopy Al Cyg

Step Precision Adjustment Parameters

™ 14 Steps Acceleration R ate ]
(* 28 5teps Deceleration R ate ]
(™ 128 Steps Acceleration Adjust i}
Define Tables Deceleration ddjust ]

Select Table / Mid Step (000

Simple 3-5tep Kick Start LU

Forward Trim non
Full 28-Step Rewerse Trim non

35t Linear

Exp

Save Table

Cancel

i

Speed Table - Full 28-Step

) 285

Y R - R
L
- SR
@
@
@
Y R A SR
@
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- and clicking Exp generates an exponential speed curve — the inverse of the
logarithmic curve -

[tem #6 - Addr 2011 - Configuration Variables

Item Description |D&F|GW' 2-Truck Shay - DW142

Program Ch's | Identit_l,lT Config T Speed TFunct'nT PagesT Susl
Read/verify CVs Step Precision Adjustment Parameters
™ 14 Steps Acceleration Fate aoo
Copy &)l Oz Ao
R (* 28 Steps Deceleration Fate oo
Paste Main Oz ™ 128 Steps Acceleration Adjust i}

e Define Tables Deceleration Adjust aon
Select Table / Mid Step (000

St -3ty Kick Start oo
Farward Trim L]
Hlete e Full 28-Step Fieverse Trim 000
Cloze |
Speed Table - Full 28-Step

HLA0

3 255 : P
@2 - : P
- ' i @
: N
35t Linear . : : : : : : : : : : : :’? H
R R YRy ST N S S T DU RN, S
Lag P g®T
. ' S
R o $,¢¢0‘? !
ave | able - 1 1 1 = 1 i i
cbesesededddT L L
Eancel DDD ] ] ] ] ] ] ] ] ] ] ] ] ] ]
Q === 02 04 05 02 10 12 14 16 18 20 22 24 26 28

For both logarithmic and exponential speed curves, the ‘steepness’ of the curve is set
by making small adjustments to the value of Speed Step 1. Once you have clicked on
the marker for Speed Step 1 to select it (changing its colour to green), you can use
the mousewheel, or the Up and Down Arrow keys, provide the required precise
adjustment.

Any of the preset speed curves can also be scaled to a maximum desired speed. Click
in the column for Speed Step 28 near to the desired maximum speed value, or click on
the marker itself, then use the mousewheel with or without a Shift key, or the relevant
Arrow/Page keys, to set the required Speed Step value, as shown below.

As an alternative to using the preset speed curves, you can also adjust any or all of the
Speed Step values individually, to produce a speed curve of any desired shape. Press
down on the left mouse button in the column above or below a selected Step, so that
the relevant red marker changes colour to green then, when you release the mouse
button, the marker will move to the position of the mouse cursor.

As before, fine adjustments to the Speed Step value can be made using the
mousewheel (plus Shift), the Up and Down Arrow keys, or the Page Up and Page
Down keys, with the current value of the adjusted Speed Step displayed in the yellow
textbox —
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ltem #6 - Addr 2011 - Configuration Variables

Item Description |D&RGW 2-Truck Shay - DN142

Program C¥'s | IdentilyT Config T Speed ] Funcl'nT Pages] SusI
ReadMVerify CVs I Step Precision - Adjustment Parameters
" 14 Steps Acceleration Rate 000
Copy All CV! I L. -
opy 3 (+ 28 Steps Deceleration Rate 000
Paste Main CVs | " 128 Steps Acceleration Adjust 000
- - Deceleration Adjust 000
Paste Exten'd CVs | Define Tables
Select Table / Mid Step |000
Paste Inderd OVs Skiple 580 I Kick Start 001 _
Forward Trim 000
Update Item L.
94, Full 28-Step | Reveres Tiic 000
Close | -
~Speed Table - Full 28-Step
255 —
@& ‘I
3ot | Linea| . i Speed Step 28
127--4 moved to new
Log E_””l g maximum
| R speed value

000
Eacs 180 02 04 06 08 10 12 14 16 18 20 22 24 26 28

After assigning a new value to either Speed Step 1 or to Speed Step 28 (or to both),
click on any one of the Linear, Log, or Exp buttons to set an appropriate type of
speed curve. The example below shows a logarithmic curve —

[tem #6 - Addr 2011 - Configuration Variables

Item Deszcription |D&HGW 2-Truck Shay - DN142

Proaran Ci's | IdentilyT [ZnnligT SpeedTFunct'n PagesT Susl

ReadMerify e | — Step Precision ——  Adjustment Parameters ——
i~ 14 Steps Acceleration R ate ]
Copy All CY: =
o il % 28 Steps

Deceleration Rate non
Paste Main Cis 128 Steps Acceleration Adjust 0on

Paste Exter'd Cifs | “Define Tables — Deceleration ddjust ol

Select Table / Mid Step (000

Faste Index'd Cv's Simple 3-Step | Kick Start F
Forward Trim non
ottt Full 28-Step | Rewerse Trim non
Cloze |

— Speed Table - Full 28-5tep

e =

- S
&

- S
&
D S

L el oo
Save Table | ) ;o? A
o L b b

— Do ®——
4|a”°e === 02 04 06 03 10 12 14 16 18 20 22 24 26 28
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Note that, once you have selected any Speed Step marker by clicking on it (shown by
its colour changing from red to green), you can move to select the adjacent marker
on either side by pressing the Left or Right Arrow keys.

Also, if you decide that a newly-set Speed Step value is incorrect, pressing the Esc
(Escape) key while the relevant marker is selected (green) will return that Speed Step
to the value currently held in the relevant CV (ie. return it to the value shown when
you first displayed the Speed Table).

If you are completely dissatisfied with your adjustments, simply click on Cancel at any
time to discard all changes and retain the original Speed Table settings. Click on the
Full 28-Step button once again to display the speed curve for another attempt.

Finally, when you are happy with the shape of the speed curve, click on Save Table to
transfer the parameters of the newly-defined speed curve to the Speed Table CVs
(CVv67 to CV94) in the CV Value Grid, where any changed values will be highlighted in
pink —

[tem #6 - Addr 2011 - Configuration Variables

Item Deszcription |D&HGW 2-Truck Shay - DN142

Proaran Ci's | IdentilyT Config T Speed TFunct'nT PagesT Susl

ReadMerify e Step Precision Adjustment Parameters
™ 14 Steps Acceleration Fate aoo
Copy &)l Oz Ao
y (* 28 Steps Deceleration Rate aoo
™ 128 Stepz Acceleration Adjust aoo
Deceleration Adjust aon

Select Table / Mid Step (000

Simple: 3-Step Kick Start 0m

Define Tables

[ PaseanVs |
| PossutdUl
[Pese Indevdovs |
T

Farward Trirm [T
Update It e
e Full 28-Step Rewerse Trim non
Cloze |
Ox | 1x | 22 [ 3x | 4x [ 5x [ 6x | 7x | 8x | 9x [10x]|11x]12x

000 000 000 000 000 000 053 7140 173 000 | 000 | 000
011 | 000 000 000 000 000 000 070 14% 175 000 | 000 | 000
3 001 000 000 000 000 000 081 143 177 000 | 000 | 000
000 000 000 000 000 000 000 031 153 178 000 | 000 | 000
000 000 000 000 000 000 123 100 157 180 000 | 000 | 000
206 000 000 000 000 123 001 108 7160 000 | 000 | 000 | 022
032 000 000 000 000 043 000 116 163 000 | 000 | 000 | 032
250 193 000 000 000 000 016 123 166 000 | 000 | 000 | 000
129 219 000 000 000 000 031 123 1683 000 | 000 | 000 | 000
000 000 0%4 ) 000 000 000 046 13% 171 000 | 000 | 000 !

mmﬂmm-ﬂ-wm—hcg

Click Update Item to save all changes to the Item List, then save the updated Item
List as usual. Do not forget, however, that you will need to program the newly-
changed CV values into the physical decoder before they will have any effect on the
operation of the relevant Locomotive (see Section 6.7).
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6.2 Functions and Function Mapping

For Locomotive Items, click on the Funct’n Parameter Tab to access the set of ltem
parameters associated with Functions. This Tab is not enabled for Consists or
Accessories.

[tem #6 - Addr 2011 - Configuration Variables

Item Deszcription |D&HGW 2-Truck Shay - DN142

Proaran Cv's | IdentilyT Config T Speed TFunct'n Pages | SUSI

Fiead/Verify Ciis Enable in Alternate Power Mode
FLF FLR F1F2F3F4 FSFEFYFE F9 FIOF11F12
Copy &l Cis -~ e Crre 0 rr
Paste Main Cvs Active under Consist Address
FLF FLR F1F2F3F4 FEFEFFFE F9 FIOF11F12

PasteExendCvs| || T O OO CEET
Function / Dutput Mapping

Fhn@e¢ OO O Coor

LFLR 1 2 2 4 &5 & 78 3101112

| ORI o rrrr

Cloze

Ox | 1x | 22 [ 3x | 4x [ 5x [ 6x | 7x | 8x | 9x [10x][11x]12x

000 | 000 | 000 000 000 000 064 | 180 | 240 000 000 000
011 | 000 | 000 000 000 000 OO0 | 072 | 188 244 | 000 000 00O
000 | 001 | 000 000 000 000 OO0 | 092 | 196 248 | 000 000 000
000 | 000 | 000 000 000 000 OO0 | 106 | 204 | 252 | 000 000 000
000 | 000 | 000 000 000 000 128 | 118 | 210 255 000 000 000
000 | 000 | 000 000 000 128 001 | 130 216 | 000 000 000 OS54
000 | 000 | 000 000 000 048 OO0 | 142 | 222 | 000 000 000 032
250|199 | 000 000 000 000 O16 | 152 | 228 | 000 000 000 000
129| 219 000 000 000 000 032 | 162 | 232 | 000 000 000 000
000 oo0 054 000 o000 oo o48 172 236 000 ooo ooo [

wmﬂmmhwm—ﬁcg

In the first two sections (Enable in Alternate Power Mode and Active under
Consist Address), click on as many, or as few, of the checkboxes as you wish to
enable a specific Function as active when operating the Locomotive Item in either
Alternate Power Mode or as part of a Consist. An enabled Function is indicated by a tick
in the relevant checkbox. Click on an enabled checkbox to remove the tick mark and
disable that Function in the respective mode(s).

When not operating in either Alternate Power Mode, or as part of a Consist, any
settings in these Function Parameter Tab sections are ignored.

The third, bottom section (Function /7 Output Mapping) allows you to specify which
Function Outputs will react to a specified Function command, particularly where you
wish to make the Function Output different from that which would normally be
activated by a specific Function command. Where no selection is made, each Function
simply activates its normal, corresponding Function Output.

For example, suppose you wish to swap Functions F1 and F2. First, click to select
Function F1 on the top row then click the checkbox on the bottom row corresponding
to Output F2 —

Function / Output Mapping

Fn OO OO COCC COCo

Update [tem LFLR 1 2 2 4 5 B 78 39101112

o | orrCrC MO e rrrr
[k ]
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Next, click to select Function F2 on the top row followed by the checkbox for Output F1
on the bottom row —

Function / Output Mapping

Fn &8 CECOC CCCC OO

UIpdate [tem LFLR 1 2 34 56 73 3101112

| UP I MOCEC CECE CEEE

Cloge

Finally, to enhance the example, suppose we wish to activate both Outputs F4 and F6
when Function F4 is invoked. Click to select Function F4 on the top row, and then
select both checkboxes on the bottom row for Outputs F4 and F6 -

Function / Output Mapping

Fn ¢ CCCH CCCC COCCC

Update ltem LFLR 1 2 3 4 &5 6 78 93101112

| P VY CFECC CCCT

Cloze

Ox | 1% | 20 [ 3| 4x [ 5x | Bx | 7x | 82 | 9x [10x]|11x]12x

000 000 | 000 | 000 | 000 000 | 064 | 180 240 000 000 | 000
011 000 000 000 | 000 000 000 | 078 | 188 | 244 000 000 | 000
000 001 000 000 | 000 000 000 092 | 196 248 000 000 | 00D
000 | 000 000 | 000 | 000 000 000 105 | 204 252 000 000 | 00D
000 | 000 000 000 | 000 000 128 112 210 255 000 000 | 00D
000 000 000 002 000 128 001 | 120 216 000 000 000 | 0S54
000 000 000 004 000 042 000 142 | 222 000 000 000 | 032
250 193 000 000 | 000 000 016 | 152 | 228 000 000 000 | 00D
129 219 000 020 000 000 032 162 | 232 000 000 000 | 00D
000 | 000 054 000 | 000 000 048 172 236 | 000 ooo | ooo [

mmﬂmm-ﬂ-mm-ﬂcg

The CVs changed by the set of three Function mappings can be seen in the CV Value
Grid. Note also that A-Track ensures that you can only specify valid Function mappings
by ‘greying-out’ those OP checkboxes which are disallowed for a selected Fn button.

However, be aware that not all manufacturers implement Function / Output Mapping
exactly in accordance with the NMRA Recommended Practice, and they may utilise CV
33 to CVv46 differently in order to support their own mapping scheme(s).

In such a case you will find that using the standard scheme outlined above does not
produce the desired result from your decoder when you press particular Function
buttons on the NCE Cab. You will then need to refer to the manufacturer’s user
documentation for that particular decoder, work out the values to be loaded to each
mapping CV, and then program the values directly into the CVs using the facility
described previously in Section 5.4.
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6.3 Accessing Further CV Pages - Sound and Complex Functions

For Locomotive Items, click on the Pages Parameter Tab to access the additional
pages of CVs associated with decoders which provide Sound and Complex Function
features. This Tab is not enabled for Consists or Accessories.

An additional panel opens, extending the normal Edit CVs window to the right, as
shown below —

Itern #6 - Addr 2011 - Configuration Variables

Basic T Config T Sound ]

Item Description |D&F|GW' 2-Truck Shay - DN142

Acceleration Adjustment -
Frogram CWs Identity | Config | Speed | Funct'n| P Susl Acceleration Rate
2 | PT 9 T - T T ages T— Alternate Mode Function Status F1-F3

Read/Verify Cvs Decoder Manufacturer Alternate Mode Function Status FL, F3-F12
Bi-Directional Communication Canfiguration

Copy &ll CV's B Wi (NI @ r Configuration D ata
oy Consisgt ddress

Specific M anufacturer Select fram list below -
Pazte Main Oz — Consist Address Active for F1-F8
| Digitra: Inc =] Consist Address Active for FL, F9-F12
Paste Exten'd CV's Deceleration Adjustment
View CV Block | ~Access C¥ Page Deceleration Rate
Bae & ~ Decoder Access Unlock
Lo (001-128) & Decoder Automatic Stopping Configuration
. ~ & e Decader Lack ID Code
Hi [123.25€] o o EMF Feedback Cutaut
Cloze | Extended Address LS 8 Bits

Extended Addresz MS 6 Bits
Ox | 12 [ 2x | 3x [ 4x | 65 [ 6x | 7x | Bx [ 9% [10x[11x[12x] | |Forward Trim )
000 | 000 000 000 000 000 0G4 180 240 000 000 000 | | |Indexed Page Address High Bute

011 000 000 | 000 00O | 00O | OO0 O76| 185 | 244 000 00O 00O :{}gﬁ”;g{'?agemdrem°wayte

000 001 000 000 000 000 000 032 136 248 000 000 000 | | |Qytput Contol for Function FOT
000 000 000 000 000 000 000 105 204 252 000 000 000 || |Output Cantiol for Function FOZ
000 000 000 000 000 000 128 118 210 255 000 000 000 | | |Cutput Control for Function FO3
000 000 000 000 000 128 001 130 216 000 000 000 054 SEEEE:Egg::g”g:mgt:g:;gg
000 000 000 000 00D 048 000 142 222 000 000 000 032 || |Qsput Contol for Function FOR
250 199 000 000 000 000 O16 152 228 000 000 000 000 || |Cutput Contral far Function FOT
129 219 000 000 00D 000 D032 162 232 000 OO0 000 000 | | |Output Control for Function FOS
000 000 054 000 000 000 048 172 236 000 ooo ooo N || Dvteut Contiolfor Function FO3

=

One or more CV Description Tabs will be displayed in the righthand panel, with each
Tab containing a list of CVs, arranged alphabetically, relating to the type of DCC
Decoder selected in the Decoder Manufacturer section of the Pages Parameter Tab.
The Basic CV Description Tab will always be shown, regardless of the decoder type
selected, with a list of all of the CVs defined in the NMRA DCC Standards and
Recommended Practices.

When first accessing the Pages Parameter Tab, as part of the initial setup of a new
Item, as described in Section 5.3, your first action is to select the type of decoder
fitted to the Item, since this will determine the number and content of the CV
Description Tabs which will be displayed.

The simplest case is where the manufacturer of the fitted decoder appears in the list
which can be shown by clicking on the Specific Manufacturer option button, and
then on the down-arrow () at the righthand end of the listbox below the option
button —
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Item Description [D&RGEW 2 Truck Shay - DN142 Basic | Config | Sound |
Acceleration Adjustment -
Pragram CWs Identity | Confi Speed | Funct'n| P Susi Acceleration Rate
2 | PT g T P T T agesT— Alternate Mode Function Status F1-F3
Fead/Verify Cvs Decoder Manufacturer Alternate Mode Function Status FL, F3F12
. Bi-Directional Communication Configuration
Copy All Cv's Bleelte / Wl (RIHIREY) (@ r Configuration D ata
Specific Manufacturer & Select from list below - Caongist Address
Pazte Main Ci's — Consizt ddress Active for F1-F8
|D|g|tra:-: Inc j Consist Address Active for FL, F3-F12
Paste Exten'd Ci/s Easic / Other (MMF& CV Definitions) Deceleration Adiustment
Deceleration Fate
Decaoder Access Unlock
Decoder Automatic Stopping Configuration
Lenz Elektranik Decoder Lock 1D Code
tadel Rectifier Carparation (MAC) EMF Feedback Cutaut
Close MTH Electric Traing - Proto-Sound 3 E”:engeg iggfess If:fISSBBBBIt'tS
__|MCE Carparation rlended Address Itz
Cv | Ox ML_QSISqutions-Quantum Forward Trim _
0 000 | 000 | 0 SoundT ras Indexed Page Address High Byte
1 | o011 ooo oon | gTrain Control Systems (TCS) l}?dEHgtd I;'age.ﬁ.ddress Lows Byte
— Zimo Elektranik. ICK. otar
2 Qoo | oot oo LSy | &y W [ 6 = = gy T o ooo oo 00 Dutput Control for Function FO1
3 | 000 000 000 000 000 000 000 106 204 252 000 000 000 | | | Output Control for Function FOZ
4 | 000|000 000 | OO0 000 | 00O 128 | 118 | 210 255 000 000 | 000 || |Output Contral for Function FO3
5 | 000 000 000 000 00O 128 OO1 130 216 000 000 00O 054 83:33: Fontal for Punction P04
6 | 000 000 000 000 000 048 000 142 222 000 000 000 032 | | |3yt Cantrol for Function FOS
7 (250 199 000 0OO OO0 00O 016 152 228 00O | 000 000 000 || |Owutput Control for Function FO7
8 | 129|219 000 000 000 000 032 162 232 000 000 000 000 || |Output Contral for Function FOS 9
9 | 000 000 054 000 000 000 o048 172 235 000 000 ooo [ | Cuteut Contiolfor Function FO3

In the example above, selecting Digitrax as the decoder manufacturer results in the
addition of Config and Sound CV Description Tabs which will contain lists of all those
CVs used by Digitrax to control specific features provided in their range of decoders.
The Config Tab covers parameters such as lighting effects and the control of
momentum and acceleration, while the Sound Tab (obviously) covers the selection of
specific sound effects and their relative volumes, as shown below —

Basic T Config T Sound ]

Decoder Lock Enable/Disable

Ditch Lights Holdower / Blink Hold Time
Forward Light Effect - Headlight

Function 1 Effect

Function 2 Effect

Function 3 Effect [Fx Only)

Function 3 Effect [F<3]

Function 4 Effect [F Only)

Function 4 Effect [F<3]

Function 5 Effect [F<3]

Function & Effect [F<3]

Function Output Select Logic Lesel / 12%olt
Headlight Larmp / LED Select

Lights F= Keep-dlive Rate

Fiezet Factorm Defaults

Reverse Light Effect - Backup Light
Scaleable Speed Stabilization - BackEMF Intetzity

Basic | Config | Sound ]

Air Comprezzor On Time

air Drier Rate

Auto Coupler Seguence Threshold Walue
Bell Ring Rate / Bell Delay
Bell Selector

Bell Valurne

Comprezzor Fun Rate

Harm  whistle Setup

Harn / Whistle Volumne

Harn Delay Threshald

I aster Violume Control
Mizcellaneous Sounds Yaolume
tute Yolume

MWatch Rate

Motching # Slip Mode

Prime Maver / Chuff Valume
Sound Project Author 1D

x| | |5caleable Speed Stabilization - Dynamic Compensation x| | |5ound Praject [D

0| | |Scaleable Speed Stabilization - Static: Compensation 0| | |Sound Project Yariant 1D

a Torque Compenszation- Switching Speed [F43) 0 Sound Scheme Select
Transponding & Split-Field Maotor Setup Sound Time-Out Walue

0 0 Steam Blowdown /7 Safety Yolurme

i] 0 Steam Chuff / Cam Configuration

0 0| | |5team Gear Ratio Trim

4 4 Time-Scattered Air Effects YWolume

2 2

0 ]

] 1]
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A left-click on the name of any CV in a Description Tab will immediately highlight the
relevant CV in the CV Value grid, and display its value in the Parameter Tab area,
ready for editing if required, as described previously in Section 5.4.

Clicking on ‘Configuration Data’ on the Basic tab, for example, will highlight CV29 in
the CV Grid and show details of its present value (054) as shown below. To display any
another CV Value simply click on its description in the list under the Basic (or any
other) Tab, or click Cancel to return to the normal set of Parameter Tabs —

Itern #6 - Addr 2011 - Configuration Variables

Item Description [D&RGW 2 Truck Shay - DN142 Basic | Config | Sound
Aoceleration Adjustment -
Frogram Cis Idetit Canfi Speed | Functh | P, Susl Acceleration Rate
2 | C :J T - QVT - I;I VTI T agesT— Alternate Mode Function Statuz F1-F8
Read/Veriy Cvs onhgurabonidanabielaiue Alternate Mode Function Status FL, F3-F12
Bi-Directional Communication Configuration

Copy &Il CV's d [_|29 i ‘Confiquration D ata
Configuration D ata Consigt Sddress

Paste kain Cvs Consist Address Active for F1-FB
Consist Address Active for FL, F3-F12

Paste Exten'd CVs Dec |054 Hex |36 Deceleration Adjustment
Value 76543210 Dieceleration Rate
gits T TV MW Decoder Access Unlock

Decoder Automatic Stopping Configuration

Decoder Lock ID Code

oK Cancel EMF Feedback Cutout
Cloze | Extended Address LS 8 Bits
Extended Address M5 B Bits

I

CV [0k | 12| 2¢ | 3x [ 4x | 5% [ 6x | 7x | 8x [ 9% [10x[11x[12x] | |Forward Trim .

0 000 000 000 | OO0 OO0 000 | OB4 | 160 240 000 000 00O :ngﬂegEageiggfﬂsrlghaﬂwe
1 [ 011 000 000 000 000 000 OO0 078 188 244 000 000 000 || |goern o oo yie
2 | 000 0o | 000 000 000 000 000 092 196 248 000 000 000 | | |Qutput Control for Furiction FOT
3 | 000/ 000 000 000 000 000 000 105 204| 252 000 000 000 || |Output Contral for Function FO2
4 | 000 000 OO0 OO0 OO0 OO0 128 118 210 255 000 000 000 | | |Chutput Control for Function FOCH
5 |oo0 000 000 000 000 128 001 130 216 000 000 000 054 | | |Duteut Contol for Function FO4
— Qutput Contral for Function FOS
6 | 000 000 000 000 000 048 D00 142 222 000 000 000 032 || |gyput Control for Funchion FOR
7 | 250 199 000 000 000 000 016 | 152 228 000 000 000 000 | |Qutput Control fer Fumction FO7
8 | 129 219 000 000 000 000 032 | 162 232 000 000 000 000 | |Owtput Cantal for Function FOS y
9 | 000 000 054 000 000 000 048 172 236 000 ooo ooo [ | /Cuteut Contiolfor Function FOS

Note that, for all Decoder Manufacturers, the lists shown in the CV Description Tabs
cover all parameters defined by that manufacturer over their full range of DCC
decoders. Not all parameters will apply to the specific model of decoder fitted to the
locomotive associated with this Item, and you should refer to the relevant
manufacturer’'s documentation to determine which CV values should be set, and the
range of values which are valid for each of these CVs.

A-Track provides specific support for decoders made by Broadway Limited (Paragon 2),
Digitrax Inc, ESU (LokSound), Lenz Elektronik, Model Rectifier Corporation (MRC), MTH
Electric Trains (Proto-Sound 3), NCE Corporation, QSI Solutions (Quantum),
Soundtraxx, Train Control Systems (TCS), and Zimo Elektronik. Selecting a Decoder
Manufacturer (which you would normally do as part of the initialisation of a new Item)
sets the extent of the range of CVs which the Item can use to define all of its
operational parameters.

All decoders which provide sound effects, with the exception of those made by MRC,
use CVs beyond the NMRA basic range of CV0O1 to CV128. As defined in the NMRA
Standards, the wider range of CVs is divided into pages, each containing 256 CV
values, and A-Track further divides each page of CVs into two blocks of 128 CVs each.

Selection of the block to be shown in the CV Value grid is made by clicking the
appropriate option button in the View CV Block section of the Pages Tab, with the Lo
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button showing the lower half of the page, and the Hi button the upper half.
Confirmation of which Block is currently on display is indicated by a number in the top
left corner of the grid, 00O for the low block of the first CV page (see all preceding
pictures), and 128 for the high block, as shown below —

View CV Block | ~Access CV Page Deceleration Rate
Base & (" Decoder dccess Unlock ) ) )
Lo (001-128) Decoder Automatic Stopping Configuration
15 8 Decader Lack [D Code
! o) @ EMF Feedback Cutout
Cloge | Eutended Address LS & Bitz

Extended Addrezs M5 B Bitz

Ox | 1x [ 2% | 3x | 4x | 5x [ 6x | 7x | 8x | 9% [10x[11x[12x] | |Forward Trim ]

000 | 000 OO0 000 000 000 000 000 000 | 000 | 000 | 000 :ngemg Eageiggfesst‘@haﬁ&?e
000 000 OO0 000 D00 OO0 000 000 000 000 000 000 00 | ||/Ri | eds Aeess honese
000 | 000 | 000 000 000 000 00O 000 000 000 000 000 000 | | |Oytmet Contol for Function FO1
000 D00 000 000 000 000[}000 000 000 000 00D 000 000 || |Output Control for Function FO2
000 | 000 | 000{-y_180 Reserved for Manufacturer use! | 000 000 | 000 gutputgontm:;or:::unction:::gi
000 | 000 | 000 T 0007 00U 00 U0 OO0 000000 | 000 000 | 000 DEEES:EEQ:;EIEEIFEQE:E:FDE
000 | 000 000 000 000 000 000 000 000 000 000 000 000 | | |gywt Contol for Function FOB
000 | 000 | 000 000 000 000 000 000 000 000 | 000 | 000 | 000 | | | Qutput Contral for Function FO7
000 | 000 000 | 000 000 000 000 000 OO0 000 000 000 | 000 | | |Output Control for Function FOS

000 D00 D00 D00 000 000 000 000 000 ooo ooo ooo [ | |Ovteut Control for Punction FO3

5

When displaying any of the higher blocks, you can identify the number of any CV by
hovering the mouse cursor over the CV in question, where a descriptive label will be
displayed — as shown above for CV180.

Where the selected Decoder Manufacturer, such as Digitrax or SoundTraxx, does not
use any CV greater than CV256, only the Base Page will be enabled in the Access CV
Page section, as shown above. However, for decoders which use larger numbers of
CVs, the next Extended Page (CV257 to CV512) may also be enabled. A-Track will
again display the contents of the Extended Page in two Blocks, the low block (CV257-
CV384) indicated by having 256 in the top left corner, and the high block (Cv385-
CVv512) with 384.

Two CV Pages, however, are not sufficient to accommodate the most recent generation
of sound decoders from ESU (LokSound), for example, which now employ close on 900
distinct CVs across their full range of products. In this case, the CVs are accessed
using an Indexed Addressing scheme defined by the NMRA. Rather than continue
the upward numering of CVs, each additional page of 256 CVs retains the addresses of
the Extended page (CV257-CV512) but is identified uniquely by an additional Index
value of 1, 2, 3, etc. An Index value of O identifies the “real” Extended Page.

The Page Index is set by loading appropriate values to CV31 and CV32, but this is
taken care of automatically by A-Track, so that you do not need to be concerned about
such details when setting up and programming your locomotive sound decoders.

Selection of ESU LokSound as the Decoder Manufacturer will enable access to four
Indexed Pages in addition to the Base and Extended CV Pages. Half of each Page
(one Block) can be viewed at any one time in the CV Value grid by selection of the
required Page in the Access CV Page section together with either the low or high Block
in the View CV Block area. Each of the Indexed Blocks is identified with one of the
captions X1L, X1H, . . ., X3L, X3H appearing in the top left corner of the CV Value
grid, as shown in the example below —
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Item Description [D&RGEW 2-8-0 Consolidation - LokSnd Select Basic | Config | Sound | Assign | Lights |Assign-2
Acceleration Adjustment -
Pragram CWs Identity | Confi Speed | Funct'n| P Susi Acceleration Rate
2 | PT gT P T T agesT— Alternate Mode Function Status F1-F3
Fead/Verify Cvs Decoder Manufacturer Alternate Mode Function Status FL, F3-F12
. Bi-Directional Communication Configuration
Copy All Cv's Bleelte / Wl (RIHIREY) (@ r Configuration D ata
Specific Manufacturer & Select from list below - Caongist Address
Paste kain Cvs Consist Address Active for F1-FB
|ESU LakSound j Consist Address Active for FL, F3-F12
Paste Exten'd CVs Deceleration Adjustment
o B View CV Block |  Access CY Page Deceleration Rate
Sl > LD[DD”zS] L Blese @ Btk (@ gzgggziatcoeniztiLcl:néotglsping Configuration
|Jpdate Item Hi (120256} Indexed 1 (7 Indexedz & Decoder Lock 1D Code
[~ Show All s Indexed 3 ¢ Inderedd4 EMF Feedback Cutaut
Cloze | Extended Address LS 8 Bits
Extended Address M5 B Bits
CV [ Ox [ 12 [ 2x [ 3x [ 4x [ 5x | 6x | 7x | 8x | 9x [10x| 11x [ 12x | | [Forward Trim _
0 000 000 003 000 000 000 000 000 000 OR4 000 000 :nge”egEagﬁggfﬁsr@haﬂvﬁe
1 [000 000 000 000 000 000 D00 OO0 000 000 000 000 OO0 |||gefie, o ods feemss manese
2 | 000 003 000 129 00O DO1 064 000 00D 00O 000 000 000 || |Qutpot Contol for Function FOT
3 | 004 000 000 000 00O 00O 00O 00O 00O 00O OO0 OO0 Ooo DutpulCDntmIfUlFuncl!onFEQ
4 | 000|000 000 | OO0 OB4 | OO0 | 000 | 00O | 016 | 000 000 000 | 000 || |Output Contral for Function FO3
5 | 000 000 000 064 00D 000 OO0 00O 000 0S4 OO0 00O OOD SEEEE:Egg::g”g:mgt:g:;gg
6 | 000 000 000 000 000 000 000 000 000 000 032 000 000 ||Qytpust Control fr Function FOR
7 | 000 000 000 00O 00O OO0 00O 00O 00O OO0 00O 001 001 Output Control for Function FO7
8 | 000 000 000 OOO 000 OOO 004 00O 000 00O 000 00O 000 || |Cutput Control for Function FOR .
9 | 000 076 000 000 000 000 000 032 000 000 000 ooo [ | /Cuteut Contiolfor Function FO3

When a Block of CVs from an Extended or Indexed Page is being displayed, only those
CVs which have a purpose defined by the selected manufacturer will have their values
shown. All other cells in the CV Value grid will be ‘greyed-out’, as can be seen in the
example below, and made inactive, so that they do not respond to any mouse clicks.
Marking inactive CVs in this way speeds up Read/Verify or Program operations (See
Sections 6.6 and 6.7) since time is not wasted in attempting to access decoder CVs
without any declared function —

—

Paste Index'd CVs
Update ltem

Cloze |

Hi [123-256]
[ Show &l vz

Access CY Page

Base (" Ewtended
Indexed 1 ¢  Indemed2
Indexed 3 Indexedd

Ox

Ix | 2x [ 3x | 4x [ 5x | 6x | 7x [ 8x | 9x [10x[11x]12x

E

=
)
o

033

128

128

128

128

128

128
060 128
128 128

123 128

128

Deceleration Fate

Decaoder Access Unlock
Decoder Automatic Stopping Configuration
Decoder Lock ID Code

EMF Feedback Cutout

Extended Address LS 8 Bits
Extended Address M5 B Bits
Forward Trim

Indexed Page Address High Byte
Indexed Page Address Low Byte
Kick Start

Output Control for Function FO1
Olutput Contral far Function FO2
Qutput Contral for Function FO3
Output Control for Function FO4
Clutput Control for Function FOS
Output Contral far Function FOB
Qutput Contral for Function FO7
Output Control for Function FOZ
Output Contral for Function FO3

If you wish to access these hidden CVs (when, perhaps, a new version of the decoder
is released with additional functionality, or you simply wish to use Read /Verify to
capture a full record of the decoder’s contents) then you can ‘unmask’ all CVs in this
and all other Extended or Indexed blocks by clicking on the Show All CVs checkbox in
the View CV Block section, with the result shown below (where you can see that ESU
actually utilises some of these undefined CV locations to store data) —
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Itern #16 - Addr 015 - Configuration Variables

Basic T Config T Sound T AssignT Lights TAssign-2

Acceleration Adjustment -

Frogram CWs Identity | Config | Speed | Funct'n| P Susl Acceleration Rate
2 | PT 9 T - T T agesT— Alternate Mode Function Status F1-F3

Fead/Verify Cvs Decoder Manufacturer Alternate Mode Function Status FL, F3F12
. Bi-Directional Communication Configuration
Copy Al CVs Basm:.a-’ Other [NMRA] -

Configuration D ata
Specific Manufacturer & Select from list below - Caongist Address

Item Description |D&RGY 2-8-0 Corsolidation - LokSnd Select

Consist Address Active for F1-FB
|ESU LakSound j Consist Address Active for FL, F3-F12
Deceleration Adjustment
View CV Block |  Access CV Page Deceleration Rate
Lo ([Ii-12E) oy Blese @ Btk (@ gzgggziatcoeniztiLcl:néotglsping Configuration
|Jpdate Item Hi [123-256] ¢ Indexed 1+ Indexedz (" Decoder Lock 1D Code
Indexed 3 ¢ Inderedd4 EMF Feedback Cutout

v .
| Extended Address LS 8 Bits
Extended Address M5 B Bits
Ox | 1% | 2x | 3x | 4|75, [ 64 | 7u | 8n | 9% [ 10 1% 12x] | |Forwerd Trim

000 oot 128 00 0oo o ool o128 000 000 o001 128 000 Indexed PageAddress High Byte

000 093128 000 OOON 425 123 oo o0 128 125 oo ooo | | |Indexed Page Addiess Low Byte
oo oot | 150 000 oo Kick Start
oo | 128 | 000 000 001 128 000 000 Qutput Control for Function FON

033 128 000.p000 | 128 98 ppo | 000 0BO 128 | OO0 000 128 | | | Output Contral for Function FO2

001 |Cy-1.278 Not Used!®% | 128 | goo | 000 001 128 | 000 000 001 | | |Cutput Cantral for Function FO3
OO0 OO0 128

128 250 ooo | OO0 128 128 000 OO0 128 128 Qutput Contral for Function FO4

Output Control for Function FOS
180 000 | 000 | 001 128 | 000 | 000 001128 | 000 000 001 | 128 | | | Quput Contial for Function FOS
o0o | 0oa |CV 1.331 Slot 10 Volume - Conductor Whistle / Crossmg Comms utput Control for Function FO7
000 000 OOTT 125 OO0 000 OOT | 125 000 0007 00T L ‘ ulDul Contral far Function FO3

000|128 128 000 00D 128 128 00O 00D 128 128 DDD Output Control for Function FO3 Y

Cloze

r.n‘m|--.|‘:n‘ e[ m 0 |ro| = o |2

As for all other CV Blocks, when you pause the mouse cursor over any CV value in the
grid, the pop-up label describing the function (if any) allocated to that CV is displayed
with the CV Address prefixed with the Page Index, as shown in the example above,
where the cursor is over CV-1.331 (ie. CV 331 in Index Page 1) which holds the
Volume level for a specific sound feature programmed into this make of decoder. Note
also (in the inset group of CVs) that CV 278, which has no defined function for this
decoder, is nevertheless used to hold data of some kind — you are recommended,
therefore not to attempt to program such ‘unused’ CVs.

You should refer to the manufacturer’s data sheet or user manual for details of how to
set and adjust each CV value in order to obtain the particular operational function, or
type and volume of sound, you require from the specific decoder.

With so many CV locations available for use, searching through all of the available
Blocks for the value you wish to check or edit becomes impractical, even if you become
very familiar of how the manufacturer arranges the various groups of CVs.

Hence, in order to locate the particular CV you require, click on the Description Tab
appropriate to the CV category, then click on the description of the CV (all Lists are
arranged in alphabetical order). This will immediately display the relevant Block in the
CV Value grid, highlight the required CV, and display its value for editing in the
Parameter Tabs area, as described in Section 5.4.

An example is shown below, where the parameter ‘Diesel Manual Notching Offset’ has
been selected from the Config Description Tab. A-Track has opened the high Block of
the Base Page and highlighted, in bold text, the correct CV (CV131) which currently
contains the value 012 (CV Grid Column Ox / Row 3)
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Itern #16 - Addr 015 - Configuration Variables

Item Description |[D&RGEW 280 Consolidation - LokSnd Select | Basic | Config | Sound | Assign | Lights [Assign-2
ABC Mode Threshold ]
Frogram C's | | dentity T Config T Speed T Funct'nT Pages SUS| AL Mode Valtage - Maximum Speed

AL Mode Woltkage - Start Speed

Fread/erity Cvs Configuration ¥ariable ¥alue Analog Made 5 elect

Analogue Function Yoltage Dffset

Copy &Il CV's [:V 13 i . Analogue Motor Voltage Offzet
Diezel b anual Motching Offset Afzsign Fr - Automatic Decoupling Push Time
Stop-Fonward C [V3.5] Automatic Decoupling Removal Time
Dec I_EI'I 2 Hex I_DC .g.?;ﬁgnﬂgd[;ecouphng Speed
# Yalue 7EG 43210 Brake Mode Configuration
gt T T T T I Cotstant Brake Mode [Brake Rate)
Constant Brake Stopping Diztance (Backward)

Update ltem Comnstant Brake Stopping Distance (Forward)
0K Lancel D Mode Yoltage - Maximum Speed
d

Cloze
qy, AnLa

Ox | 1x | 25 | 3x | 4x | 5 | 6x | 7x | Bx | 9x | 10x ] 11x | 12x] | |Extended Configuation #1

5

0 000 000 000 000 000 000 000 000 000 000 000 | 000 | | |Extended Configuriation #2 / Ausiliary Settings

1 | 015 ooo 000 ooo | 000 ooo | 000 | 000 000 000 | ooo | oo | oog | | |Bvade Crossing Holding Time

— Load-BackEMF Contral Dynamic Operating Range

2 | 005 000 000 000 000 000 000 | 00O | 000 000 000 000 000 ||| oad-BackEMF Contiol Parameter I

3 |012 000 000 000 000 000 000 000 000 000 000 000 000 || |Load-BackEMF Control Refersnce Voltags

4 gggh@gg 000 000 000 000 000 o000 oo0 ooo ooo | ooo | ooo | | |Load-BackEMF Contral Slow Speed Parameter VK 4 Helper Mode
— Load-BackEMFCartral Parameter 1"

[CV-131 Diesel Manual Notching Offset /Assign Fn - Stop-Forward C (v35)J000 | | | i o e e

THBT 00 U0 | 00| 00| 000 000 0007 000 | 000 | 000 U007 000 | | | poyer Fail Bypase

000 000 000 000 00D 000 000 000 000 000 000 000 000 || |Protocol Select

000 | 031 000 000 00D 000 000 000 000 000 000 000 000 || |RsiCom Configustion
000 152 000 000 000 000 000 000 000 000 oo ooo [ | ) Sesondary Steam Chuff Trigger

W‘CO|'HI‘G'

Note, in the particular example selected above, while CV131 is used by LokSound for
the ‘Diesel Manual Notching Offset’ parameter in their current Version 4 decoders, it is
also used for a completely different Function Assignment purpose in their earlier
Version 3.5 decoders. If you select ‘Assign Function — Stop-Forward C (V3.5)’ from the
Assign Description Tab then you will find that you will again end up at CV131, as
shown below —

Itemn #16 - Addr 015 - Configuration Variables

Basic T Config T Sound T AssignT Lights TAssign—2

Item Description |D&RGwW 2-8-0 Cansalidation - LokSnd Select

Aszsighn Fri - Senzar2-Forward A (v3.5) -~
Frogram CWs |detit Canfi Speed | Functh | P. SUsl Agsign Fr - Sensor2-Forward B (V3.9)
£ | C :J T . QUT . I;I \I'TI T EH=S T— Azzign Fr- Senzorz-Forward C [W3.5)
Fead ety Cvs onfiguration ¥anable Yalue Aszsign Fr- Senzord-Reverse & [(V3.5)
V13 Aszzign Fr - Senzar2-Reverse B [W35)
Copy &ll CVg . . ) Agsign Fri- Sensor2-Reverse C[V3.5]
Diezel Manual Motching Offset Azsign Fr - Lssign Fr - Stop-Backup & (W3.6)
Stap-Fonward C (W3.5] Assign Fri - Stop-Backup B [V3.5)
,— ,— Aszzighn Fr - Stop-Backup C [W3.5)
Dec |2 Hex JOC Azzign Fr - Stop-Fomward A [ 2.5)
VELTE TES543210 Assign Fn - Stop-F B [v3.5)
Bts: T ITMMITT | 5
Update tem Azzign Select-Fr - FOQ(F] Logic #2
LS Cancel Assign SelectFr - FOO[F) Physical
Cloze | Aszzighn Select-Fr - FOOF] Sound #1
& zzinm SalartFe - FOMFT Grnnd #7

An abbreviated summary of the possible different assignments for each CV is shown on
the pop-up label which appears when you hover the mouse cursor over that CV in the
CV Grid.

For the LokSound range there are also appreciable differences between the Select
decoders and the standard Version 4 decoders regarding the Function Assignment CVs
(note the use of two Assign Tabs). There are separate Description Tab entries for each
type of decoder, as you can see in the fragment of the Assign List shown above, so
take care to select the appropriate entries for your own equipment.
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The latest range of sound decoders produced by QSI (Quantum) have a similar
complexity to the ESU (LokSound) products, with almost 700 CVs to define the
locomotive’s operating parameters. The Quantum range have their own unique (and
complex) indexing scheme to access each CV but, to keep things as simple as possible,
A-Track handles all of the complexity behind the scenes, and presents the various
groups of Quantum CVs in a set of four ‘psuedo’ Indexed Pages similar to those used
for all other complex decoders. Each of the Quantum Indexed Blocks are identified with
one of the captions Q1L, Q1H, . .., Q3L, Q3H appearing in the top left corner of the
CV Value grid, as shown in the example below —

Itern #12 - Addr 122 - Configuration Variables

Item Description |Uni0n Pacific Challenger - Q51 Titan Steam Basic T Config T ound T AsmgnT Lights T Eontind

Acceleration Adjustment -
Frogram CWs Identity | Config | Speed | Funct'n| P Susl Acceleration Rate
2 | PT 9 T - T T ages T— Alternate Mode Function Status F1-F3

Read/Verify Cvs Decoder Manufacturer Alternate Mode Function Status FL, F3-F12
Bi-Directional Communication Canfiguration

Copy &ll CV's B Wi (NI @ r Configuration D ata
Consisgt ddress

Specific Manufacturer & Select from list below -

- Consist Address Active for F1-F8
|Q5| Solutions - Guanturm ﬂ Consizt &ddress Active for FL, F3-F12
Deceleration Adjustment
View CV Block | ~ Access CV Page Dieceleration Rate
Bae -~ ~ Decoder Access Unlock
Lo (001-128) & Decoder Automatic Stopping Configuration
|Jpdate Item . Indewed 1 (7 Indexed2 Decoder Lock 1D Code
Hi [123-256) Indexed 3 Indexedd EMF Feedback, Cubaout
Cloze | Extended Address LS 8 Bits

Extended Address M5 6 Bits
Ox | 12 [ 2% | 3x [ 4x | 65 [ 6x | 7x | Bx [ 9% [10x[11x[12x] | |Forward Trim

5

0 oo i001: 001 032 000 000 000 000 000 000 000 OO0 :ngeﬁegEageiggmssrighaﬁﬂte

1 |oo0 oss 1e0le003 | 004 000 00O 00O 00O 00O 00O OO0 OO0 Qcﬁ”gtanage ress Law bite

2 | 000 032 032 001 255 000 000 000 000 OO0 000 000 000 || |Qutpot Cantral far Function FOT

3 | [CV-55.72.0 Reverse Light Initial Statefl | 000 ] 000 | 000 | | |Output Cortral for Function FO2

4 ao 00 000 000 000 | 000 | | | Qutput Cantrol for Function FO3

5 | 000 00D 000 OOD 000 OOO 000 OO0 000 00O 000 00O 000 SE:EE:EEEEEHE:EEQE:E:ES;

B | 000 000 000 100 000 000 000 000 000 000 000 000 000 || |§utpt Contol for Function FOR

7 127 127 127 000 0ooo 000 | 000 | 000 | | | Output Control for Funetion FO7

g | oo 127 127 127 000 000 000 | 000 | 000 | | | Output Control for Function FOB

9 | oo 000 DDD! Output Cantral far Function FO3 hd

Again, when a Block of CVs is being displayed, unused grid cells are ‘greyed-out’, and
do not respond to any mouse clicks, but note that in this case there are no ‘hidden’
CVs in these cells. Also, as normal, and as is shown above, when you pause the mouse
cursor over any CV value in the grid, the pop-up label describing the function allocated
to that CV is displayed with the CV Address.

For Quantum decoders, this CV Address is made up of three parts comprising the
number of the CV used in the Base Page to retrieve the value of the CV from the
decoder, followed by the Primary Index (a value loaded to CV49 prior to accessing the
CV value), and finally the Secondary Index (a value preset in CV50). In the example
above, the cursor is over CV-55.73.0 which holds the Reverse Light Initial State.

The full range of defined Quantum CVs are displayed in numerical order through all
eight Indexed Blocks but, like other complex decoders, the easiest way of finding the
CV value you wish to check or edit is to click on the Description Tab appropriate to
the CV category, then click on the description of the CV (all Lists are arranged in
alphabetical order). This will immediately display the relevant Block in the CV Value
grid, highlight the required CV in bold text, and display its value for editing in the
Parameter Tabs area, as described in Section 5.4.
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Hence, to locate the CV highlighted in the previous example, select the Lights
Description Tab, scroll down to find ‘Reverse Light Initial State’, and click on it. A-Track
opens the low Block of Indexed Page 2 (Q2L) and highlights the correct CV
(CV-55.73.0) which currently contains the value 001 (CV Grid Column 2x / Row 0) —

ltemn #12 - Addr 122 - Configuration Variables

Basic T Config T Sound T AssignT Lights Tl:unlml

Fear Mars Light Ramp Up Time ~
Program CWs |dentit Carifi Speed | Functn| P 5SS Rear Mars Light Strobe Hold Time
J | v T 2 T F T T SRS T— Rear Mars Light Strobe Period

Read/Verfy CVs Configuration Yariable Value Rear Mumber Board Lights Iritial State
CV55.73.0 Fear Humber Board Lights Max Intensity

Copy All C's ; . Rear Murnber Board Lights Famp Down Rate
Reverze Light Initial State

Fear Murmber Baard Lights Rarmp Do Tirme
Fear Humber Board Lights Ramp Up Rate

Item Description |Union Pacific Challenger - Q51 Titan Steann

,— ,— Rear Mumber Board Lights Bamp Up Time

Dec 001 Hex |01 Rear Overhead Beacon Light Initial State

Yalue TES 43210 Rear Overhead Beacon Light Max Intenzity
Bts T T rrr i+ Rear Overhead Beacon Light Min Intensity

Rear Overhead Beacon Light Period
Update Iterm Fear Overhead Beacon Light Ramp Up Rate
Ok Cancel Rear Overhead Beacon Pulze 2 Max Intensity
Close Rear Overhead Beacon Bamp Down R ate

Fear Overhead Beacon Rarmp Down Tirme
Ox | 1% | 2u | 3n | 4x | 5x | Bx [ 7x [ 8x [ 9x [108[ 112 [ 12« | | |Rear Overhead Beacon Ramp Up Time

Jiil

5

0 001 001 001 032 000 OO0 000 000 00O 000 000 | ooo | | |Fear Step Lights Initial State
Rewerze Light Dim Intensit

1 | 000|036 160 003 004 000 000 00O 000 OO0 000 00O 000 ||k Cight Initial State.

2 | 000 032 032 001 255 000 OO0 0OO OO0 000 000 000 000||[Reverse Ligh bl 2w Itit_l,J

3 | 000 255 285 001 032 000 000 ood oo 000 000 | | | Rewerse Light Ramp Down Bate

4 ] ooo ooo ooo 000 | 000 | | |Reverse Light Ramp Down Time

5 | 000 000 000 000 00O 000 00| 000 000 000 000 oo ogo | | |Feverse Light Ramn Lp Rate
— Feverze Light Ramp Up Time

6 | 000 000 000 100 000 000 000 000 000 000 000 000 000 |||Sien ights Max Intersity

7 127 127 127 oo oo 000 | 000 | 000 | | |Step Lights Ramp Time

8§ | 000 127 127 127 0o 0o 000 | 000 000 | | | Truck Lights Max Intensity
9 | o oon | oon ! Truck Lights Ramp Time hd

A-Track handles all of the QSI CV Indexing mechanism automatically, including
inserting the required index values in CV49 and CV50, so that you can access any of
the CV values in very much the same way as for any other decoder.

Note : If you have any Items with Quantum decoders which were set up under
Version 4.1, or an earlier release, of A-Track, which had a simpler CV format, then
they will be converted to the new Indexed Page format automatically as soon as you
open the Edit CVs window for the Item. Because of this, the Update Item Action
Button will then be enabled even if you make no explicit changes to the Item
yourself. If you choose to use the Close button to terminate the edit, then you will
be prompted to save the changed Item back to the Item List.

Warning : Once you have selected a Decoder Manufacturer which uses Indexed
Pages, and load (and save) data from a decoder into the Item’s Indexed Pages,
then, at a later time, if you re-open the Item and change the Decoder Manufacturer
selection, you will lose any CV data loaded to those Pages. If you do this by
accident, you can recover by clicking Close and choosing not to update the Item.

When you have a locomotive decoder from a manufacturer other than the eleven who
are currently supported directly, selecting the Basic / Other (NMRA) option in the
Decoder Manufacturer area of the Pages Parameter Tab provides the Item with access
to both Base and Extended CV Pages, with the further option to use up to four Indexed
CV Pages, as shown in the example below —
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Item Deseription |Colorado 5outhern 2-6-0 Mogul [t
icce:eration .gdiustment -
i 5 . coeleration B ate
Frogram C's | Idenlll_l,lT EnnflgTSpeedTFunclnT Pages | SUSI et Mode Function Status 18
Fead/Verify Cvs Decoder Manufacturer Alternate Mode Function Status FL, F9-F12
o BV Basic / Other [NMPA] & B [ 'With Indexed Pages E;E;[;Sf‘aﬂ[‘oﬂ Lomm.ricaion Configuection
Specific Manufacturer ¢ Select from list below - Caongist Address
Paste Main CV's - — Conzist Address Active for F1-F8
| Basic / Other INMRA CY Defiritiars] =l Corsist Address Active for FL, F3-F12
Paste Exten'd CVs Deceleration Adjustment
View CV Block |  Access CY Page SBCB?TGE‘UH HateLI ek
ecoder Acces: LRloc)
Lo (001-128) = Bess o Gtk (@ Decoder Automatic Stopping Configuration
E ] {5 . [Decoder Lock 1D Code
Hi [123-256] © r r EMF Feedback Cutout
Cloze | Extended Address LS 8 Bitz
Extended Address M5 B Bits
CV | Ox | 1x | 2% | 3x | 4x | 5% [ 6x | 7x | 8x [ 9x [10x[11x[12x] | |Forward Trim
0 000 | 000 000 016 000 000 000 000 000 000 000 007 || |Indewed Page Address High Bute
1 | 047 OO0 255 00D 000 00O DDD 00D 000 000 DDO 00D 002 |||hdeved Pape Addess Law Byte
2 | 000 001 255 000 OO0 000 OO0 000 OO0 000 000 000 000 || |Guput Contral far Function FiIl
3 | D00 000 000 001 | OO0 000 OO0 00O OO0 | 000 000 000 000 | | |Output Control for Function FO2
4 | 000 000 000 002 | 00O | 000 000 00O | 000 | 000 000 000 000 || |Qutput Control for Function FO3
"5 | 000 000 00D 004 00O 000 DOD OO0 000 00D 000 00O 00O SEEEE:Egg::g”g:mgt:g:;gg
6| 000 000 000 008 | 000 000 000 000 000 000 000 | 000 | 000 | | |§yteck Control for Furction FOB
7 | 035 194 000 016 000 000 000 000 000 000 000 000 000 || |Output Contral for Function FO7
8 | 011|035 000 004 000 000 000 00O OO0 000 000 020 000 || |OutputContol for Function FOS
9 | 000 000 054 008 000 000 000 000 000 000 000 ooo [ | /Cuteut Contiolfor Function FO3 v

In order to add four Indexed Pages to the Item, click to tick the With Indexed Pages
checkbox next to the Basic / Other option, with the result shown below —

Itern #28 - Addr 0347 - Configuration Variables

Frogram C¥'s |

Item Description |Cololado Southern 2-6-0 Mogul

IdenlilyT Config T Speed TFuncl'nT Pages | 5SUSI

ReadVerify CWs
Copy All C's

Decoder Manufacturer
Baszic / Other [MMBA] &8 = [

Specific Manufacturer  © Select from list below -
Pazte Main Oz - —
|BaS|c: / Other [MMRA T Definitions) J
Paste Exten'd Cv's
Yiew C¥ Block | — Access C¥ Page
Q Lo [001-128) @& Baze (v  Extended
Indexed 1 ¢ Indered2
m Hi [123-256) Indexed 3 Inderedd
Cloze |
CV | Ox | 1x [ 2x | 3x | 4x | 5x [ 6x | 7x | 8x | 9% [10x[11x]12x
1] Qoo 000 oo0 | 018 000 000 | 000 000 000 | 0oo ) 000 om
1 | 047 000 255 000 000 000 000 000 000 000 000 0od o 002
2 | 000 00 255 000 00O OO0 000 000 OO0 000 000 OO0 0oo

Basic

Aoceleration Adjustment

Acceleration B ate

Alternate Maode Function Status F1-F8
Alternate Mode Function Status FL, FS-F12
Bi-Directional Communication Configuration
Configuration D ata

Consist Address

Consist &ddress Active for F1-FB

Congizt Address Active for FL, F3-F12
Deceleration Adjustrment

Deceleration Fate

Decoder Access Unlock

Decoder Automatic Stopping Configuration
Decader Lack ID Code

EMF Feedback Cutout

Extended Address LS 8 Bits

Extended Address M5 B Bits

Forward Trim

Indexed Page Addrezs High Bpte

Indexed Page Address Low Byte

Kick Start

Qutput Control for Function FON

Although the Basic / Other selction gives you an Item where you can handle the full
range of CVs for the most complex decoders, with access to all CV Pages, it does suffer
from the disadvantage that it only has a single Basic Description Tab. Hence, you will
need to refer to the manufacturer’'s documentation in order to identify which CVs you
need to access and program in order to extract the required functionality from the

decoder.

Consideration will be given to supporting decoders from other manufacturers in future
releases of A-Track if there is sufficient demand from users.
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6.4 Serial User Standard Interface (SUSI)

SUSI is an interface for adding a slave or secondary decoder to the primary DCC
decoder, proposed by the German company Dietz Modellbahntechnik. It is intended to
support sound and complex function decoders, and has been provisionally incorporated
in the NMRA DCC standards, where it is allocated the use of CV897 to CvV1024,
inclusive.

Although SUSI does not appear to have achieved any general acceptance, and is not
incorporated in any product from the major DCC manufacturers, other than in some
decoders from Lenz, it is supported by A-Track - to be fully compliant with the NMRA
DCC standards. Even when a decoder features SUSI, programming of the attached
secondary decoder is usually handled by the manufacturer through settings made to
the CVs of the primary decoder, rather than directly according to the NMRA standards.

For Locomotive or Multiple Items click on the SUSI Parameter Tab to reveal the
available options (note that the Tab is not enabled for Consists or Accessories).

The options available under the SUSI Tab allow you to set the defined CV values for all
subsets of the SUSI parameters -

[tem #18 - Addr 0606 - Cenfiguration Variables

Item Dezcription |Clear Lake Lurnber 2-Truck Climnax - Zimob<648R

Identit_l,lT Conlig T Speed TFunct'nT PagesT susi

Range Select Module Identity

(e SUSI-| f* Sound Manufac 1D {000
Syl Lvs " SUSI-1I ™ Function Werzian [0 i}

" SUsE- {~ Features

Sound - Yolume Range / Number Select

“ol (000 FO3 (000 FOF (000 F11 (000

FOO |OO0  FO4 00O FO8 (000 F12 (000

FO1 |000  FOS (00O FO9 (000

FOZ |000  FOE (00O F10 joo0

Cloze |

Ox | 1% | 20 [ 3| 4x [ 5x | Bx | 7x | 82 | 9x [10x]|11x]12x

000 000 | 000 | 000 | 000 000 | 000 | 000 | 000 000 000 | 000
000 | 000 | 000 | 000 | 000 000 000 | 000 | 000 000 000 | 000 | 000
000 | 000 | 000 | 000 | 000 000 000 | 000 | 000 000 000 | 000 | 000
000 000 000 | 000 | 000 000 000 | 000 | 000 000 000 000 | 00D
000 | 000 | 000 | 000 | 000 000 000 000 | 000 000 000 000 | 00D
000 | 000 | 000 | 000 | 000 000 000 000 | 000 000 000 000 | 00D
000 | 000 | 000 | 000 | 000 000 000 000 | 000 000 000 000 | 00D
000 | 000 | 000 | 000 | 000 000 000 000 | 000 000 000 000 | 00D
000 | 000 000 | 000 | 000 000 000 000 | 000 000 000 000 | 00D
000 | 000 | 000 | 000 | 000 000 000 o000 000 000 ooo ooo [

mmﬂmm-ﬂ-mm-ﬂcg

However, A-Track does not provide any further operational support for SUSI-equipped
decoders, and will not do so until use of SUSI becomes more widespread.

For further details on the SUSI specification see the relevant section of the NMRA DCC
standards and the referenced supporting documentation.
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6.5 Transferring CV Values Between Items

When initialising the CVs for a new Item added to your roster, it can save a lot of time
if you copy the current values from a similar existing Item (and generally with the
same make, if not necessarily the same model, of decoder). Then, instead of having to
set every single value from scratch, you should only need to alter a small set of key
values, including (normally) the Primary and Extended Addresses.

Open an Edit CVs window for the Item which contains the set of CVs you wish to copy,
then simply click on Copy All CVs to transfer all CV values to the CV Copy Buffer, a
private area of memory within A-Track —

Item #16 - Addr 015 - Configuration Variables

y Item Description ID&HGW 2-8-0 Consolidation - LokSnd Select

Program CV's .ldentity\[‘ Config ] Speed] Funct'nT Pages ] Susl

Read/Verif T
_ReadNeity OVs | | 1o, Type Primary Addiess @ [015
Extended Address 2515 .
... Lop = m Click to make a
[t (e User Identifier #1 'UUU‘-—-.______-__— <oy ol CU
= 5 u er ntner - H H
Paste Exten'd L-.VSJ\ * Locomotive User |dentifies 2 000 —— values held in this
Paste Index'd CVs Manufac Yersion No. 168 Item
Manufacturer ID 151

Update Item

Close |

o

BN 007 o o0 v e 10 011 | 8| vea [ 0T e
1 11 1 =

015 000 000 016 00O 000 075 015 066 188 000 000 0OOTY - which buttons
002 000 000 003 000 032 200 O18 074 208 000 030 003 depends on range
040 128 000 000 000 140 100 022 082 230 000 032 100 of this Item’s CVs
030 003 000 000 000 048 100 026 030 255 000 120 004
064 000 000 00D 000 032 025 030 100 128 000 015 070
022 000 000 000 000 255 128 034 110 000 000 005 120
162 201 024 000 003 143 003 040 124 000 000 030 000
151 211 000 000 001 043 005 046 136 000 OO0 032 000
000 000 006 000 013 128 008 o052 152 000 000 ooo [

) NotAllocated |00 €3 NotProgd

Paste Buttons

[

/

mmw|m|m&wm—n2’

As soon as the copy is complete, the Paste Main CVs and Paste Exten’d CVs buttons
will be enabled. If the Item you are copying is set up to use Indexed CV Pages, as is
the case in the example above, then the Paste Index’d CVs button will also be
enabled.

You can leave this Edit CVs window on the screen if you wish, when proceeding to the
next stage, but it is probably safest to Close it now to avoid any mistakes when
transferring the copied CVs into another Item.

Next, open the Edit CVs window for the Item which is to receive the copied CVs. This
can be either an existing Item or, more usually, a new Blank Item which has just been
created. If you have not already done so, carry out the basic initialisation of the Item
(by setting its Type — as Locomotive, for example — and entering a Description — and,
importantly, setting the type of decoder on the Pages tab), then reading in, and safely
saving, a copy of the current decoder CV settings (just in case of any unfortunate
accidents) as described in Section 5.3.
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Now, before you change the recipient Item’s Primary and Extended Addresses, click on
Paste Main CVs in the Edit CVs window of that Item —

Item #28 - Addr 000 - Configuration Variables

New Item

ﬁ Description

Item Description |Colorado Southemn 2-6-0 Mogul - LokSnd Select

Program CVs Identity]' Config] Speed ] Funct'n] PagesT SuUsI
_ResdNeity Vs | | 1o Type Primaty Address 037

Copy All CV's e Extended Address @ (0737 Click to paste
_ 1 ' 7 | Consict Adeenas the copied Base
Paste Main CVs - =
Al CV values into

Paste Exten'd CV's (" Locomative L |dentiifel 2 L] \
5 User |dentifier #2 000 \ the new Item

; ‘ Manufac Version No.  |168 \\

Manufacturer ID 151
Update ltem
| ¥ MNotélocated [00° € Edted €3 NotProgd Set Primary
Close
— Address

| o I— —

CV [ Ox | 1x | 2« | 3x | 4x | 5x ] 6x [ 7o after Paste
[l 000 R B 168 000 000 | 000
037 00 016 000 000 075 015 066 188 000 000 000

002 001 000 003 OO0 032 200 018 074 208 000 030 003 \ \

040 128 000 00O 000 140 100 022 082 230 000 032 100 —J Set Extended

030 003 000 000 000 048 100 026 090 255 000 120 004!

064 000 000 000 000 032 025 030 100 1 _ Address
022 000 000 000 000 28 120 after Paste
163 134 003 040 124 000 000 080 00D
151 225 000 000 001 043 005 046 136 000 000 032 000
000 000 038 000 019 128 008 052 152 000 o000 ooo [

LDW*H@U'I&W|N—‘

This action copies the values of CV1 to CV256 from the CV Copy Buffer into CV1 to
CV256 of the new Item. The contents of the CV Copy Buffer are retained until replaced
by a further Copy All CVs action, so the values can be copied to as many further Items
as you wish.

While it is reasonably safe to copy the Main (Base) CV Page into an Item with any type
of decoder, the Page still contains a large number of manufacturer-specific CVs as well
as the standard NMRA-defined CVs, and you may experience some unusual responses
if you copy such values into a decoder from a different manufacturer. It is highly
recommended that you restrict copying to between Items which will be fitted with the
same make, and preferably model, of decoder.

The same caution applies if you click Paste Exten’d CVs, which will copy the buffered
values of CV257 to CV512 into the new Item, together with the Block of CVs specific to
SUSI CVs, namely CV897 to CV1024. Having the SUSI CV values loaded into the A-
Track Item will not cause any problems with decoders which do not support SUSI,
since this range of CVs will only be transferred to the actual decoder if you select and
Program them explicitly (see Section 6.7).

Returning to our example, you will note that, in the new Item, because we have not
yet selected the Decoder Manufacturer (as we should have done normally as part of
the Item initialisation), the Paste Index’d CVs button is currently disabled, even
though the Indexed CV Pages were copied from the original Item.

Click on the Pages Parameter Tab, click on the Specific Manufacturer option button,
and select ESU LokSound from the drop-down list as the Decoder Manufacturer (the
same as the original source Item). If you now select one of the enabled Index Pages,
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and then click Paste Index’d CVs, you can see the copied Index Pages being

transferred to the new ltem

Item #28 - Addr 000 - Configuration Variables

ltem Description [Colorado Souhem 2.60 Mogu - LokSnd Seiect Basic | Config | Sound | Assign
: ; ; . Acceleration Adjustment
Program CVs | ldentily] Conlig] Speed] Funcl'n] Pages] SUSI | | |Acceleration Rate "
; Al F9-F12
Read/Verify CV's [B)et.:of;l':! a:::;ituu:: = i Decoder s
Copy All CVs Sas'c", . o [’ : ] i iy b | -~~~ Manufacturer
pecific Manutacturer (¢ elect from list M T A
Paste Main CV's E] selected - fH’St
|ESU LokSound - cd b
Paste Exten'd CV's Deceleration Adjustment
View CV Block | — Access CVY Page geceleratlon Rate
Lo (001-128) & Base " Extended D P—
T e Indexed 1 (& - o| Indexed Page ["***™"
L256) Indexed3 "  Indexe selected to
Close | I :
q view
[ 2 [ 2w T B8 T~ 8% | 9x | 10x | 11x]12x] | |Fd
0 - Indexed Page Address High Byte
Indexed Page Address Low Byte
1 033 128 K
2 /|o| Click to paste
3 | 039 128 000 the Indexed CV
4 NN 3
values in h
5 128 128 000 0 1 ko the
= o| new Item - last
7 099 123 000 Dutput Control for Function FO7
8 Output Control for Function F08
9 128 128 000 ! Dutput Control for Function FO3

After copying the required set(s) of CVs into the new Item you can then proceed to
make any further adjustments to its parameters, where necessary, such as under the
Config Parameter Tab.

The key change of course, as already shown in the example, is to assign different
Primary and Extended Addresses, by clicking in the relevant textboxes on the Identity
Parameter Tab and typing the address values required for the new Locomotive. This is
essential to ensure that the new Item can be uniquely identified within the Item List,
particularly when allocated to a Controller.

Once this is done, you can click on Update Item to transfer the edited Item and its
new parameters into the Item List —

D& Forest Flat - Tam Walley Quad-PIC Aocessly P 0051 »>0201 0230
D& MeGiligan Luriber #1 - MCE Switch-t Acceszy P 00=3 0212 a0

D& McGiligan Lumber #2 - MCE Switch-lt Mk2 Accessy P 0056 0221 0z

D‘ Colarada Southern 2-6-0 Maogul - LokSnd Sel.. Loco _EP_ 037 0737 28 F 000

A ltern List: C:AUzershserDocurnents'@-T | stsSaT-Tobanal-Demo-44+ CalSouthbogulitl & | Themns 28 Curent : 28 |NCE @ [3][COM &

Finally, save the changed Item List to the PC’s hard disk to ensure that the
modifications are securely preserved.
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6.6 Reading and Verifying CV Values

With the Program Track connected to the appropriate output from the NCE Command
Station (Power Cab or Power Pro), placing a physical item (Locomotive) on the Track
will allow you to read the current values of all, or of a selected subset, of the
locomotive’s DCC decoder Configuration Variables. Only a single locomotive should be
present on the Program Track at any one time for correct Read/Verify operations.

This facility is used either to verify that new values programmed into the decoder have
been received correctly, or, with a newly-acquired locomotive and/or decoder, to
transfer the manufacturer’s factory-set CV values (or the parameters programmed into
the decoder using some other equipment, such as an NCE Handheld Cab) from the
decoder to the corresponding A-Track Item in the Item List.

The latter operation is one you should always perform with a newly-acquired piece of
DCC equipment, so that you know where you are starting from — and have a defined
state you can get back to — before altering any of the decoder’s CV values.

Note that, while using A-Track to read and verify a decoder’s CVs, you should not
simultaneously attempt to perform a similar operation (or any operation) using an NCE
Handheld Cab, or you are likely to confuse the NCE Command Station.

Bear in mind also that, while the Program Track is active, the Mainline Track cannot be
used. With the NCE Power Cab, which has only a single power output to connect to
both Tracks, a switch to isolate the Mainline Track during Read / Verify and Program
operations is recommended, as suggested in the connection diagram in Section 1.1. If
you use the Mainline Track for Read/Verify (or Program) operations with an NCE Power
Cab, ensure that no other locomotive is present on the track at that time. When using
an NCE Power Pro Command Station, power is removed from the Mainline Track when
the Program Track is operational.

Now double-click on the Item in the A-Track Item List that is intended to correspond to
the locomotive on the Program Track (see Section 5.3). An Edit CVs window opens,
displaying the current values of the Item’s first 128 CVs in the CV Value Grid occupying
the lower half of the window.

Before proceeding further, you need to ensure that the displayed Item contains the
same number of CVs as the real decoder in your locomotive. Do this by clicking on the
Pages Parameter Tab in the Edit CVs window and checking that the appropriate
decoder Manufacturer has been selected or, if Basic / Other (NMRA) has been selected,
that Indexed Pages have been enabled if required (see Section 6.3).

If you intend to access all of the CVs in one or more blocks then you can proceed
directly to click the Read/Verify CVs Action Button and open the Read/Verify
Configuration Variables page, as described in Section 5.3.

However, if you just wish to get the values of a subset of the CVs currently displayed
in the CV Value Grid of the Edit CVs window, click on the first CV to be selected, hold
down either Shift () key, then click on the last CV in the group. The group of CVs,
from the first to the last selected, will be highlighted with a yellow background. Note
that selection is done in columns, running from top to bottom in each column, then
moving rightwards to the next column.

Single CVs can be added to a selected group (which may just consist of one other
selected CV) by clicking on the additional CV while either Ctrl (Control) key is held
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down. Conversely, clicking on a selected CV while holding down either Ctrl key will
deselect that CV and remove its background (yellow) highlighting.

After clicking on at least one cell in the CV Value Grid, you can also select all CVs in
the displayed Grid by pressing Ctrl-A (hold down either Ctrl key then press the A
key). You can then deselect any individual CV by clicking on its location while holding
down either Ctrl key. Alternatively, you can first select those CVs you do not want in
the final selection by using the mouse in conjunction with either Ctrl key, and then
press Ctrl-1 (either Ctrl key plus the | key) to invert the selection.

If you make an error in selecting a group of CVs, then simply click on any CV to
remove the unwanted highlighting and leave only the CV on which you clicked
highlighted. This last CV highlight can be removed by clicking on the highlighted CV
while holding down either Ctrl key.

Note that, whenever any CV is selected, the Program CVs Action Button background
will also be changed to yellow as an alert. This feature is not particularly significant
when dealing with a single block of CVs, as here, but can be useful when handling
complex decoders with multiple blocks of CVs, as described later in this Section.

The example below shows a group of CVs selected by a click on CV0O1 followed by a
click on Cv46 with a Shift key held down, and then CV20 to CV26 removed from the
selection by clicking on them in turn with a Ctrl key pressed. Before or after selection,
a click on the Read/Verify CVs Action Button reveals the Read/Verify Configuration
Variables page —

Item #6 - Addr 2011 - Configuration Variables

Item Description ED&RGW 2-Truck Shay - DN142

‘Identity] Config | Speed | Functn] Pages | sUsI
Read/Verify Configuration Variables
CV Range CV Scope Mode

4| & Curent View + AllCVs {* Paged
te M " ANCY Blocks " Selected " Direct

" Reagister

.'—| " Address

__ Updateitem_| Confirm | Cancel | f)}

Ox | 1x | 2x | 3x | 4x | 5% | 6x | 7% | 8x | 9% | 10x | 11x] 12x ] Yellow highlight
000 000 OO0 00D OO0 OO0 064 180 240 000; 00O — to show CVs

011 000 000 00D 000 OO0 000 078 188 2 selected for

000 001 000 0OO QOO 00D 000 .

000 0DO OO0 0OD O Read/Verify

000 000 00O 00D 000 000 128 118 210 255 000 000

000 0DO OO0 ODD OO0 128 001 130 216 000 000 QOO

000 000 00O 00D 000 048 000 142 222 000 000 000

250 193 000 00O 000 000 016 152 228 000 000 000

129 219 000 00D 000 00D 032 162 232 000 000 00O

000 000 054 000 000 000 048 172 236 000 000 000

Program CW's

|

wlo|~|o|o|a|w|nf=|o|Q

The CV Range options allow you to select either only the Current View, ie. the block
of 128 CVs presently shown in the CV Value grid, or All CV Blocks, ie. the full
complement of all CV Pages defined in the Item (with the exception of the SUSI block).
Note that if you want to access a specific block of CVs other than that currently on
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view, then you will have to display that block from the Pages Parameter Tab before
clicking the Read/Verify CVs Action Button — an example will be shown later. Within the
selected CV Range, you can then choose a CV Scope, by clicking on the appropriate
option button, of either All CVs or only those which are Selected, ie. are highlighted
(yellow).

You should also consider which decoder access Mode is to be used —

e Paged is the most common mode (and most likely to work correctly), but is also
slow and may take up to 20 seconds to read the value of a single CV (Note that
the NMRA term ‘Paged’ used here is completely unrelated to the CV Pages
defined for the NMRA Indexed Addressing scheme)

¢ Direct is much faster, and is the preferred Mode, but is not supported by all
decoders

e Register is similar to Paged, but only reads a very small subset of seven CVs,
consisting of CV1 to Cv4, CV7, CV8, and CV29

e Address is a legacy mode which only allows you to read the value of CV1

Click to select the required Mode, or leave it at the default setting of Paged.

For a first example of the Read/Verify operation, assume that no CVs are selected, CV
Range and CV Scope are left at the default settings (Current View and All CVs), and
that Register Mode has been selected, then click Confirm to start the Read/Verify
operation —

Item #6 - Addr 2011 - Configuration Variables

Item Description ID&HGW 2-Truck Shay - DN142

.Identily] Config ] Speed ] Fur'u:?’nT Pages ] Susl

Program CV's

Read/¥erify Configuration Variables
¥ Bange CY Scope Mode

& Cunent View & AlCVs " Paged

" AllCY Blocks " Selected " Direct

Ee|
o]
— o || ) o Timer e
o]
=

show operation in
progress

| — Pink highlight to
CV [ Ox [ 1x] 2x [ 3x [ 4x [ 52 [ 6x | 7x [ 8x [ 9 SHOW EV TEdc
X X X H 9 X ® X X X =

0 000 000 000 QOI_Dno== differs from Item

1 | 003—60m or green to show

2 | oo0 ool value is the same

3 | 000—&8m

4 |000 000 000 000 0OO 00O 128 118 210 255 000 000 000 .

5 000 000 000 000 000 128 001 130 216 000 000 000 02| | Red highlight to
_6 | 000 000 show current CV

7 | 250 199 — :

ol 21 read in progress

9 | 000 000 172 | 236 000 000

During the Read/Verify operation, the CV currently being accessed will be highlighted
in red. Once the CV value held in the decoder has been determined, it will be
displayed in the grid and highlighted in light green if the value read is the same as
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that held in the Item, or highlighted in pink if it differs from the Item’s stored value,
as shown above, where the Program CVs button has also been highlighted in pink.

Note the animated ‘egg timer’ icon being shown to indicate a currently active
operation, and that all buttons other than Cancel are ‘greyed-out’ to prevent any
interference with the Read/Verify process. Clicking Cancel will stop the Read/Verify
operation eventually — in Paged or Register Modes this can take up to 20 seconds
(regardless of how many times you click the Cancel button) — but the value read from
the currently accessed CV cannot then be relied upon to be correct.

Once the Read/Verify operation has been completed, a message is displayed to
indicate the result -

Item #6 - Addr 2011 - Configuration Variables

Item Description |D&FH3W 2-Truck Shay - DWN142

Program Cwv's Identit}lT Canfig T SpeedT Funct'nT FPages T SUs|
Read/Yerify Configuration ¥ariables
* Current View v AllCVs ™ Paged
" AllCY Blacks " Selected " Direct
(+ Reaqister
" Address
g 0 Read/¥erify Completed Successfully

_ Updetefien_| |

CV | Ox | 1x | 2% | 3 | 4x | 5x | Gu | 7x | 8x | 9= |10x |11z |12«
!n | 2% [ 3 | 4 | 5x | 6x | 7 | 8x | 9x [10x] 1112«

[T T T A T R T O T (B T R o} 100 | An | nnn | non | ann |

e

=3

Click Finish to complete the Read/Verify operation. All highlighting of CVs will be
removed except for those CVs where the value read from the decoder differs from that
currently held in the Item. Such CVs will retain their pink highlight. Any CVs which
were highlighted (yellow) before starting Read/Verify, but not accessed during the
operation, will also retain their highlight.

If the Read/Verify operation fails for any reason then the value of the CV which could
not be determined is set at zero, and indicated as a failure by ‘striking-through’ the
digits (869).

Failure to complete the requested Read/Verify operation can be due to one or more of
a number of causes —

e The Program Track is not properly connected to the NCE Command Station

e The locomotive is not in good contact with the Program Track, or the decoder
wiring/connection is defective

e The decoder does not support the selected access Mode (particularly Direct)

e A sound decoder is fitted and is overloading the Program Track drive capability
of a standard NCE Power Pro Command Station — a programming booster unit
(such as the SoundTraxx PTB-100) requires to be inserted between the
Command Station and the Program Track — such a unit is not required, nor
recommended, when using an NCE Power Cab

e The decoder does not support the use of specific CVs and does not respond to
Read/Verify commands when these CVs are accessed. This is a ‘feature’ of QSI
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Quantum sound decoders, for example, and, once you know which CVs are
unsupported, you can omit these CVs from your selection in order to speed up
the overall Read/Verify operation.

The Read/Verify operation continues with the next CV following any failure.

However, when an unexpected failure does occur (or for any other reason) you can
stop the operation by clicking the Cancel button although, as noted previously, this
can take up to 20 seconds in Paged or Register Modes (regardless of how many times
you click the Cancel button).

In the example shown below, with a selected range of CV15 to CV45, Read/Verify has
failed to read the values of CV40 and CV41, and has been halted by the user in the
course of reading Cv42 (for which the value shown may be incorrect), leaving the
remainder of the selection (CV43-CV45) unread —

Item #6 - Addr 2011 - Configuration Variables

Item Description ED&RGW 2-Truck Shay - DN142

Program CVs Identity]' I:onhn;} Speed ] Furu:l‘rw] Pages ] susi
' Read/Verify Configuration Variables
CV Range CV Scope Mode
4' & Curent View " AllCVs * Paged
te M " AllCV Blocks # Selected " Direct
" Reagister
. " Address
+| Cancelled Read/Yerify of Selected C¥s .
o y _ ‘Strikethrough’
Continue | Finish | 3 indicates CVs at
| " which Read/

CV [ ox | 1x] 2% | 3x | 4x | 5x [ 6x | za = =] | Verify operation
0 000 000 00D m%mﬂﬂtﬁﬁmnr failed

1 | 011 000 000 00O 000 000 000 078 188 244 000 000 000

2 | o000 001 000 000 ! 000 000 032 196 248 000 000 000

3 | 000 000 000 000 00D 000 252 000 000 000 Value of CV at
4 000 000 00O 00O 000 000 128 118 ;

5 (000 000 000 000 000 128 001 130 216 000 T Wh'_Ch Read/ .

6 | 000 000 00D 000 000 048 00D 142 222 000 000 000TTee  Verify operation
7 | 250 192 000 000 000 000 O16 152 228 000 000 000 000 cancelled cannot
8 (129 003 000 000 000 000 032 162 232 000 000 000 000 be guaranteed
9

000 000 022 000 000 000 048 172 236 000 000 000 [N

Note that, since there are CVs read from the decoder with different values from those
of the stored Item (highlighted in pink) as well as manually selected CVs (highlighted
in yellow), the Program CVs button is now shown with an orange background.

You can carry on with the Read/Verify operation from the next selected CV by clicking
on Continue, when the Read/Verify operation will restart at CV43, continuing up to
CV45. Click Finish to terminate the Read/Verify operation.

Following a failure of the Read/Verify operation, and after checking all of the Program
Track electrical connections, and the contact between the locomotive and the track — in
case the failure was due to some temporary condition — you can repeat the operation.

Either individually select each of the CVs where Read/Verify failed, and is indicated by
‘strikethrough’ (8686), or select any one and then press Ctrl-L (hold down either Ctrl
(Control) key then press the L key), which will select all CVs marked by a
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‘strikethrough’, and then retry the Read/Verify operation with the CV Scope set at the
Selected option.

Where a sound, or other, decoder uses CVs beyond the Base Lo Block that is normally
displayed in the Edit CVs CV Value grid, you can select a CV Range of All CV Blocks
for Read/Verify. Irrespective of the selected CV Scope (All CVs or Selected) A-Track
will then proceed to step progressively through every (selected) CV value in each CV
Block allocated to the Item.

Note, however, that this extensive Read/Verify operation will take an appreciable
amount of time. In the case of ESU LokSound decoders, for example, the full operation
will take around 30 minutes to complete when using Direct Mode, where each CV read
requires 1 to 2 seconds. If you choose to use Paged Mode instead, the operation will
potentially occupy several hours.

With QSI Solutions Quantum decoders, although Read/Verify takes up to 4 seconds per
CV Value, because of the overhead of setting the decoder Primary and Secondary
Indexes before reading each value, the overall time to access all CV Pages in Direct
Mode will only be around 45 to 50 minutes, because of the lesser number of CVs to
access. Again, in Paged Mode, the operation will need several hours to complete.

However, the recommended way of using A-Track for Read/Verify operations (and for
Program operations, as described in the following Section 6.7) is to handle a single CV
Block at a time.

Hence, before starting the Read/Verify operation, click on the Pages Parameter Tab,
and select the Block of interest using the Access CV Page and View CV Block
options, as shown in the example below for an Item representing a locomotive with a
QSI Solutions Quantum decoder —

Item #12 - Addr 089 - Configuration Variables

Item Description [Union Pacific Challenger - QS| Titan Steam Basic | Config | Sound

Acceleration Adjustment

P CV: Identity| Config | Speed | Funct'n| P susl | | [Acceleration Rate
il l enly] o lg] e ] = n] ages] Alternate Mode Function Status F°

Read/Verify CV/s Decoder Manufacturer S!lg.”ale: MO?E Function Slatt&s Fl
: i-Directional Communication Conl
Copy All CVs l Basic / Other (NMRA) [~ #

Configuration Data
Specific Manufacturer ¢ Select from list below - Consist Address

M . Consist Address Active for F1-F8
| Q1 Solutions - Quantum =l Consist Address Active for FL, F9-
y alarabisem Adiiel 3
7 | View CV Block | - Access CV Page
Lol e ﬁ:e d1 £ P ened? o LLL
Update Item : Exe ndexe Ol -y
Hi (123-256) Indexed3 ¢ Indexed4 ™

Close |

CV Block to be
Read/Verified
selected before
operation started

r

mm/ pPpooo

CV | Ox | 1x | 2x | 3x | 4x | 5x | 6x | 7x | 8x | 9% [10x[11x[12x] | |Fq
0 001 001 001 032 000 00O 0OO 00O OOO 000 OO0 000 :" diexe da P"age Aﬂadadress LF'IQHBBYEB
1 | 000 086 160 003 004 000 000 000 000 000 000 000 00O ||[ccFer |edefddesstow vt
2 | 000 032 032 001 255 000 000 000 000 000 000 000 000 |||gupu Contiol for Function FO1
3 | 000 255 255 001 032 000 000 00O 000 000 000 | | | Dutput Control for Function FO2
4 001 000 000 000 000 000 | | | Output Control for Function FO3
5 | 000 OO0 00D 00O OO0 O0OD OO0 0OO OO0 OO0 OOO 000 00O g““"" Control for Function F04
utput Control for Function FO5
6 | 000 000 000 100 000 000 00O 00O 000 000 000 000 000|||Qutput Control for Function FOB
7 127 | 127 127 000 000 000 000 000 | | |Output Control for Function FO7
8 | 000 127 127 127 000 000 000 000 000 | (Qutput Control for Function FOB
9 | 000 000 | ! Output Control for Function FO3
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Ensure the locomotive is on the Program Track, then click the Read/Verify CVs
Action Button and wait for the operation to complete —

Item #12 - Addr 089 - Configuration Variables

Item Description |Union Pacific Challenger - Q51 Titan Steam Basic | Config | Sound

) ) . Acceleration Adjustment
Identity | Config | Speed | Functn| P SUSI Acceleration Rate
| ‘ ] — 1 ] ‘ ‘] s ] Alternate Mode Function Status F°

’ Read/¥erify Configuration Variables Alternate Mode Function Status Fl
CV Sco Mode Bi-Directional Communication Conl

& Current View o+ AllCVs " Paged Conhguration Data
‘ & Direct Eons!st Address )
t " ANCV Blocks " Selected Consist Address Active for F1-F8
£ Consist Address Active for FL, F3
. i Deceleration Adjustment
Deceleration Rate
! Decoder Access Unlock
Decoder Automatic Stopping Cont
Decoder Lock ID Code
{ Cancel :

| EME Ecadback Chiatont

E
E]{ Green highlight

CV | Ox | I1x | 2% | 3x | 4x | 5% | 6x | 7x | 8x | 9x [10x | 11 -

0 001 I 001 I 001 i 032l 000 I_ug_u_l__unu.l_nm-l-‘—-l"—]_'ﬂm to show CV read
1000 085 160 003 004 000" 000 000 000 000 000 o000 ooo[[[F] is same as Item
2 (000 032 032 001 255 000 000 00O 00O 00O 000 000 000|||g

3 |000 255 255 001 032 000 000 000 | | | Oyinut Contiol for Funclion 07—
4 001 000 0

5 | 000 000 000 000 000 000 000 1191 Red highlight to
6 | 000 000 000 100 000 000 00O 00d : show current CV
7 127 127 127 000 000 000 000 000 TTmn -

8 | 000 127 127 127 000 000 oo0 oo ooo| | |0 read in progress
9 | 000 ooo  ooo [ |'°

When all available or selected CVs have been read, exit the final Read/Verify operation
by clicking Finish, then click Update Item to save the values retrieved from the
decoder to the Item in the Item List. Finally, save the complete (changed) Item List to
secure the information. This back-up philosophy ensures that you have an accurate
record of the contents of the Item’s decoder stored within the A-Track Item List, and
should be regarded as an essential operation to record the original state of a newly-
acquired locomotive decoder before you begin to make any changes or
‘improvements’.

As a final note, if you do choose to read all CV Pages in a single operation from a
complex sound decoder with an NCE Power Pro Command Station, you should be
aware that this system (and its Serial Interface, in particular) was never designed to
be used continuously for such extended periods, and it is very possible that it will lock
up at some stage, even when used in conjunction with a programming booster unit.
This is usually indicated by a sequence of failed CV reads followed by one or both of
the left- and rightmost A-Track Status Bar indicators changing to yellow. In such
cases, cancel the Read/Verify operation, then switch off the NCE Power Pro Command
Station. Allow around 20 seconds for the Command Station to power down fully, then
switch it back on — when A-Track should re-establish the connection within 15 seconds.
Only in exceptional circumstances should it be necessary to restart the A-Track
program itself. Thereafter, with an NCE Power Pro system, the safer recommended
strategy is to select and operate on only the single Block in view at a time.

The NCE Power Cab is much more robust in this respect, and can usually be relied
upon to complete even the most extended Read/Verify operation. After clicking the
Read/Verify CVs Action Button, it is probably safe to select All CV Blocks and All
CVs, and leave A-Track to proceed.
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6.7 Programming CV Values

Having set up, or changed, the required values of all or some of the CVs of an Item
(such as the Primary or Extended Address), the next step, after saving a copy back to
the Item List, is to transfer the new CV values to the actual DCC decoder. This can be
done either on the Program Track (Service Mode programming) or on the Mainline
Track (Operations Mode programming).

Operations Mode programming is useful to ‘fine-tune’ selected decoder parameters
when a locomotive, for example, is running on the Mainline, having set up the majority
of CV values for the decoder on the Program Track. However, unless you are using a
sound decoder with verbal read-out of CV values, you cannot use Operations Mode to
read back the programmed value and confirm that it has been set correctly.

Note that not all decoders (especially older models) support Operations Mode (“on-the-
main”) programming commands.

Be aware, also, that some decoders which do support Operations Mode programming
will still not allow you to change Address values via Operations Mode (since the current
decoder Address has to be included in the command to update a decoder CV value on
the Mainline). In such cases, Address changes will have to be programmed on the
Program Track — or by using some special, indirect Operations Mode method provided
by the specific decoder manufacturer.

As noted in Section 1.1, and shown in the relevant system connection diagram, the
NCE Power Pro has limited Program Track drive capabilities so that, particularly where
sound decoders are fitted to your locomotives, it is strongly recommended that a
programming track booster unit (such as the SoundTraxx PTB-100) is inserted
between the Command Station and the Program Track.

Once fitted, the booster unit can be left permanently connected for programming and
verifying all types of decoders. A programming track booster unit is not required, nor
recommended, when using an NCE Power Cab which has a comparatively higher drive
capability in Program mode.

Note : Although, with the addition of an NCE Pro Cab, the NCE DCC Twin can be used
to program all types of decoder, it is not designed for this purpose and does not
incorporate the power-limiting Program Mode of either the NCE Power Pro or Power
Cab systems. This means that decoders will effectively be programmed using the full
power available for the mainline track. For decoders which are pre-installed, or already
proved to be wired-in correctly, this should not be a problem but, if you are
programming a decoder which has just been fitted, there will be no protection against
wiring errors — which could result in the destruction of the decoder from excessive
current (with acknowledgement to Mark Gurries for providing this information).

After opening up an Edit CVs window for the Item corresponding to the decoder to be
programmed, the method of selecting which CVs to Program is the same as that used
for the Read/Verify operation in Section 6.6 above, and the same decoder access
Modes are available.

As described for Read/Verify operations in Section 6.6, the recommended way of
using A-Track for Program operations is to handle a single CV Block at a time,
particularly when using an NCE Power Pro Command Station. Hence, before starting
the Program operation (especially when accessing a decoder with Extended or Indexed
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CV Pages), click on the Pages Parameter Tab, and select the Block of interest using
the Access CV Page and View CV Block options.

With the locomotive to be programmed located on the appropriate Track (and the only
locomotive present if using the Program Track and Service Mode), click on the
Program CVs Action Button to show the Program options page.

Here, in addition to options to program All or Selected CVs, you can also choose to
program only those CVs whose value has been Changed, ie. those currently highlighted
within the CV Grid in pink. Note that whenever a changed CV is selected, its pink
highlight will become orange (rather than yellow).

In the example below, programming of the decoder is set to be on the Program Track,
in Paged Mode, of the Selected CVs from CVO1 up to CV29 (highlighted in yellow). A
3-Step Speed Table has been set up under the Speed Parameter Tab (see Section
6.1) so that CV02, CV05 and CV06 will be shown as changed as well as being selected
(orange). Because there are both changed and selected CVs in the displayed grid, the
background of the Program CVs button will also be set to orange.

After clicking Confirm to start the Program operation, the Edit CVs window will look as
shown below after a few seconds —

Item #8 - Addr 0464 - Configuration Variables

Item Description |ATSF GE44 Switcher - DN140

Program CVs | Identity | Config | Speed | Functn] Pages | susi
’ Program Configuration Variables
¥ Rang Mode
& Current View " AllCVs ¢ Paged
i " AllCV Blocks " Selected " Direct
(" Changed " Register
i i r " Address Green highlight

to show CV was
tptoeten [}l i |

programmed
S
CY | Dx | 1x ] 2% ] 3x ] 4M] 7x ] 8x ] Ix ]10x]11x]12x_]_ show current CV
m 000 000 000 000 062 150 185 : :
064 00 000 00O 00O 000 OF I PEOgEAIMBHRG 1N

002 ~000 000 000 00D 3 000 000 000 progress
000 000 O 000 097 164 190 000 000 000
000 000 000 00D 128 107 168 192 000 00O 00O T
000 000 000 001 116 000 000 Orange highlight
to show changed
— CV which is also
selected

Red highlight to

1\

082 000 000
106 1393 000
123 208 000
000 000 050

LDW\JOU'I&WIN—‘Q
o
S
S

As can be seen, CV0O1 through CV03 have already been programmed successfully, so
are now shown with a light green background, while CV04, which is currently being
programmed into the decoder, is highlighted in red.

When programming of all selected (and/or changed) CVs is completed, they should all
be highlighted in light green -
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[tem #8 - Addr 0464 - Configuration Variables

Item Dezcription |AT&SF GE44 Switcher - DMN140

Frogram Cl's | Identit_l,JT Config TSpeedT Funct'nT Pages T SUs|

Program Configuration Yariables

(& Current View " AlCvs (* Paged
" Al O Blocks (* Selected " Direct
("~ Changed "~ Reaqister

[Readveincye |
L Comaicis |
[reszancys |
g - " Address
[FeseTherd s |
|

0 Programming Completed Successfully

i

=3

Ox | 1x | 22 [ 3x | 4x [ 5x [ 6x | 7x | 8x | 9x [10x][11x]12x

000 | 000 000 000 000 000 062 | 150 | 185 000 000 000
054 000 000 000 000 000 OO0 075 | 155 187 | 000 000 000
002 000 000 000 000 000 OO0 | 057 | 160 189 000 000 000
000 000 000 000 000 000 OO0 | 097 | 164 | 190 000 000 000
000 000 000 000 000 000 128 | 107 | 168 | 192 000 000 000
192 000 000 000 000 000 001 | 116|171 123 | 000 000 000
082 000 000 000 000 000 128 | 124 | 175 000 000 000 000
106 193 000 000 000 000 O16 | 132 | 178 000 000 000 000
129 208 000 000 000 000 033 | 138|180 000 000 000 000
o0 000 050 000 o000 o000 048 144 183 o000 ooo ooo [

wmﬂmm-ﬂ-wm-lng

Note, however, that this, even together with the displayed message "Programming
Completed Successfully", does not necessarily signify that the Program operation
transferred the correct value to each of the highlighted CVs.

Acknowledgements that the decoder has accepted the value being programmed are
only generated on the Program Track (when using Service Mode programming), but
even here it is allowable, under NMRA Recommended Practices, for the Command
Station to proceed to program the next CV regardless of whether any
acknowledgement was received from the decoder.

No acknowledgements back to the Command Station are generated by the decoder
when it is sent Operations Mode programming commands on the Mainline Track
(although some decoders will still power the locomotive motor on for a brief period to
show that a programming command was received).

The only completely reliable way to check that the decoder programming has been
successful is to perform a subsequent Read/Verify operation on the Program Track.

Once the Program operation has completed fully, click Finish to close the process and
return to display the previous Parameter Tab.

Clicking Finish will also remove the background highlight on the Program CVs button
provided that no CVs in any CV Block (whether currently visible or not) remain
highlighted. If any CV is currently highlighted as ‘Changed’, then the Program CVs
background will be pink, whereas if any CV is highlighted as ‘Selected’, the Program
CVs background will be yellow. If there are both changed and selected CVs, then the
Program CVs background will be orange. In all cases, the principle is to ensure that
the required programming of all CVs, in all CV Blocks, is not forgotten, and is carried
out before the Item is updated and copied back to the Item List — when all CV
highlighting will be removed.
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Important Note : Using “Keep-Alive” Units and Decoder Programming

Many decoders require their power to be cycled after Programming, ie. for power to
be removed from the decoder for a short time and then restored, in order for the
newly-programmed values to be applied to the relevant decoder CVs.

Hence, if you have a “keep-alive” unit (power storage capacitors) fitted to the
Locomotive decoder, you need to switch off and leave the unit unpowered for a long
enough time to allow the keep-alive capacitors to discharge completely (possibly a
few minutes) before attempting to Read/Verify or otherwise test the new decoder
CV settings.

Programming on the Mainline Track is performed in exactly the same way as on the
Program Track but, before clicking the Confirm button to start the operation, click the
checkbox labelled Program on Main Track to place a tick in it. This will disable the
Program Track access Modes.

The example which follows shows the Operations Mode programming of the decoder’s
Speed Table (CV67 to CV94) which has just been set up under the Speed Parameter
Tab, so that the CVs are highlighted in pink.

As with Read/Verify, clicking Cancel at any time will stop the Program operation as
soon as possible, displaying the appropriate status message, as shown in the result
below —

Item #8 - Addr 0464 - Configuration Variables

Item Description |[4T&5F GE44 Switcher - DN140

Program CV's | Iderm!_‘,h] Config ] Speed ] Furu:?’n]. Pages ] SusI

Program Configuration Yariables

CV Range CV Scope

@& Current View " AlCYs " Paged

(" AlCV Blocks " Selected " Direct
(¢ Changed " Reagister

_Resdveity s |
_ Comaucys |
_Paste Main Vs |
Paste Evterid CVs| | P ~  Address ‘Program on Main
_Paste Inded OVs |
|

Track’ (Operations

Q Cancelled Program of Selected C¥s —
Mode) Selected

3
Continue | Finish I 2

Green highlight to

106 193 000 000 000 000 020 164 222—Too—vor—ow - and not yet
129 208 000 000 00D 000 041 173 225 0OD 000 00O O0OD programmed
000 000 050 000 000 00O 060 180 228 000 000 000

CV [ Dx | 1x | 2% | 3x | 4x | 5% | 6x | 7x | 8x | 9x |10x | 11x | 12x

0 ounl unol noul oonl oool nool 0?8]—19?] Hadalie] show Programmed
1 |04 000 000 000 000 000 000 034 134 234 000 O _~ OK - no highlight
"2 | 000 000 00D 00O 000 000 000 103 200 236 00O to show Cancelled
3 | 000 000 000 000 000 000 000 122 205 238 000

4 | 000 000 00O 000 000 000 128 134 0 000 000 X A

5 000 000 000 000 000 000 001 145 000 000 000 Pink highlight to

"6 | 000 000 0OD 000 000 000 128 155 000 — show Changed CV
7

8

9

From this point you can resume the Program operation from the next changed (or
selected) CV by clicking Continue, but note that the state of the decoder CV at which
you stopped, in this case CV85, is indeterminate — it may or may not have been
programmed with the Item CV value — so you may have check it la